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Description and System requirements 

Description 
RelMo is an object based digital terrain mapping program that allows the 
user to download data directly from some electronic distance measuring 
equipment.  For users of other software, RelMo can import files using a 
number of data formats including DXF and XYZ files.  You can also export 
from RelMo in either XYZ or DXF format.  The program also has CAD 
functionality allowing surveys and plans to be edited or built from scratch. 
 
RelMo comes with a Codes Library covering many useful point and line 
styles.  The Codes Library can be edited to customise the codes to match 
the ones you are used to or, build new codes. 
 
There is a fully functional query menu which allows the user to interrogate 
distances, radii and angles both in 2 and 3D.  The analysis menu allows the 
user to create grids, contours, slope graphs, visibility plots and cross 
sections.  Dimensioning tools allow 2D plans to be annotated with 
distances in either imperial or metric units. 
 
3D views can be created by growing panels rendered with images and by 
using complex line and point styles which as well as having 2D symbols 
also have 3D shape. 
 
You can move around the model in either 2 or 3D view.  The movement 
can be ‘free’ or you can add animation to objects to show specific 
movement.  There is no physical limit to the number of objects that can 
move.  Animation can be played back in real time.  
 
A RelMo Viewer is provided on the CD free of charge.  You may distribute 
this viewer to as many people as you wish.  Once in Viewer format, 
animation may be viewed but not altered.  RelMo files have the file 
extension .rlm, Viewer files have the extension .rlv.  In addition, RelMo 
2008 allows the user to create Windows AVI files to play on other 
computers or for later conversion (using third party software) to DVD 
format. 
 
Plan plotting is achieved using layout pages which have real CAD 
functionality allowing the user to add 2D plans, 3D images, and other 
images such as photographs, text, lines and other drawing objects. 
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In short RelMo is a ‘one stop shop’ for 2D plan drawing, 3D imaging, and 
animation.
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Minimum system requirements 
The system requirements are different for 2D and 3D use of the software. 
 
The program is designed to work under Windows 2000

®
, Windows XP

®
 and 

Windows Vista
®
. 

 
Minimum 2D requirements 
Pentium

®
 1.5GH minimum 

Graphics card with at least128Mb of RAM. 
500Mb RAM 
Wheelie mouse 
 
Minimum 3D Requirements 
Pentium 2.5GH minimum 
Graphics card with at least 256Mb of RAM (512Mb recommended).

1
  

1Gb RAM 2Gb recomended 
CD or DVD writer 
Wheelie mouse 
 
Plotting requirements 
Windows

®
 printer or plotter (pen plotters are not supported) 

Networking and shared printers - The printer drivers should be installed on 
the computer(s) operating RelMo. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1
   Not all graphics cards support hardware shadowing.  If you intend to use shadows and multiple lights, please check the 

RelMo website to find a suitable card 
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Installation Networking and Management 

Security 
RelMo is licensed to the user on a year by year basis.  The annual licence 
fee gives you access to updates, fixes and, telephone support.  On each 
anniversary of purchase the software will shut down unless an update code 
is obtained from the supplier.  To protect the software RelMo uses a 
hardware key and encryption software.  If you decide not to renew an 
annual licence, you will still be able to view any saved work using the 
RelMo Viewer but, you will not be able make any alterations to a job.  If you 
do decide to end your licensing agreement, we would suggest that you 
export all your archived work as DXF files which can then be imported into 
other software.  Lighting and animation will not be exported in DXF format.  
It is however supported in XYZ format. 
 
Our XYZ format is made public thus manufacturers of other systems who 
wish to export to RelMo or, import from RelMo, can do so by obtaining the 
documentation and writing the relevant import or export routine for their 
own software.  
 
The program is supplied deactivated.  Once you have installed the software 
you will need to call AiTS for your activation codes. 
 
Note - If you are installing over an older version of the software, always back up your jobs, 
Codes and Template libraries before installation. 
 
Two types of hardware key are available, either a USB key for standalone 
computers or a USB network key for computers that are networked.   
 
Using a hardware key conveys significant advantages to users.  The user 
and company names together with the licence number are stored on the 
key itself, along with the products you are entitled to use and the expiry 
date.  The key allows you to install the software on any number of 
machines and simply move the key itself from machine to machine when 
you want to use another computer. 
 
 
Installing Your Software 
Do not insert USB Hardware keys until you have installed the software.  
Insert the CD which should auto run.  Two sets of programs will be 
installed, the RelMo software package and the Deskey hardware key 
drivers.   
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By default, the AiTS software will be loaded into the folder C:\Program 
Files\AiTS.  You can change this folder during the installation process.  You 
will need to restart your computer following installation. 
 
 
Activation on first use 
When you first receive your hardware key, it will have been supplied to you 
in an ‘inactive’ state.  This means that until you contact us to obtain an 
activation code, it will not allow you to use any of the software. 
 
To obtain an activation code, start Licence Manager and select the Update 
button.  Note down the code that the program generates and also your 
licence number.  Contact us by phone or email with your licence number 
and current code and we will provide an activation code.  Type this into the 
relevant space in the Licence Manager update dialog exactly as given, 
press Okay and your key should be activated. 
 
 
Activation on anniversary 
Your licence will expire on each anniversary date.  Each time you start 
RelMo within 30 days of the expiry date, you will be warned that the 
software is about to expire.  Follow the same procedure in the paragraph 
above. 
 
Note - You should never attempt to guess an update code and enter this into Licence 
Manager.  Each wrong attempt will cause a counter to decrease which will eventually lead 
to the key shutting down.  If a key does shut down it will have to be returned to us.  A fee to 
unlock the key will be charged.   
 
 
Stand alone use 
The majority of users are likely to operate our software on a stand alone 
machine, in other words a computer to which the key can be physically 
attached.  This is the simplest type of installation to consider.  Just install 
the software on your computer using the installation CD and select the 
option to install Local Drivers when prompted to choose by the installation 
program.  The setup program will install all the necessary programs and 
then install the drivers for the hardware key itself. 
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Re-boot the computer, if prompted to do so and attach the key.  When the 
machine restarts the computer should detect the key and allow you to 
activate it as described above. 
 
 
Network use  
Although each hardware key is network aware, you are limited in use not 
only to the number of programs currently licensed to you, but also to the 
number of process licences held on the key itself.  For non-network specific 
keys this number is one, which means that if someone is using the licence, 
no-one else will be able to start the program.  If you want to operate over a 
network we can supply keys which have sufficient process licences to 
enable access to multiple copies of the program concurrently. 
 
Network installation is slightly more complicated, even if in reality it is not 
much more difficult to implement.  First and foremost you should decide 
which computer on your network is to be the nominated server machine.  
This chosen machine must be visible to the other (client) computers that 
will connect to it.  
 
If you want to run programs on the server machine, you need to install the 
software to this computer as usual using the installation CD.  Choose 
‘Network Drivers’ when prompted by the setup program.  You should select 
the ‘Start Service on System Start’ if this option is presented to you during 
installation.  Re-boot if necessary, attach the hardware key and you should 
then be able to activate the key as described earlier.   
 
If you don’t want to install anything other than the server drivers to the 
server computer, you can browse to the ‘setup.exe’ file in the DES folder on 
the CD.  Launching this program only installs the DESNet server drivers.  
Note however that you will not be able to activate the key from this 
machine, since Licence Manager will not be installed.  You will have to 
activate the key over the network, using the Licence Manager on another 
machine. 
 
On the client computers you should install the normal programme files 
software and choose ‘Local Drivers’ when prompted during the setup 
process in exactly the same way as described in the Stand alone section 
above.  Once installed however, you need to ‘point’ the client computer to 
use the key attached to the server machine.  From Control Panel launch 
the DESKey icon (DES are the manufacturers of the keys we use).  Make 
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sure the 'Enable DK2 Network Access' option is checked and then click the 
'Networking' tab. You can then browse through the network to the server 
computer using the 'Add' button.  You will also need to do this should you 
move the key to another computer for any reason. 
 
 
File locations 
Users will periodically need to access and amend the following files on a 
regular basis; 

The Codes survey 
The Templates library  
The Textures library. 

 
By default these are installed in the following locations: 
 
Windows 2000/XP 

…Program Files/aits/surveys/templates,  
…Program Files/aits/bin/Codes and  
…Program Files/aits/textures 

 
Windows Vista 

   Documents and Settings/all users/application data/aits/relmo 
 
Where network administrators restrict users access to the C drive (or the 
drive where the program file is installed), they will need to relocate these 
files to an area on the machine that the user can access.   
 
A new folder such as RelMo Resources can be created with sub folders 
such as Codes, Templates and Textures into which the appropriate files 
can be located.  It is suggested that these folders are not located remotely 
unless your network is high speed as the files are in some cases quite 
large. 
 
Once relocated you will need to point RelMo to the location of these files 
(see page 40). 
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Care of the Hardware Key 
The Hardware key is an item of electronic equipment and as such should 
be protected from moisture, extremes of heat and cold and stored securely 
when not in use.  You should not attempt to dismantle it as you are highly 
likely to damage the internal electronic components. 
 
 
Loss or damage 
Please take care of the key and guard against damage, loss or theft.  
Although we will replace defective keys free of charge, we will make a 
charge for keys that have been lost or damaged.  In the case of a network 
key, this cost will not be limited to the cost of a new hardware key, but will 
also include the value of any unused licence(s) on that key.   
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Program Updates 

Service packs 
From time to time we release service packs between major version 
changes.  These service packs are normally notified by email, and are 
available for downloading from the RelMo website at www.relmo.co.uk.   
 
You annual licence fee entitles you to receive these updates and also any 
major releases for as long as you pay the fee.  Major version changes are 
forwarded on a CD. 
 
Additional resources 
New RelMo resources, such as line style, point codes and new objects 
often appear on the RelMo website at www.relmo.co.uk.  Some of these 
are free and some attract a fee. 
 
We can also build additional Objects for you using our 3D digitising 
technology.  Please contact us for details. 
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The RelMo Environment 

 
 
General 
There are two main windows in the RelMo environment.  The left hand 
window called the Control Bar gives access to commonly used items such 
as Objects, Templates, Resources and Views.  The main screen on the 
right is the editing screen. 
 
Control Bars 
You can choose to show or hide the Control Bars.  From the View 
menu select Control Bars and check those that you wish to display.  
By default they will appear on the left side of the screen as small 
icons.  If you move your mouse close to one of the icons, the 
relevant Control Bar will expand.  If you move away from the 
Control Bar it will return to a small icon.   

 
To permanently display a Control Bar or Control Bars, 
when they are expanded click on the small pushpin in 
the top right corner.  When the pin points down the 
Control Bar is locked, when it is horizontal, the Control 
Bar will auto hide when the mouse is moved away.  
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Each Control Bar can be resized by dragging the top or sides of the frame.  
They can also be undocked and moved.  To move a Control Bar use the 
mouse to drag the blue top bar.  Note that an outline shows what will 
happen when you drop the Control Bar.  Examples are shown below. 
 

  ..  
The Control Bar will be The Control Bar will be docked below The Control Bar will be docked in 
docked above  the Button Bars Objects as a Tab 
templates 

 
To reset the Control Bars, from the View menu 
select Control Bars, Reset Control Bars. 
 
Note – From RelMo 2008 Service Pack One, Control Bars will 
work whilst undocked.  

 
 
Toolbars 
Each toolbar can be customised to 
show the buttons that you use most 
frequently.  To customise a toolbar click 
on the small downward arrow at the end 
of the toolbar, click on the toolbar you 
wish to customise and the check or 
uncheck the buttons you want to 
display.   
 
To add buttons that do not form part of 
that toolbar click on Customise and drag 
the buttons onto the toolbar. 
 
Toolbars are customised on a per-user 
basis, if several people use a computer, 
when they log on, that user’s toolbars will be loaded. 
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You can choose which toolbars to display by right 
mouse clicking on the area to the right of the 
existing toolbars.  Check or uncheck the appropriate 
toolbar. 
 
 
Moving between views and surveys 
If you have several surveys open or, different views 
such as 2D and 3D, you can swap between them by 
clicking on the tabs that appear at the top left of the 
screen. 
 
If you have several views open, the tabs may extend right beyond the 
extent of the screen.  In this case use the small left and right arrows to 
scroll the tabs into view. 
 
 
Selecting commands 
As well as using the toolbar buttons, the 
majority of the commands can be reached by 
use of the right mouse button.  The menus 
change depending on the command you are 
in.   
 

 
Feedback 
Feedback appears at the bottom of the screen towards the centre.  The 
feedback depends on what on the current mode for example, in 2D it will 
tell you the name of the current Active Object, when measuring distance 
however, the distance and change in height is displayed.  In the example 
below, the user has selected a number of points. 

 
 
Feedback on the cursors current position is displayed in 2D towards the 
right hand side of the screen. 
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Shortcut commands 
Control + Z Undo 
Control + C Copy 
Control + V Paste 
 
F1 Help 
F2 Set scale (2D view) 
F2 Fly (3D view) 
F3 Go to location, easting, northing and height 
F4 Fly speed increments (3D view) 
F5 Refreshes the screen 
F6 Full size (2D view) 
F6 Home (3D view)

1 

F7  
F8  
F9 Previous camera (3D) 
F10 Next camera (3D) 
F11 Full screen mode (3D) 
 
 
1 – Home in 3D is a position 100 metres above the centre of the survey. 
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Moving and zooming in and out  
(2D) 
In 2D view hold the cursor over the area you wish to zoom in on, use the 
wheel of the mouse to zoom in and out.  Follow the point you wish to zoom 
in on until it gets to the centre of the screen at which point it will remain 
there until you meet maximum zoom.  Reversing the direction of the mouse 
will move out. 
 
As well as using the wheelie mouse, you can zoom in, or show full screen 
by clicking on the Zoom in button     .  Having 
clicked on the zoom in button, drag a box 
around the area you wish to display by 
keeping the left mouse button depressed (the 
box appears from the centre of the 
magnifying glass).   
 
F6 or clicking the home button      will return 
you to full screen view. 
 
You can pan across the survey in 2D view.  
This feature only works if you are not in an editing mode that also uses the 
shift key (such as rotate object).  Hold down the shift key and with the left 
mouse button depressed drag the survey across the screen. 
 
(3D) 
Use the wheel on the wheelie mouse to zoom in and out.  Holding down the 
Control key will increase the rate at which you zoom in. 
 
Shift and left mouse or, button A to the right, allows you to 
drag the survey about the screen. 
Control and left mouse or, button B to the right, moves you 
about the centre of the survey. 
Left mouse only or, button C to the right, rotates the survey about your eye. 
 

A     B     C 
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Flying in 3D 
You can fly around the scene in 3D 
F2 Fly or stop flying 
F4 Set Fly speed increments 
Control + A  Speed up in increments 
Control + Z  Slow down in increments (you can use this command to 
stop) 
ESC Escape from Fly mode 
 
You can control your heading and pitch using either the arrow keys or the 
mouse with the left mouse button depressed.  Whilst flying, you are given 
feedback at the bottom of the screen.  This includes, Pitch (where a 
negative figure is down), Heading in degrees, Speed in metres per second 
and the Frame rate in frames per second. 
 

 
 
If you get lost whilst in free flight, use Esc to stop flying and click on the 
home button     . 
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General principles 

Whether you are downloading a survey from electronic distance measuring 
equipment, importing a survey from another piece of software or, creating a 
survey from scratch, the principle way in which RelMo works is the same. 
 
This section describes the general principles behind the way in which 
RelMo works and, for users who have been used to CAD, demonstrates 
the difference between CAD and Digital Terrain Models (DTM’s). 
 
Unlike CAD, in which lines are the all important feature and, the nodes at 
the end of each line are simply used to join it to another line, in RelMo the 
points (or nodes) are more important than the lines.  Each point knows its 
easting, northing and its height and therefore knows where it exists in 
space.  Lines are then used to join the points together.  Both points and 
lines can be coded.  These codes are recognised by RelMo and the 
appropriate point or line style is then applied to the point or line.  For 
example a point that contains a code PTREE will, when imported, create a 
2D symbol of a tree around the point.  Similarly, two points joined by the 
code WL will produce a 2D symbol of a wall.  This is shown in the diagram 
below to the left.  In addition, when viewed in 3D, the PTREE code will 
place a picture of a tree on the point and the WL code will produce a wall 
rendered with a bitmap, (the diagram below to the right). 
 

    
2D drawing 3D image 

 
For users of electronic distance measuring equipment this means that, as 
each point is imported, it is automatically placed in its correct position in 
space and, where a line style has been defined by the user, the points are 
automatically joined together with the correct line style.   
 
For those who import a job from another piece of software, the story is 
similar.  Again as each point is imported it is placed in its correct position in 
space and, where a line style has been defined by the user, the points are 
automatically joined together with the correct line style.  It is worth pointing 
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out here that not all software will output line and point styles.  For example 
DXF files only output lines, their colour and thickness.  An XYZ file however 
will output styles in the form of a code thus RelMo can assign the correct 
style to the code.  The difference is shown below. 
 

   
 
Data downloaded from electronic distance A DXF file which only imports lines, 
measuring equipment or an imported  their colour and thickness 
XYZ file which stores full code information. 

 
For users who wish to create or design jobs from scratch or from manually 
recorded measurements all points, (unless a specific height is manually 
entered), will be created at a default height and a ‘flat earth’ survey will be 
produced much like many 2D CAD systems.  RelMo contains a host of 
tools to assist you to manually create a survey. 
 

 
An example of a manually created survey 

 
The next stage is to edit your data in the software.  Not many of us import a 
perfect job and therefore some form of editing will be necessary!  This is 
where the difference between CAD and DTM’s becomes large. 
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In CAD, you are unlikely to worry about the height of any points, the 
eventual aim being to create a 2D plan of an area.  If you never interrogate 
the job to measure distances or if the area was almost level, the lack of any 
height data has little significance.  However if the area was on a slope, then 
height does matter as the distances to be measured are likely to be those 
along the slope rather than the horizontal distances.  This is where a DTM 
comes into its own. 
 
Having imported or download the job and, after correcting any line styles, 
the DTM is triangulated.  This process creates triangles between all the 
points and thus creates a surface onto which extra points can be added.  
The advantage of this triangulation process is that new points will land on 
the surface at the correct interpolated height between existing points.  This 
means that any interrogation of distances etc taken from the model will be 
more accurate. 
 
Now the user has a choice.  If 2D plan production is the only goal you can 
choose between producing a 2D line drawing or a coloured plan.  Two 
examples are produced below. 
 

   
 
2D plan (line drawing)   2D plan (coloured) 

 
If the objective is to create a line drawing, the triangles are created in a 
single colour and then switched off.  This means that they do exist to allow 
you to add points at the correct level, but you never see them.  If a coloured 
plan is required, the triangles are created in a single colour and then over 
painted to distinguish between the grass, road etc. 
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If 3D views or animation are to be added then the triangles are painted with 
the appropriate texture as well as the solid 2D colour to produce the 3D 
view. 
 

 
A 3D view of a Canadian junction 

 
If 2D plan production is your goal then the final stage is to add your plans to 
the Layout Pages, add your text, arrows and any additional features before 
you plot to your Windows

®
 plotter. 

 

 
Finally, if animation or fly-bys are required, in 3D view, you can add your 
animation and cameras prior to distributing your finished job on CD 
together with a free RelMo Viewer program. 
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The importance of the Codes survey 
The importance of the Codes survey that by default resides in C:\program 
files\aits\bin folder cannot be stressed enough.  As mentioned previously, 
this is where each new survey draws the information for any point and line 
codes, textures and any plan templates that you have. 
 
Whether you want to create a new code style, alter an existing one or 
simply change the letter code of a feature, you should do it in the Codes 
survey.  In this way it will be available for all future jobs. 
 
There are also ways of making new codes available to older surveys and 
this is dealt with in the body of the manual. 
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Surveying protocols 

For users who wish to download data from electronic distance measuring 
equipment (EDM’s), there are a number of protocols that you will need to 
follow in order to ensure the file successfully loads and that lines link 
together correctly.   
 
Unfortunately, no matter which software you use, you will find that they all 
have different surveying protocols! 
 
 
Stations and check observations 
Using the RelMo Download Utility you can download surveys generated 
from EDM equipment.  Use of that equipment should be as described by 
your supplier, but a few general hints and tips may be helpful in getting the 
best out of your equipment and RelMo.  
 
The use of control or check observations seems to have declined in certain 
vocations over the past few years. 
 
Control observations are a vital part of surveying practice.  Although in 
some circumstances they are not actually necessary to complete a survey, 
they demonstrate throughout the survey that data integrity is being 
maintained, that the equipment has not been moved, and that you are 
surveying accurately.   
 
When using multi-station surveys, the use of control observations is 
essential.  A sensible approach to using control observations can make it 
very easy to create surveys with many stations and, as importantly, 
demonstrate that the survey is accurate. 
 
RelMo is designed, in common with most surveying software, to use the 
check observations as well as checking on the accuracy of the survey, as a 
way of creating the station setup locations in multi station surveys.  Unless 
you use check observations, you'll end up having to perform many more 
steps before you can use the data you've surveyed. 
 
Single station surveys 
These are the only type of surveys where check observations are not 
essential, however desirable they might be! 
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For a single station survey, you'll have the option of defining the location of 
a station using your survey equipment.  If you don't, RelMo will setup the 
first station at the location specified in RelMo when it imports the data, 
(1000 north, 1000 east and 100 high by default).  Most if not all equipment 
requires you to name this station, the name of which will be stored by 
RelMo.  RelMo will accept stations either as numbers (1, 2 etc.) or letters 
(A, B etc.). 
 
Assuming that you will be observing good surveying practice and using a 
back sight station as a check observation point, follow the procedure below. 
 
Having set your station up at A (or 1) you will need to define the back sight 
station position. 
 
Note – It is advisable not to use the practice of shooting an arbitrary back station point to a 
church spire or other feature in the distance as unlike some software packages, RelMo will 
not ignore this point which will be added to the survey. 
 
Locate a suitable position for station B (or 2), your back sight station.  Mark 
the position of the station and, using your pole, 0 set on station B (or 2) and 
then in your normal point gathering screen, type –STB (or –ST2) depending 
on your lettering or numbering convention.  Record the shot.  Now record 
your data as normal, and prior to completing the job, take a final shot to the 
back site station –STB (or –ST2). 
 
It is good practice to take periodic shots back to B (or 2) during the point 
collecting routine.  This will allow RelMo will calculate the difference 
between each check observation to station B (or 2) and list any difference 
in the log file (see page 203 for further details). 
 
Two station surveys 
As with multi-station surveys, you will need to define the second station 
position before you move the station to the new position.  Having setup at 
station A (or 1), we would suggest that you locate the position for your 
station B (or 2).  Mark the position of the station and, using your pole, 0 set 
on station B (or 2) and, in your normal point gathering screen, type –STB 
(or –ST2) depending on your lettering or numbering convention.  Record 
the shot.  Now record your data as normal, and prior to moving the station, 
take a final –STB (or –ST2) to Station B (or 2’s) position.  Now move your 
station and set-up at B (or 2) entering the station details as you would 
normally.
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The first step having moved is to 0 set back to A (or 1) and then, in the 
normal point collection screen, type –STA (or –ST1) in the point code field 
and take a shot to your pole now on the old station A (or 1) position. 
 
Collect all the data as normal and, before finishing take a final check 
observation, again using –STA (or –ST1) before switching off. 
 
Multi station surveys 
For multi-station surveys, the technique is pretty much the same as with a 
single and two station surveys.  By way of an example, we will use a four 
station survey of a building and its surrounds, just to illustrate the main 
points. This can be extended to as many stations as you desire, the only 
limitation being the capacity of the surveying equipment! 
 
We will use the –ST codes although there is no need if you can enter these 
in separate fields on your measuring equipment. 

 

C 

A 

D 

D 
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Let us assume that you've set up on station A, your first station and, you 
are using a letter rather than number convention for your stations.  In this 
example we will also use the special station code (-STname) to define the 
stations.   
 
From station A your first check observation would be to station B (-STB).  
At this point, RelMo will create a new station at B.  You can then take an 
observation to station D (-STD), and RelMo will create that station too.  
Carry on and survey all the points you can see from A, at which time you 
would then be ready to move to station B.  Before moving take a check 
observation to B (-STB). 
 
Now you can physically move the equipment to station B and setup on that 
location. From B, your first observation should be back to station A (-STA). 
Then you should take an observation to station C (-STC).  RelMo will then 
create that station.  RelMo by this time has created all the stations, and any 
subsequent observations to the stations will be check observations.  All 
check observations are recorded in the internal log file as too are the 
station setup details (see page 203 for log file details).  As before you can 
then survey all the visible points from station B, take a final check 
observation back to A (-STA)and move to station C.  The process is exactly 
the same as the previous station move.  Take a check observation to D (-
STD) and then one back to B (-STB) before moving to station D. 
 
At station D you follow exactly the same process and then move to station 
D making sure you take check observations to both A and C. 
 
Surveys where you can take control observations back to the starting 
station are said to be ‘closed’ and this allows a useful check on the 
accuracy of your surveying as ideally your final check observation to A, 
should report a zero or small difference from the original definition of the 
setup on station A. 
 
In some surveys however it is not possible to close the survey in this way. 
Linear surveys, along perhaps a winding section of road, do not always 
lend themselves to being closed in this manner. In these circumstances, 
you can't close the survey, but your existing check observations should still 
be fairly consistent. 
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As you can see, the key to the whole process of RelMo creating a complete 
survey all in one go from your data is the use of control observations. 
RelMo knows and automatically adjusts itself to take account of differing 
zero headings at each station, because it knows the bearings of each 
station from each other. This means that whenever you move to a new 
location, RelMo already knows where it is in 'real space' and can interpret 
that survey data properly. 
 
 
Surveying methods 
Starting and ending lines 
As previously mentioned RelMo recognises codes that you enter in your 
distance measuring equipment and translates these into various line and 
point styles during the import/download process.  The way in which you 
start and end lines is, (as you would expect having read this section), 
specific to each individual piece of software. 
 
This section describes the way in which RelMo recognises start and end 
codes and also special codes. 
 
Note – for historical reasons users of Sokkia instruments can enter their control codes to 
stop lines etc.  See the section on RelMo download for more information.  
 
An example of a junction which has a number of kerbs is shown on the 
following page. 
 
Codes are stored in a special survey called Codes.  This survey resides in 
the C:\Program Files\AiTS\bin folder.  Every time you start a new job, 
RelMo takes a copy of these codes and uses them in the new job.  Thus, if 
you decide to add, delete, rename or amend any of the codes, if you do it in 
the Codes survey they will be available for all new jobs.  If you do it in an 
existing survey the changes or additions will only be available in that 
specific survey and the Codes survey will be unaffected. 
  

A 

B 
C 
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In the world of surveying there seems to be two common practices.  For 
those who do not like walking there is lazy!  This method involves 
zigzagging across a series of features taking first one feature then the next 
and the next before moving further up the feature taking the same detail on 
the way back.  The diagram below illustrates this method with the order in 
which the points are taken 

 
The default code for a straight kerb in RelMo is KS and for one of a range 
of centre lines, L421.  If the user simply crossed the road in the order of the 
points adding KS, L421, KS and KS, L421, KS etc the kerbs would be 
created as shown by the red zigzag line. 

 
This is not very meaningful and happens because RelMo joins the points 
with the same code in the order in which the points are taken.  However 
RelMo can distinguish between the two features with the same code by 
adding a number after the feature.  Thus in our example above, the left 
hand kerb would become KS1 and the right hand kerb KS2.  Numbers can 
continue to be added for any number of separate kerbs.  The sequence for 
the survey above becomes KS1, L421, KS2 and KS2, L421, KS1 and so on 
back an forth across the road.  In this case there is no need to add a 
number to the centre line code as RelMo will automatically join point 2 to 5 
to 8 as there is no other L421 on the survey.  Neither do you have to add a 
KS1, 2, 3 to the Codes survey as RelMo automatically recognises the 
number after the code. 
  

1 

2 

3 
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For those who enjoy walking and prefer to survey up one kerb and down 
the other, either the 1, 2 codes can be used, (KS1 for the first kerb, KS2 for 
the second etc.), alternatively you can use the RelMo dot (.) codes. 
 
Using this method, a dot (full stop) is used to force a code to stop.  Using 
our example survey again, the order in which the points are surveyed is 
changed to reflect the fact that we are now surveying up and down the 
road. 
 
 
 
 
 
 
 
 
 
 
In this case points 1 and 2 would be coded as KS and point 3 as KS.  the 
dot has the effect of ending this kerb line.  4, 5 and 6 are coded as L421 
(there is no need to add a dot as there are no other lines of this style on the 
survey).  Points 7, 8 and 9 are all codes as KS although point 9 would be 
coded with a dot if there were further KS’s to survey. 
 
As we all make mistakes, you can also add a dot before a code to start a 
new line.  If for example, you forgot to add a dot after the KS of point 3 
above, you could add it before the KS of point 7 i.e. .KS  This stops the KS 
at point 3 being joined to the KS at point 7. 
 
You can also use the dot codes or a space to change from one line style to 
another at the same point.  In the survey below, the straight kerbs (code 
KS) are also linked to curved kerbs (code KC) 
 
If we simply surveyed points 1 and 2 as KS (ending point 2 with a dot of 
course) and point three as KC, RelMo would leave a gap between points 2 
and 3.  To end the KS and start the KC at point 2, code as follows. 
 
Code point 1 as KS, point 2 as KS. (to end the KS feature).  Point 3 is 
coded as ..KC the leading double dots tell RelMo to link point 3 to point 2 
using the point 3 code.   
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Knowing a little more about dot codes, try to work out the sequence for 
points 1 to 10 below using the dot code method.  The answers are on the 
following page! 
 

 
 
 
Answers using the dot code method 
1  KS 
2  KS. 
3  ..KC 
4  KC 
5  KC. 
6  KC 
7  KC 
8  KC 
9  KC. 
10  ..KS. 
 
Point codes such as trees and lamp post do not require the use of a dot.  
Point codes only expect one point to create a feature, thus recording 3 
points with the code PTREE will lead to the creation of three individual 
trees, one at each point rather than a line of trees between the three points. 
  

1 2 
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Double coding of points 
RelMo will also accept a comma to allow you to double code a point.  Thus 
if point 2 were coded as KS,KC the same effect as with the dot codes 
above would be achieved. 
 
If your EDM does not have a comma, you can change the symbol used to 
separate the codes.  See page 75 for further details. 
 
Closing a rectangle 
If you want to join the last point of a line back to the first point of that line, 
put a double dot after the last point as shown in the diagram of a small 
square building (code B) shown below. 
 
Survey as; 

 
 
RelMo would create the following on import. 
 
 
  

1 B 

2 B 3 B 

4 B.. 
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Two point codes 
Two point codes expect only two points to create the line.  There is no need 
to add dots or numbers to cause a two point code to stop and restart 
somewhere else.  A good example of a two point code is a road arrow.  
The code for an ahead arrow is AA  Points 1, 2, 3 and 4 in the example 
below are all codes as AA  Because AA is a two point code, no arrow is 
created between points 2 and 3. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Three point codes 
The final special line code is the three point code.  This code expects three 
points in the order base left, base right and, anywhere along the top.  Such 
codes are useful for anything that needs to scaled in two directions for 
example ground text such as SLOW on the road or the outline of a vehicle.  
The diagram below shows the order of surveying for a line symbol called 
SLOW 

 
 
Points 1, 2 and 3 are all coded SLOW.  Point 3 can be anywhere along the 
top (including outside the box).  There is no need to end the code with a dot 
before starting another SLOW as only three points are expected by RelMo.  
Reversing points one and two will result in a mirror image, useful if you 
have a directional object. 

1 2 

3 

2 4 3 1 
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Finally, there is nothing to stop you surveying your whole site with one code 
and settling down to some serious data editing in the warm and dry when 
you return to the office! 
 
 
Special survey codes 
There are a number of special survey codes which can assist when you 
cannot actually see the survey point you want to take. 
 
These codes are entered into the point code (not the point number) field on 
your electronic distance measuring equipment. 
 
Note that if you output data from your EDM in coordinate format, (Easting, 
Northing, Height, Code) and import the file rather than downloading it, only 
the –OBJ and –TX codes will be recognised.   
 
Create a new object 
This code allows you to create a new object in the RelMo survey with the 
name of name where name is any name you wish to give it.  Note that 
there is no space between the code -OBJ and the name.  This observation 
and all subsequent observations will then be created in the new object.  It is 
anticipated that this observation will be at the very least dual coded for 
example, -OBJname,WL It is vitally important to make sure you have a 
comma between the -OBJname and the point code.  If not, then RelMo has 
now way of knowing where the object name part ends and the point code 
begins.  A new object will be created as described and the observation will 
have the coding as described by the point or line code following the comma 
or space. 
 
If you wish to revert back to the base object, use the code -OBJ..  The 
single dot instructs RelMo to revert back to the base object.  Remember too 
that you MUST have a comma after the -OBJ. if you wish to add a point or 
line code.  You can create as many separate objects in the base object as 
you require.  If you use a different name a new object will be created.  If 
you use the same name, the object of that name will be used. 
 
As RelMo triangulates the surface on a per Object basis, this routine may 
prove useful when surveying features that you may not want triangulated 
into the main body of the survey such as the top corners of a building. 
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Creating a Rectangle from three points 
This command creates true rectangles from three survey observations. 
Survey two points along one side of the rectangular feature (preferably the 
longest side) with normal codes and survey the third point anywhere along 
the opposite side, The third point is coded as -REC as shown in the 
diagram below. RelMo will then create a true rectangle from the three 
points. The third point is not used, but inserted into a hidden object 
ORIGINAL which is created as a child object of the main survey. 

 
Creating a Rectangle from two points 
Using this command you can create a true rectangle of a specified distance 
to one side of two observations.  Code the first observation as normal.  
Code the second observation using the code -RECdistance where 
distance is the width of the rectangle in metres.  A positive value, e.g. -
REC1.5, or -REC2.7 creates a rectangle to the right of the line joining the 
two observed points.  A negative number, e.g. -REC-1.2, or -REC-3.6 will 
create the rectangle to the left. 

 

STATION 

PT: 1 
CODE: B 

PT: 2 
CODE: -REC2.5 On downloading 

points 4 and 5 
are created at the 
same surveyed 
height as point 2.   
 
In this case, 2.5 
metres to the 
right of the 

surveyed line 

PT: 4 

PT: 5 

STATION 

PT: 1 

CODE: B 

PT: 2 

CODE: B 

PT: 3 
CODE: -REC 

On downloading 
points 4 and 5 
are created at the 
same surveyed 
height as point 3.   
 
Point 3 is unused 
and moved to a 
child object called 
Original 

PT: 4 

PT: 5 
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Creating a point for a hidden rectangular Indent 
Use this code to generate rectangular indentations along a building or wall 
line.  As with -REC, this code requires three surveyed observations.  
Survey the first two points at either end of the indentation, survey the third 
point anywhere within the indentation and code it as -RIN as shown in the 
diagram below.  The third observation is not used, but inserted into a 
hidden object ORIGINAL which is created as a child object of the main 
survey. 
 

 

STATION 

PT: 1 

CODE: B 

PT: 2 
CODE: B 

PT: 3 
CODE: B 

On downloading 
points 6 and 7 
are created at the 
same surveyed 
height as point 4.   
 
Point 4 is unused 
and moved to a 
child object called 
Original 

PT: 6 

PT: 7 

PT: 5 

CODE: B 

PT: 4 

CODE: -RIN 
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Creating a point for a hidden rectangular indent by stipulating a distance 
As with -RECdistance, this code allows you to create a rectangular 
indentation at a specified distance.  Code the first point as normal and on 
the second, code it using -RINdistance where distance is the depth of the 
indentation.  For example –RIN3.5 creates the points 3.5 metres to the right 
of the survey line.  A negative value would create the points to the left. 
 

 
 
 
Creating a point perpendicular to the survey line 

This code allows you to create a new point at a perpendicular to three 
observations. This causes an extra point to be generated on an extended 
baseline formed by the first two observations at the point where the 
perpendicular from the third point intersects the baseline. All the points are 
joined together using a line code specified for the first observation. –NLP is 
entered as the point code.  The example below illustrates this coding. 
 

 
 

STATION 

PT: 3 
CODE: -NLP 

PT: 2 

CODE: B 

PT: 1 
CODE: B 

On downloading point 4 is 
created at the same 
surveyed height as point 
3.   The point is created at 
the extended baseline 
from point 1 and 2, 

perpendicular to point 3  

PT: 4 

STATION 

PT: 1 

CODE: B 

PT: 2 

CODE: B 

PT: 3 

CODE: -RIN3.5 

On downloading 
points 5 and 6 
are created at the 
same surveyed 
height as point 3.   
 

 PT: 5 

PT: 6 

PT: 4 

CODE: B 
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The opposite of this code is –NPL.  This code is very similar to -NLP, but 
instead the baseline is formed by observations 2 and 3 and the 
perpendicular by observation 1 as shown in the diagram below. 
 

 
 
Horizontal Offset 
This code can be used to create an offset observation.  This is very useful 
when the centre of the object is not accessible.  Two observations are 
required.  The first is taken at the correct distance, i.e. to one side of the 
object and the second is taken towards the centre of the object and given 
the code -HA The first point is removed to the ORIGINAL child object and 
the second point is created using the distance and vertical angle specified 
by observation 1, but the horizontal angle from the second observation. In 
effect the data from both observations is combined to produce the correct 
observation. 
 

 

PT: 3 

STATION 

PT: 2 
CODE:-HA 

On downloading point 3 is 
created from point 1 and 2 
at the intersection of the 
two lines.  Both points are 
moved to the Original, a 
child Object of the main 

survey. 

PT: 1 

CODE: TREE 

STATION 

PT: 1 

CODE: B 

PT: 2 

CODE: B 

PT: 3 

CODE: -NPL 

On downloading point 4 is 
created at the same 
surveyed height as point 
3.   The point is created at 
the extended baseline 
from point 1 and 2, 

perpendicular to point 3  

PT: 4 
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Vertical offset 
This code allows you to create an offset observation vertically above or 
below a real observation in an otherwise inaccessible location.  Two 
observations are required.  The first is made to a point as normal, with the 
normal code.  The second observation is made towards a point vertically 
above or below the first observation and given the code -VA RelMo then 
extracts the distance and horizontal angle from the first observation and 
uses the vertical angle from the second observation to determine the 
location of the height of the observation.  The only information used from 
the second observation is the vertical angle.  RelMo does not physically 
create a point at this new location, but instead inserts a block of text 
describing the height of this location above the first location.  This is 
especially useful when surveying cliff edges, buildings, trees etc where the 
top of the object is inaccessible. 
 
You may need to set the mode on your electronic distance measuring 
equipment to measure the vertical angle. 

 
Interpolated points 
This code allows you to create a new 
point at the midpoint of two 
observations.  This causes an extra 
point to be generated between the 
two existing observations.  The first 
point is coded with the code for the 
point you wish to create and the 
second –CN.  On download the two 
survey observations are inserted into 
the ORIGINAL object which is created 
as a child object of the main survey. 
 
 

PT: 1 

CODE: TREE 

PT: 2 
CODE:-VA 

On downloading the height 
of the vertical offset is 
added as a text note to 
point 1.  Point 2 is not 

created. 

STATION 

On downloading point 
3 is created midway 
between point 1 and 2.  
Point 1 and 2 are 
moved to the Original 
child Object of the 

main survey. 

PT: 1 

CODE: TREE 

PT: 2 

CODE:-CN 

PT: 3 
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Line of Sight Offsets 
Line of sight offsets are defined using a baseline between the current 
station and the observed point.  They allow great flexibility in creating the 
point at an offset from the baseline, either to the left or right of the observed 
location, forwards or backwards from the observed location or above or 
below the observed location.  The physical observation is removed to the 
ORIGINAL child object, and the offset point created in the survey model. 
The descriptions below illustrate the various options available. 
 
Left and right offsets 
There are two options.  You can either offset by a specified distance which 
you enter as a distance in metres after the code.  Note that no space is left 
between the code and the distance. 
 -OLn.nn offset left of the line of sight n.nn metres or, 
 -ORn.nn offset right of the line of sight n.nn metres 
 
The alternative is to offset by the current detail pole length.  For example if 
your detail pole is currently set at a height of 1.6 metres, entering 2 after 

the code will offset the point by 2  1.6 = 3.2 metres. 

 -TLn offset left of the line of sight, where offset = n  current detail 
pole height 

 -TRn offset right of the line of sight, where offset = n  current detail 
pole height 

 
Left and right are defined as follows. 
 
 
 
 
 
 
 
 
Forwards and rearward offsets 
This offsets the observation directly ahead or directly behind the pole along 
the line of sight.  You can either offset by a specified distance which you 
enter as a distance in metres after the code.  Note that no space is left 
between the code and the distance. 

 -OFn.nn offset forwards along the line of sight n.nn metres 
 -OBn.nn offset backwards along the line of sight n.nn metres 

  

STATION 

SIGHT 

LINE 

POINT TO BE 

RECORDED 

- OL 

- OR 

POINT TO BE 

RECORDED 

OBSERVED 
POINT 

OBSTRUCTION 

OBSTRUCTION 
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The alternative is to offset by the current detail pole length.  For example if 
your detail pole is currently set at a height of 1.6 metres, entering 2 after 

the code will offset the point by 2  1.6 = 3.2 metres. 

 -TFn offset forwards along the line of sight, where offset = n  
current detail pole height  

 -TBn offset backwards along the line of sight, where offset = n  
current detail pole height 

 
Upwards and downwards offsets 
This creates the point immediately above or below the detail pole.  You can 
either offset by a specified distance which you enter as a distance in 
metres after the code.  Note that no space is left between the code and the 
distance. 

 -OUn.nn offset upwards from the observation n.nn metres 
 -ODn.nn offset downwards from the observation n.nn metres 
 

The alternative is to offset by the current detail pole length.  For example if 
your detail pole is currently set at a height of 1.6 metres, entering 2 after 

the code will offset the point by 2  1.6 = 3.2 metres. 

 -TUn offset upwards from the observation, where offset = n  current 
detail pole height 

 -TDn offset downwards from the observation, where offset = n  
current detail pole height 

 
Adding a text note 
You can add a text note to a point.  Type –TXtext where text is the 
annotation you wish to appear against the point.  You may add a code after 
the text using a comma for example –TXdrain cover,WL (note there is no 
space between the –TX and the text).  This will start a string code (wall left) 
and put the text note ‘drain cover’ against the point.  If the code is omitted, 
RelMo will use the same code as the previous point.  Thus if you are 
working along a string and adding notes at various points, the string will not 
be broken.  If you use –TX as the very first point of your survey, in the 
absence of a code, RelMo will assume that the point is a default point PNT. 
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Using Attributes to change a Code 
Using the correct attribute, you can force RelMo to display a point or line in 
a way specific to the line or point you are defining.  For example you may 
have a point code in your symbol library called PTREE to signify a tree and, 
by default, it may be 10 metres high and 8 metres wide.  However, the tree 
you wish to survey is 20 metres wide and 35 metres high.  To force the tree 
to be created in the correct dimensions when surveying the point would be 
coded, PTREE:X20Y20Z35 where the : (colon) is the attribute delimiter.  
The X tells RelMo the dimension of the X axis, the Y the Y axis, and the Z 
the Z (or height) axis.  By way of a second example, for a 2.5m high wall, 
with a width of 0.4m you would code the WALL code as, WALL:H2.5W0.4 
where H is the height and W the width.  
 
Only one colon may be present per code but attributes may be combined 
as in the examples above.  It is the attribute identifier (the W, H etc.) which 
determines how the data that follows is interpreted.  
 
You can use multiple codes per observation such as PTREE, F where each 
code is separated using a comma or space.  Each individual code can be 
allocated attributes so that for example you may use, PTREE:Z20, F:H2.9.  
A full list of attributes are listed below. 
 

LINE SPECIFIC ATTRIBUTES 

Attribute Description Example 

:C Forces the line style generated to be curved rather than straight :C 

:S Forces the line style generated to be straight rather than curved :S 

:Hd Specifies the height of a complex line where d is the height in metres :H2.65 

:Wd Specifies the width of a complex line where d is the width in metres :W0.4 

:RGBn Forces a line of colour n where n is a 24 bit integer with 0=Black :RGB255 

 
POINT SPECIFIC ATTRIBUTES 

Attribute Description Example 

:Ad Specifies the angle of rotation of a complex point where d is the clockwise 
angle of rotation 

:A90 

:Xd Specifies the X dimension of a complex point where d is in metres :X2.5 

:Yd Specifies the Y dimension of a complex point where d is in metres :Y3.0 

:Zd Specifies the Z dimension of a complex point where d is in metres :Z35 

 
Most of the attributes are only applicable to complex points and lines and 
can be edited after import using the appropriate edit properties commands. 
Please note that using point code attributes for a line code, or vice versa 
has no effect.  
 
Note – If your EDM does not have a colon, you can change it to another symbol.  See page 
75 for further details. 
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Initial Set-up and Options 

Introduction 
To set up your options, from the View menu select Options or click on the 
Options button.  The Options dialog will appear. 
 
You can change the options for the current job by making the changes and 
clicking OK or, you can change the options for all future jobs by making the 
changes and then clicking the Default button. 
 
Most options will only need to be set up the once, however some will 
change on a per job bases. 
 
This section takes you through each of the Options tabs, explaining their 
meaning and the effect they have once you change them. 
 
 
General tab 

Colour 
The background colour of the 
RelMo screen can be changed.  
The default colour is white. 
 
Show maximised on start-up 
The program can be forced to open 
maximised to fit the whole screen, 
check the Show Maximised on 
start-up box to force this option.  If 
you leave this box unchecked, the 
program will remember its size from 
the last time it was closed. 
 

 
File locations 

There is an option to change the location of the symbols, template and 
textures library.  Users on networks who are restricted from viewing the C 
drive (or drive where the program file is installed will need to relocate 
Symbols, Templates and Textures to an area on the machine that they can 
access, (see page 7). 
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Use internal 3D viewer 
You can choose to use the RelMo internal 3D viewer (an integral part of the 
program).  Alternatively you can choose to use the external viewer.  The 
external viewer is supplied on the CD and is loaded onto your computer as 
part of the installation process.  The program also needs to know the 
location of this program if you use the Pack and Go Wizard to distribute 
your files to others. 
 
Most recently used files 
You can choose the number of most recently used files that are displayed 
in the File list.   
 
Undo levels 
You can set the number of undo levels.  Setting a large number of undo 
levels may caused abnormally large memory usage after a prolonged 
session.  This had the affect of slowing the software down.  However you 
can alter the number of levels if you require. 
 
Autosave 
RelMo has an autosave feature.  You can choose the frequency of the 
save, by default 10 minutes by altering the number in the box.  To disable, 
change the number to 0 minutes.   
 
Note – during animation routines (either creating or playing), and whilst editing in the 
symbols library, autosave is automatically disabled.   
 
Allow custom toolbars 
If checked, this will allow the user to customise the toolbars.  From SP3 
customised toolbars are stored on a per user basis (provided of course 
users are using different log on names). 
 
Note – If you lose your toolbars uncheck this option, save and close the file.  Reopen RelMo 
and the toolbars should reappear. 
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Allow custom Control Bars 
If checked, this will allow the user to customise the Control Bars.  From 
SP3 customised Control Bars are stored on a per user basis (provided of 
course users are using different log on names). 
 
Screen tab 

Outline Style 
You can alter the border that 
appears around the Active Object.  
Select between a hatched, solid or 
dotted line.  (The Default setting is 
hatched). 
 
Rotation 
You can choose to rotate objects 
about the centre of the object or a 
selected point.  (The Default setting 
is about the centre). 
 

Grid 
You can choose whether to display a grid and you can define the size of 
the grid.  You can also set the snap to grid option.  Snap to grid can also be 
set and unset from the Design menu.  Snap to grid is useful when using 
RelMo to design new objects and codes. 
 
Screen Dimensions 
Screen Dimensions allows you to take physical measurements against a 
flat panelled monitor.  RelMo has its own set of measurement tools which 
are unaffected by this option.  
 
Should you wish to take a measurement (with a ruler for example) from a 
plan displayed on screen, this measurement will be accurate if you enter 
the exact screen dimensions in the Width and Height boxes.  If you set this 
Option, click on the Default button. 
 
Granularity 
The Granularity option allows you to alter the default amount by which the 
arrow keys move and rotate an Object.  The Default settings are 100 mm 
and 10/10 or 1 degree respectively.  Finer movement can be achieved by 
reducing the numbers.   
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Display Options 
Show tooltips will display the point number, code and any annotation 
associated with the point when the mouse is held stationary over a point for 
more than half a second.  You have to be in a points or lines menu such as 
Point Properties or, Draw Line for this feature to work. 
 
Highlight point creation type will colour code all points displayed on screen.  
The colours are listed on page 92. 
 
Slope Arrow Options 
Slope arrows can be used to display the direction of the slope on a 
triangulated surface.  You can chose whether to show scaled arrows (larger 
arrows for greater slopes) and the colour in which they display (see 
page141). 
 
 
Survey Import tab 

Import file type 
Import file type does not affect users 
who use RelMo download to 
download data from EDM equipment.  
It only affects files which are imported 
using the File, Import routine.  
However the other settings on this 
tab do have effect so users of 
electronic distance measuring 
equipment should not skip this 
section. 
 
Users who export from EDM 
equipment in XYZ coordinate format 

will need to set this option to XYZ standard as this type of file is imported 
rather than downloaded. 
 
Mesh size relates to users who are importing XYZ mesh information.  This 
number must be set to a multiple of the mesh being imported i.e. for a 5 
metre mesh, 5, 10, 15, 20 etc. 
 
Set the default file format that you will be importing.   
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There are further options for users who import DXF files.  If you change this 
option you should click the Default button. 
 
Clicking on the DFX options button allows the 
user to select which DXF entities are imported.  
CAD users should have a fuller knowledge of the 
various entities. 
 
Polyline import attempts to reduce the number of 
points created by DXF files.  DXF breaks 
polylines into many very short straight line 
segments each joined by a point.  Reduce points, 
attempts to space these points, by the distance shown.   
 
SmartReduce looks along the line from one point to the next and, if it is 
within the angle given, deletes that point assuming that the line is almost 
straight.  It then makes a further pass, to check the remaining points.  
Smart merge then joins all the line segments of any ‘continuous’ line 
together to form one line.  Generally, good integrity is maintained when all 
three boxes are checked, the maximum point spacing is set to between 1 
and 2 metres and an angle of 5 degrees is applied. 

   
Polyline reduction tools turned off The same import with the tools on 
    Note the reduction in points. 

 
It is worth reiterating here that DXF files do not retain any point or line code 
information thus all that is imported is a series of lines. 
 
Default station 
The base location for your first station, by default this is set at 1000 metres 
east, 1000 metres north and 100 metres high.  For users of distance 
measuring equipment who do not specify a station location when setting up 
their instrument, the first station will be set up at this location.  



INITIAL SET-UP AND OPTIONS  

AiTS International  45 

Line creation 
If you wish to load a file from someone else who does not use the same 
codes as you, RelMo will not be able to link the lines together.  This applies 
to all file types that RelMo can read such as DXF, XYZ, LSS load and 
RelMo load.  By checking the auto create unknown line styles button, 
RelMo will link any codes of the same type with a basic line in the order of 
their observation numbers.  This may produce reasonable results, 
depending of course on the logic employed to survey the points in the first 
place! 
 
Note – Any code that starts with a P will not be linked as RelMo assumes that a code 
beginning with P is a point code rather than a line code. 
 
Triangulation 
The triangulation section of the dialog, allows you to control how RelMo 
should try and optimise the survey to generate the best possible 
triangulation.  As mentioned previously RelMo is a digital terrain model and 
therefore the surface needs to be triangulated so that any editing in the 
form of adding points etc. will ensure that they land on the surface of the 
model rather than at the height set in the default station location.  The 
Disable option prevents any form of optimisation taking place. 
 
The Smart point insertion option creates points along a line every X.xx 
metres where X.xx is the measurement entered in the ‘insert every’ box.  If 
however the curvature between this new point and the last point is less 
than the smart angle specified in the DXF options dialog, the point is not 
created.  The effect of this option is to increases the point count around 
areas of high curvature, but reduces the additional points inserted along 
nearly straight sections.  This means that when triangles are created 
between the points their edges will more faithfully follow the edge of any 
line.  The significance of this is for models which are to be coloured in or 
rendered with 3D textures.  Colouring in is done on a per triangle basis 
therefore it is important to ensure that the edge of the triangles match the 
edge of any change in surface which is usually demoted by a line. 
 
The third option, to insert points by distance merely inserts points at the 
specified distance with no attempt to add additional points at areas of high 
curvature. 
 
The Optimise triangulation to match lines option attempts to match the 
triangulation process with existing lines. In other words, triangles should be 
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formed along line edges rather than crossing existing lines. RelMo 
achieves this during the triangulation process by inserting points where 
lines cross the edge of a triangle.  It then repeats the triangulation process, 
adding these new points to the model.  Up to 20 iterations of this process 
can take place, which can take a few seconds.  The process is not 
guaranteed to break every triangle, but in the majority of cases the results 
are excellent.  
 
Examples of the various methods are produced on the following page 
 

   
No form of triangulation Smart point insertion (5º) Points by distance added 
optimisation.  As can be two triangles still break every metre.  Triangles have 
seen, two triangles break across the edge of kerb line now been formed with their 
across the edge of kerb line. as the kerb only has a slight edge along the line.  However 
 curvature and extra points more triangles than are needed 
 have therefore not been added have been added making the  
  model less efficient on slower 
  computers. 

 

  
Optimise triangles turned on Optimise triangles with insert 
triangle edges now follow lines every 2 metres.  An 
lines more faithfully. excellent compromise in this 
 survey. 

 
External triangle optimisation attempts to prune those very long thin 
triangles that form around the edge of a survey but which do not form any 
part of the survey itself. 
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Fill 
Lines 
This feature sets up the colour of the 
triangle border.  You only see the 
outline if you are in a triangle type 
routine such as add triangles or fill 
triangles or, you physically turn on the 
triangle outline from the Display 
menu. 
 
You can force the triangle outlines to 
show all the time by selecting Show 
triangle outline from the Display 
menu. 
 
Fill 

When you create triangles and panels in your model, you can set a default 
colour and texture for them (colour for the 2D view and texture for the 3D 
view).  The colour/texture that will be used by default.  You will need to 
change this colour in the routine in which you are working if you require a 
different colour or texture.    To alter the defaults, first click on the texture 
you require and then alter its 2D colour if required.  Altering the 2D colour 
does not alter the colour of the 3D texture.  If you wish to do this you will 
need to use third party software such as Paint Shop Pro.  If no texture is 
required select None from the textures list. 
 
For users who predominantly create 2D surveys, change the texture to 
None and the same solid colour as your screen background. 
 
Shininess and specularity affect the way that light is reflected from the 
texture.  The default settings are 0. 
 
Repetition is the number of times the bitmap you have selected is repeated 
per metre.  The default setting is 1 east, 1 north.  Increasing the repetition 
will cause the image to display more frequently thus making the image 
appear more refined or smaller.  
 
Set size is used for ortho-photos.  It is necessary to set the size of the 
ortho-photo using the bottom left and top right of the photo.  For more 
information see page 189. 
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Animation tab 
Time control 
Time control allows you to set the 
number of calculations that your 
computer makes per second.  The 
trade off is smoothness against file 
size.  The default setting is 100 
calculations per second. 
 
The playback rate allows you to 
change the rate at which the 
animation plays.  The default setting 
is 1, which is real time. 
 

Preview 
You can preview the motion of an animated object in both 2 and 3D.  The 
redraw option alters the number of times the outline of the vehicle is 
redrawn per second.  The default setting is 100 milliseconds.  If you 
increase the number, you will get less outlines.  There is an option to 
include the redraw in plotted output. 
 
Playback pause  

This feature allows you to set a pause when an animation is set to loop 
continuously. 
 
Video format 
RelMo 2008 allows the user to create Windows video files (which can also 
be turned into DVD’s using third party software).  PAL is the European 
format, NTSC is the North American format.  User Defined allows you to 
define your own size.  
 
Video Codec 
Video streams can create very large files, so some method of compressing 
the video is desirable.  CVID is installed on the majority if not all Microsoft 
based computers.  It is considerably slower than more recent video codecs. 
Your computer will need to have the appropriate video compression 
software installed.  Windows media player contains a number of formats.  
MPG4 and XVID work particularly well with RelMo. 



INITIAL SET-UP AND OPTIONS  

AiTS International  49 

3D View tab 
This tab allows you to set up the global defaults for 3D views.  There is an 
option to change these in individual documents. 
 

Display 
Vertical scaling allows you to 
exaggerate the vertical scale or Z 
axis.  Enter a value of 1 for no 
vertical exaggeration. 
 
Angle of view allows you to 
increase or decrease the angle 
from your eye.  60º simulates the 
human eye.  120º would give you a 
wide screen view. 
 
3D point size allows you to set the 

default size at which the points will be displayed in 3D view.  The size of 3D 
points very much depends on what you are doing.  For example, if you are 
working on a survey anything between 6 and 12 will probably suffice.  
However if you are building a new detailed 3D code you may which to 
reduce this considerably or all the points will merge together.  The range is 
0.1 – 5000. 
 
Smooth contours will allow the edges of any triangles to be smoothed 
rather than have sharp changes in slope.  Smoothed object edges look 
more natural in most circumstances. 
 
Display background allows you to display a background bitmap.  Check the 
box and click on Set Image.  Select a texture for the background.  RelMo is 
supplied with a number of background textures including Cloud1, Cloud3 
Cloudsnight etc.  These reside in the folder c:\program files\aits\textures. 
 
You can choose to show the following by default, 

 Textures – shows the textures you have added, if left unchecked 
only the default colour will be displayed. 

 Lines – shows any lines that you have created. 

 Points – shows the points. 

 Show front faces – renders the front of any triangle with your 
texture. 
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 Show rear faces – renders the rear of any triangle with your texture 
(speed may be enhanced on slower computers if you only show the 
front). 

 Contours – shows the contours, the interval of which you can set. 

 Draw wireframe – shows the terrain and any objects as a wire 
frame model. 

 
You can turn all of these feature on or off from the Display menu whilst in 
3D view. 
 
Colour depth 
Colour depth can be set at 16, 24 or 32 bit.  Again, the issue is one of 
speed.  32 bit requires more processing than 16 bit, however 32 bit gives 
more colour depth.  The default value is 24 bit. 
 
Granularity 
You can choose by how much the arrow keys will move an object in 3D by 
changing the granularity nudge (in metres) and angles (in degrees).  Finer 
control may be needed when building new Objects to use as Templates 
etc.   
 
Nudge also alters how far you move for each click on the wheel of a 
wheelie mouse. 
 
Note - Once changed, you will need to close the 3D view and re-open it for the changes to 
take effect. 
 
Clipping planes 
Clipping plane sets the distance between which 3D Objects are displayed 
on the screen.  The default setting is Near, 1 metre and Far, 2500 metres, 
thus only textures between this range will be displayed.  Again, reducing 
the near clipping plain is useful when doing close up work such as building 
new code styles.  If you begin to get odd display problems with triangles, 
check the near clipping plane which may be too close.  Do not set either 
Near or Far to 0. 
 
Lighting and fog 
Lighting and fog are dealt with in the main section of the manual.  See page 
146. 
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Advanced 
Acceleration 

Graphics acceleration can be fine-
tuned.  This is only necessary where 
slower processors are being used and 
some graphics quality may need to be 
lost at the expense of smoothness of 
any movement.  The options vary 
between nicest, the best display and 
fastest, the least jerky movement. 
 
Fly controls 
The sensitivity of the response from 
the mouse when flying can also be 
altered.  10 is the default setting, 100 
would be extremely sensitive to any 

movement of the mouse. 
 
Frame rate 
The maximum frame rate can be set so that the flying speed cannot be 
increased above the maximum set here.  30 frames per second is the 
default value. 
 
Set Viewpoint  
This relates to the height of the eye when the View, Set Viewpoint 
command is used in 3Dview.  This command allows the user to look from a 
particular point towards another point on the model in 3D view.  
 
Create diagnostic log file  
Creates a file that reports various aspects of your hardware.  This file is of 
use to the RelMo support team and should be left unchecked unless you 
are asked to turn it on.  If checked, a Log file is generated every time the 
user switches into 3D view.  Log files are created in the same folder as the 
program is installed and can be deleted if this feature has been switched on 
inadvertently. 
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Printing tab 
This is the only Options page that is dynamic.  The various options are 
specific to each of your Layout Pages (plan templates).  Hence the Page 
name appears at the top of the dialog.  To set up the options differently for 
each plan template, first create the plan templates (see page 163).  Then 
with that template page open, click on View, Options, Printing to bring up 
the dialog below. 
 

Print settings 
The programme supports Windows

®
 

printers and plotters.  Pen plotters are 
not supported. 
 
Printing is dealt with in more detail on 
page 163. 
 
The default scale is the scale at which 
any 2D view will be saved.  When you 
have made a new 2D view, it can be 
dragged into the appropriate Layout 
Page for subsequent annotation and 
printing. 

 
The text scale factor is necessary for a few users whose computers do not 
correctly scale the text as seen on screen to the plotter/printer.  If you find 
that text appears on one line on screen but two lines when plotted, reduce 
the text scale factor by a couple of percent.  Once you have found the 
appropriate setting, click the Default button to set this default for all new 
jobs. 
 
Scale view to fit print window allows you to take views at a particular scale 
but when you drag the view into the Layout Page you are asked whether 
you wish to stretch the plan to fit the print window.  This results in a plan to 
the largest scale for the page but, can result in some ‘non conventional’ 
scales.  It is advisable therefore to add a scale bar to your plan if 
measurements may be required to be made. 
 
Paper orientation sets the default paper orientation.  You can change this 
via the normal print dialog. 
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Border  
By default you can print a border around the outside of the plan.  If 
checked, this border will be displayed in the Layout Page.  You can also 
adjust the colour and weight of the border. 
 
Margins  
You can alter the margins to try and compensate for those printers that 
insist on producing a larger leading edge or do not align your plot centrally 
on a piece of paper.  This is a matter of experimentation and once done, 
you are recommended to click Default. 
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Understanding Objects 

Objects, Parents and Children 
Introduction 
RelMo is an Object based system whereby groups of points are bound 
together as Objects.  If you are a CAD user, you can equate an Object to a 
CAD layer.  Objects can be visible, hidden, locked etc. 
 
Objects can also have sub-objects know as Children.  For example, a set of 
traffic lights may be made up of a pole and box as the main object, but 
have a child object, the lights.  The advantage of this system is that the sub 
object can be animated to create a working set of traffic lights. 
 
Objects are separate entities and cannot be linked to each other thus when 
you triangulate your model to create the terrain, you will need to ensure 
that all the points for the terrain are within the same Object.  Any points that 
you do not wish to be triangulated into the ground model should be stored 
in a separate Object and merged with the main survey after triangulation 
 
For users who import from CAD software, RelMo will store each CAD layer 
as a separate Object.  This may mean that you have to merge some 
Objects together to produce the ground model.  If you download direct from 
electronic distance measuring equipment you can force points to be 
imported into a separate Object by using the –OBJ command (see page 31 
for details). 
 
Objects are managed via the Objects Control Bar which lists all the Objects 
and their children.  You can only edit the Active Object.  This is indicated in 
the Object Manager by the coloured highlighted symbol.   
 
All jobs contain a Root Object and a default light (Light 1).  Under normal 
circumstances the Root Object does not in itself contain any points.  It is 
merely the ‘container’ for all other Objects.  There are two exceptions.  
When you create a new point or line style, they are merged with the Root 
(see page 95 (points) and page 108 (lines) for information on creating new 
point and line styles).  Users who create jobs from scratch can choose to 
create an Object in which to add their points or, add them to the Root 
Object.  Points should never be added to a light. 
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The example below seeks to show the main features of the Object Control 
Bar tree. 
 
In this example, the main 
Survey points are contained 
within the Parent Object called 
Rw1, the Active Object is Artic 
3-axle.  RW1 has a number of 
child Objects.  The light (Light 
1) is the default light that 
appears as a Child of the Root 
in all jobs.  Lighting is dealt with 
later in this manual.  
 
 
Managing Objects 
Right mouse clicking on an Object in the Control Bar allows you to do the 
following.   
 
Set Active 
Set the Object as the Active Object.  Note that there 
are a number of different ways of setting an object 
active.  See page 57. 
 
New Object 
Create a new Object as a Child of the highlighted 
Object.   
 
Merge 
Merge the Object with the Active Object in which case all the points and 
lines will be added to whichever object is currently active.   
 
Merge Children 
Merge an Objects Children with the Parent Object.   
 
Copy Animation 
Copy animation from the Active Object to the Object you have selected.   
 

The Active Object 

A Parent Object 

A Child Object 

Double clicking on an Object 
will set it active. 
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Import Animation 
This feature allows the user to import animation from a file.  The file is 
generated by third party software such as an incident data recorder.   
 
Note - We do not write these routines, we do however supply information to third parties on 
the required file format.  Problems on importing data should be addressed to the authors of 
that software. 
 
Hide Object 
Hide the Object so that it is not visible on the main screen. 
 
Delete 
Delete the Object (and any Children). 
 
Info Page 
Add an Information page to an Object.  This allows you to attach text, and 
pictures to an Object.  You can choose to show or hide the Information 
Box.  (See page 155 for further information on Info boxes). 
 
Properties 
Inspect the Objects Properties (see page 64). 
 
Moving an Objects position in the tree 
You can also change the order of Objects by 
holding down the left mouse button and dragging 
them further up or down the tree.  Note that the 
order that Objects are displayed in the tree is also 
the order in which they are displayed on screen.  If 
Artic 3-axle is dragged above Rw1 it will not be 
visible as it will be drawn on screen before the road 
surface in Rw1 which will then obscure it. 
 
Merging objects 

Merging objects deserves a little more explanation as 
users who import from CAD will often import a number 
of Objects which are based on their CAD layers.  As 
mentioned above, before the ground model can be 
triangulated, all the points that form the ground model 
will need to be merged into the same Object.   In the 
example to the right, a job called DXF One has been 
imported from CAD.  As can be seen the features such 
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as ROADS, VEHICLES etc. were created in a number of CAD layers.   
 
These layers have been imported as separate RelMo 
Objects however they should all be included in one Object 
as they all form apart of the terrain model.  
 
To merge the Child Objects of DXF One, right mouse click 
on DXF One and click on Merge Children 
 
 
The results are shown in the Control Bar Window below.  
And DXF One can now be triangulated. 
 
 
 
Making Objects Active 
An Object can only be edited when it is the Active Object.   
 
When an Object is active it is surrounded by a box.  In 
the diagram of the 2D view to the right, the car is the 
Active Object.  The style of this box can be changed 
using View Options and clicking on the Screen Tab.  
You can select from solid, hatched or dashed.  
 
In 3D, you will need to turn on the View Outline from the 
Display menu.  The traffic lights to the right are the Active 
Object. 
 
There are other ways to make objects active.  In 2D 
mode, double click on the Object or use the mouse with 
the left mouse button depressed to drag a box around the 
Object.   
 
In 2 or 3D, you can also move between Objects by using 
the Tab key or, Shift + Tab to reverse the order.  
 
Cut, Copy and Paste  
You can Cut, Copy and Paste Objects.  To Cut or Copy an Object set the 
Object Active and select the appropriate action from the Edit menu.  
Alternatively use the Windows

®
 shortcut Control+X for Cut or Control+C for 

Copy.  
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Note - When you cut an Object the Root Object will be come the Active Object. 
 
To Paste an Object you have a choice.  You can Paste into the Root Object 
or alternatively Paste into another Object.  Where you wish to Paste into 
another Object, you must make that Object Active.  When you Paste, the 
centre of the base of the Object you are pasting will land on the surface of 
the Object you are pasting into.  The Windows

®
 shortcut for Paste is 

Control+V.  Control+V automatically pastes into the Active Object rather 
than the Root. 
 
When you Paste, the cursor changes to the cursor shown 
on the right.  Position the cursor at the point you wish to 
Paste the centre of the object and click the left mouse 
button. 
 
A common fault is to fail to set the object you wish to paste into as the 
Active Object.  If the Root Object is active when you use the Paste 
Command, your pasted Object will land at the default height for imported 
surveys set in Options, Survey Import.  This can lead to pasted Objects 
hanging in mid air. 
 
If you are pasting an Object with a large base onto a Slope, expect some of 
the Object to disappear into the slope.  You can correct this by Pitching or 
yawing the Object onto the slope using the Object, Transform, Rotate to 
command or you can use Auto Level from the Object, Transform menu. 
 
Moving Objects – 2D 
Objects can be moved and rotated. 
 
To Move an Object, first set the Object Active. 
 
Click on the Move button       or right mouse click 
and select Move from the Objects Transform 
menu. 
 
The Object can now be moved by holding down 
the left mouse button and dragging it to its new 
position. 
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When in the Move command, the cursor changes and an outline of the 
Object appears.  This outline can be difficult to see on surfaces in the dark 
grey or black range. 
 
You can also use the arrow keys to move an Object.  This allows for very 
accurate placement of Objects. 
 
The amount that an Object moves in the response to the arrow keys can be 
changed.  From the View menu select Options and click on the Screen tab.  
Under the heading Granularity you can alter the Nudge value for 
movement. 
 
You can also move multiple Objects by setting several Objects active by 
dragging a box round them.  Right mouse click and select Move. 
 
You can also move an Object to a specific Easting/Northing or Height using 
the Objects, Transform, Move To dialog. 
 
Note - When moving Objects in 2D they retain their original height.  This means that on a 
surface that slopes, the Object may be left floating in the air or, buried in the surface.  If you 
need to move an Object any distance on a surface with significant slope, you are better off 
cutting and pasting as mentioned above. 

 
Moving Objects – 3D and locked ortho mode 
Moving objects in 3D and locked ortho mode 
has the advantage that it allows an Object to 
stay in contact with the surface of the parent 
Object.  To move an Object in this way, you 
need to set the view so that the cursor is over 
the parent object rather than over the un-
triangulated background (this is easier in 
locked ortho mode as you are locked above 
the survey).  Click on the Move button       or right mouse click and select 
Move from the Objects Transform menu. 
 
The Object can now be moved by holding down the left mouse button and 
dragging it to its new position.  To keep it in contact with the surface of its 
Parent, you must hold down the Control key as you drag. 
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Note that it is the centre base of the Object that stays in contact with the 
Parent surface.  Where the parent surface slopes, it may be necessary to 
use the pitch and yaw commands or the AutoLevel command to keep the 
whole Object on the surface.  
  
Rotating Objects – 2D 
There are a number of ways in which an Object can be rotated.  To Rotate 
an Object, first set the Object Active. 
 
To free rotate by mouse or arrow keys, click on the Move button      or right 
mouse click and select Move from the Objects Transform menu. The 
Object can now be rotated by holding down the Shift key and left mouse 
button.  Move the Cursor further from the Object for finer control. Releasing 
the mouse button will leave the Object in the new position.  You can also 
use the arrow keys to rotate an Object (shift and arrow keys).  This allows 
for very accurate placement of Objects.  The amount that an Object rotates 
in the response to the arrow keys can be changed.  From the View menu 
select Options and click on the Screen tab.  Under the heading Granularity 
you can alter the Nudge value for angular value for rotation.  You can also 
rotate multiple Objects by setting several Objects active by dragging a box 
round them.  Right mouse click and select Move. 
 
Note – When you free rotate an Object, you should see two arrows, one pointing forward 
and one to the right.  If the arrows are pointing differently, use the set heading command on 
page 62. 
 
To rotate an object by a specific number of degrees, select Rotate To from 
the Objects, Transform, menu. 
 
To rotate an Object by survey points, from the 
Objects menu, select Transform, Rotate by Points.  
Select the point in the Active Object about which you 
want to rotate.  Now select a second point in the 
Active Object to form your bearing.  Finally select a 
point to which you want the Active Object rotated to.  
On selecting the third point the Object will be rotated.   
 
This command can be used in conjunction with the Transform by Points 
tool (see page 63). 
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Pitching Rolling and Yawing – 2D 
You can Pitch, Roll and Yaw Objects either for 
animation purposes or to make Objects lie on a 
surface which is sloping. 
 
The picture to the right shows some of the 
problems that can occur.  Most of these can be 
cured using a combination of Pitch Roll and Yaw. 
 
To select Pitch Roll and Yaw make the Object the Active Object and ether 
Select Rotate To from the Objects, Transform menu or right mouse Click 
and Select Objects Transform Rotate to.  The dialog box below will be 
displayed.   
 
By default all objects are created with the y-axis 
pointing vertically up the screen (roll). The x-axis 
(pitch) is to the right and the z-axis (yaw) is at 
right angles to the other axes and points out of 
the screen.  A positive roll value will therefore 
rotate the object to the left, and a positive pitch angle will rotate the front of 
an object downwards. For consistency within the program a positive yaw 
rotation will rotate the object clockwise. 
 
The values are stored and thus it is simple to alter the value or return the 
Object to its original position. 
 
Auto-level 
Auto-level will automatically level an object on the surface of the model.  
Before using Auto-level you should rotate the object to face the correct 
direction.  Once done, ensuring that the object you are trying to rotate is the 
Active Object, select Auto-level from Objects, Transform. 
 
Auto-level works by picking up the slope of the triangle under the centre of 
the object and pitching and rolling the object to match that triangle.  Thus if 
you Auto-level a large object on a very uneven terrain, parts of the base of 
the object are likely to disappear into the surface or be left suspended in 
the air. 
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Pitching and yawing Objects – 3D and locked ortho mode 
Make the Object active and click on the Move 
button     or right mouse click and select Move 
from the Objects Transform menu. 
 
Three bars will be seen coming from the centre 
of the Object.  The green bar should be 
pointing out of the front of the object, the red 
bar to the right and the blue bar out of the top.  
If the bars are facing differently than described, 
re-set the heading (see setting the heading below). 
 
To pitch and rotate the Object hold down the shift key and use the left 
mouse button to drag the Object to the new position. 
 
Setting the Heading 
On some Objects it can be difficult to know which part of the Object is the 
‘front’.  On some imported objects it may also be necessary to set the 
heading.  To display an axis, select Set Heading from the Object Menu.   
 

The forward or yaw axis is shown in green.  
The right or roll axis is shown in red.  You can 
set their position yourself using the left mouse 
button to rotate the axis.  To permanently reset 
the heading, rotate the object so that the front 
is facing north (up the screen) and select Zero 
Heading from the Draw, Object command. 
 
 

Scaling Objects 
Objects can be made larger or smaller.  This is useful when importing 
Objects built by others which often have arbitrary scales.  You can find 
many useful objects on the Web and samples supplied with CAD 
packages. 
 

To scale an Object, first set it as the Active 
Object.  Select Scale by either right mouse 
clicking, Objects, Transform, Scale or select 
Transform, Scale from the Objects menu. 
 
The dialog box to the left will appear. 
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Enter the factor you wish to scale by, where 50% would be half size and 
150% would be one and a half times the size (decimal entries are allowed).  
To keep the Object in proportion, enter the factor in the X axes box and 
check the Scale all by X value box.  Your object will be scaled by its centre.  
If you want it to remain in contact with the ground or its parent Object, 
check the box Realign base to parent.  If the Object has been rotated you 
can undo any rotation at the same time. 
 
Offsetting Objects 
You can offset an Object from its original 
position by either one of two methods.  You 
can offset by a known distance by selecting 
Objects, Transform, Offset. 
 
Enter the number of metres East, North or 
the change in height.  To move an Object West or South, enter a negative 
value. 
 
You can also offset by points.  From the 
Objects menu, select Transform, Offset by 
Points.  This method allows you to select a 
point from the Active Object and a second 
from another Object, the Active Object will 
then move, aligning the two points on top of 
each other.  This command can be used in 
conjunction with the Rotate by Points tool (see page 60). 
 
This command can be useful when trying to stitch two Objects which have 
common points together.  An example would be two areas of a plan that 
were surveyed separately.  By noting the coordinates and heading of two 
common points, one Object can quickly be transformed to align with the 
other Object.  Once transformed, merge the two Objects and use the 
Merge Points Command from the Points menu to delete any duplicate 
points and permanently stitch the model together.  
 
Flipping Objects 
Objects can be flipped about their X, Y and Z axis.  Select the appropriate 
Command from the Objects, Transform menu.  This enables you to invert 
Objects through any axis quickly. 
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If your Object is triangulated you may need to flip all the triangles as the 
wrong face will now be reflecting light (the dark side will appear bright and 
the bright side dark).  This Command can be found in 3D view on the 
Triangles menu. 
 
Object Properties 
The Properties of an Object can be inspected, set or altered.  The Object 
Properties dialog box can be accessed in a number of ways. 
 
From the Objects Control Bar, right mouse click on the Object and select 
Properties.   
 
From the Objects menu select Properties.  This will display the Properties 
of the Active Object. 
 
Alternatively, set the Object as the Active Object (double click on the 
Object) right mouse click and select Properties from the Objects menu.   
 
The following dialog box will appear. 
 
You can change the name of your Object which 
can be useful for identification purposes within the 
Objects Control Bar.  You can change the height of 
an Object (see post).  You can choose whether to 
include the Object in any printing that you do.  You 
can set the object to be Active. 
 
Note – You can exclude Objects from individual views in the 
Layout Pages.  This means that although they exist in the main survey, they will not be 
printed.  See Excluding Objects from the printed output on page 169. 
 
You can choose whether the lines between the points are to be shown in 
3D output.  This is a useful feature.  For example the trees supplied in the 
template library have points and lines about their base to create a tree 
symbol for 2D output.  However in 3D you display the image of the tree 
rather than the 2D symbol.  If you leave the show lines box unchecked the 
lines will not be displayed even if, in 3D view, you are displaying lines in 
other Objects. 
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You can force an object to always face the camera.  This has the effect of 
enhancing the 3D effect of some objects.  For example, there are two ways 
of creating a 3D model of a tree.  You can create two panels at 90º onto 
which you place two identical images of a tree, one on each panel.  If you 
now look at the tree in 3D, it has depth height and width.  Alternatively you 
can create a single Panel with an image of a tree and check the Always 
Face Camera box.  The tree will now turn to always face the screen 
thereby appearing to have 3D shape. 
 
Offset in 3D views stops display problems where one object is placed 
immediately onto another.  For example imagine a survey of a road onto 
which you wish to place the word ‘SLOW’.  If you have a symbol for 
‘SLOW’, you can import this as an Object and place it on the road surface.  
You now have a triangulated surface of asphalt, the road, and one with 
white triangles, ‘SLOW’.  Graphics cards can have problems ‘’knowing’ 
which triangle to display as they get further into the distance.  
Consequently shimmering can occur.  By checking the Offset in 3D Views 
box for the ‘SLOW’ Object, this shimmering will be minimised. 
 
Always show triangles overrides the Display Command to turn off the 
triangles of all Objects within a Survey.  This can be useful for Objects such 
as a scale bar which have triangles which always need to be displayed and 
where you wish to print your survey without displaying any triangles. 
 
Smooth vertices affects the way that that light reflects off the edge of 
triangles.  It has the effect of smoothing the edge of the triangles.  Some 
objects look better with smoothed edges and some look better with sharp 
angular edges. 
 
Finally the statistics for the Object are shown at the bottom of the dialog 
Box. 
 
Creating new Objects from a group of points within another Object 

You can create a new Object from a group of points.  Set the Object from 
which you wish to extract the points 
as the Active Object.   
 
Either right mouse click and, click on 
Select Points from the Points menu 
or from the main menu choose 
Points, Select Points.  There are 
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options to make a Block Selection or, select points One by One.  Using the 
Block Selection command allows you to select a group of points by 
dragging a box, (mouse with left button depressed), around the points. 
 

The selected points appear enlarged and red in 
colour.  
 
Right mouse click and 
click on Clone area.  The 
Add New Object dialog 
box appears. 
 

Give the new Object a meaningful name.  You 
can now set the properties of the Object including 
its height above the source Object.   
 
See Object Properties earlier in this section for a 
description of the various Properties. 
 
Once you click OK you will be asked if you want to keep or delete the 
original points.  Click on the appropriate choice. 
 
Dealing with Groups of Objects 
You can make alterations to groups of Objects.  
Select a group of Objects by using the mouse 
with the left button depressed to drag a box 
around several Objects.  Once selected, right 
mouse click.   

 
You can check which 
Objects you have selected by selecting List and you 
can make changes to the entire group by checking or 
un-checking the Display Properties box.   
 
Where a box appears greyed out it means that only 
some of the Objects have a particular Property. 

 
You can also Delete a selected group of Objects or group the Objects 
together as one Object.  Where you group Objects, you have the option to 
ungroup them by right mouse clicking on the Object and selecting Ungroup 
from Objects menu or, Selecting Ungroup from the Objects menu. 
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Note – If you group Objects that always face the camera they will rotate about the centre of 
the new object.  This can result in some interesting effects such as whole forests sweeping 
around the survey! 
 
 
Template Objects 
Introduction 
Template Objects are Objects which are used frequently.  
They are stored in a Template Library.  You can create 
your own Templates. 
 
To access the Template Library open the Template 
Control Bar and highlight the template you wish to use 
by clicking the left mouse button on it.   
 
Note - it is useful to have the Preview Control Bar displayed as well. 
 
Provided the Template Object has a Mini View, a 
preview of the Object will be displayed.  See the 
following page for the way to create Templates. 
 

You can now drag the Template you want 
to use into the Survey by holding down the 
left mouse button.  Once over the survey, 
release the mouse button and the cursor 

will change to the Paste cursor. 
 
Position the cursor over the place where you wish to place the Object and 
click the left mouse button again.  The Object will be pasted into the Active 
Object at that position and on the surface of the Object.  You can now use 
the Windows

®
 shortcut Control + V to reload the cursor with another copy 

of the Template Object ready to be pasted. 
 
Troubleshooting Tip – If your Template Object disappears when you paste 
it, you have attempted to paste it into the Root Object.  It will be hanging in 
the air at the default height set in Options, Survey Import!  Control + Z will 
undo the paste, now make the Object you wish to Paste into the Active 
Object and try again. 
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Remember – if you want the object to land on a surface, you must make 
the Object containing that surface active prior to copying the template 
Object. 
 
Creating your own Template Objects 
You can save any RelMo Survey as a Template Object.  By default 
Template Objects are stored in C:\Program Files\AiTS\Surveys\Template.  
You can create new folders as necessary. 
 
To save a survey as a Template, first open the Objects Control Bar.  Right 
mouse click on the Root and set the Root Active.  Right mouse click on the 
Root again and Merge its Children.  You now have one object named Root.  
Right mouse click on Root again and click on Properties.  Change the 
name of the Root to reflect the nature of your Object.  Close the Properties 
box and the Object Manager. 
 
You now need to save a view of the Object.  From the File menu select Set 
MiniView, this will open a small 3D view of the Object.  Use the arrow keys, 
drag with the mouse and the mouse wheel to select the view.  Click on 
Save and close the Window. 
 
Note - Before finally saving your template, remove all unused codes (see page 202) and 
delete all Layout Pages.  
 
Finally save your survey to the Template Library. 
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Getting Started 

The flow chart below gives you a suggested method of working in RelMo 
 
What do you want to do? 

 

Create a 2D plan Create a 3D survey 2D and 3D 

Correct line styles 
Page 83 

Import 
Page 70 

Download 
Page 74 

Draw 
Page 81 

Correct line styles 
Page 83 

Triangulate model 
using main colour 

Page 83 

Triangulate model 
using no texture 
and same colour 
as background 

Page 83 

Finished 
product will be 

coloured in 

Finished 
product will be 

a line drawing 

Add additional lines and points 
Lines page 111, Points page 97 

Add template 
objects 
Page 67 

Create Views 

Page 157 

Create Layouts 

Page 163 

Analyse 
Page 122 

Plot  
Page 168 

Add Text 
Page173  

No 

animation Animation 

Animate 
Page 176 

Add cameras 
Page 186 

Distribute 
Page 190 

Analyse 
Page 122 

Plot? 

Import 
Page 70 

Download 
Page 74 

Draw 
Page 81 
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Importing 

Introduction 
Also see page 206 for the current import data formats supported by RelMo.  
For downloading from EDM equipment see page 74. 
 
When you import, RelMo looks at a specific survey called Codes.rlm.  By 
default this survey can be found in C:\Program Files\AiTS\bin.  As you open 
a new job, RelMo takes a copy of the Codes survey and adds it to the new 
survey.  As the points are imported, RelMo notes their location, (the X, Y 
and Z) and then more importantly, looks up the code and places the 
appropriate symbol at the location.  For example, if it finds a line between 
two points such as a wall it will place a wall between that point and the next 
and the next etc. 
 
You can change the code of any particular point or line style to match one 
that you are already used to.  You can also add further codes or delete or 
amend existing codes.  See page 95 (points) and page 107 (lines) for more 
information. 
 
Note - Not all file types support Codes, for example DXF exports everything as a ‘line’. 
 
 
Import dialog Box 
From the file menu, click on import, the Import dialog box will appear. 
 

Select the options button to reflect the file 
type you wish to import.   
 
Use the Open button to browse your 
computer for the file you wish to import. 
 
You can choose to import into the Root 
(the norm for all new surveys) or the Active 

Object if you are adding to an existing survey. 
 
Note - Users who are using EDM equipment to import a survey in two parts should import 
both parts into the Root, before using offset by points (page 63) and rotate by points 
(page60) to align the two sections.  The surveys can then be merged (page 55) to form a 
single survey. 
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Using the Filter Option 
You can use the filter command to filter out some data.  Click on the filter 
button. 
 

You can choose to apply a range.  This is useful 
when you are trying to import a section of data 
from a large block such as OS data in the UK.  In 
such a case you may have 2000 m

2 
of data but 

only require a particular 500 m
2
.  Check the apply 

range button and enter the easting and northing 
of the bottom left and top right corners of the data 
you wish to import.  RelMo will only import points 

within this block. 
 
Remove duplicate points will remove any points that are duplicated.  This 
sometimes occurs with less robust export files from some CAD software.  
RelMo will remove one of the duplicated points and attempt to join any lines 
that were joined to them. 
 
Prevent link creation will import only the points, ignoring any lines which 
link the points together.  See Survey Import Options on page 43 for the 
opposite effect i.e. creating links where you only have point data to import. 
 
Scale Object will cause an object to be reduced or expanded in size during 
the import.  This can be useful if the import file contains data in alternative 
or arbitrary units. 
 
Note - If you have the ability to output an XYZ file which will retain line code information and, 
you have changed the RelMo Codes Library to match your own codes, your line styles will 
automatically be created including and Complex 3D lines such as fences, walls, etc. 
 
RelMo/LSS 
RelMo and LSS load files take, for historical reasons, the same format.  
See page 77 for the format.  RelMo supports the import of LSS 001, 002 
etc load input files only when the EDM equipment is set to survey using the 
VASD (Vertical Angle Slope Distance) mode.  If you don’t use this mode, 
use the LSS Output Survey command to create an XYZ file. 
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DXF files 
Most programs will allow the user to output DXF files.  DXF files do not 
remember point and line codes, thus every line and every point is simply 
imported as point and line.   
 
Further DXF problems can occur where survey data has been imported into 
a CAD package and further CAD symbols have been used to finish the 
plan.  You will find that the survey data retains the height information 
however the additional symbols will be added at height 0.  The symbols 
below represent two spot levels (points surveyed for height information 
only) on a piece of sloping ground.   
 
 
 
The surveyed point is the black point in the centre of the cross.  The CAD 
package has generated the additional red points and joined them with lines 
to create the symbol, a cross. 
 
However when viewed from the side in 3D the following effect is seen. 
 

Surveyed slope 

 
 
 
 
 
Contact your CAD support office if this problem occurs. 
 
Since the addition of complex line styles in Version 4.0, DXF is no longer 
the ideal import media. 
 
It is worth noting that DXF OS data will be imported at its real world 
Northings and Eastings.  If you have already created a survey and are 
adding the OS data as a ‘location plan’, your survey will be somewhere in 
the area 1000E 1000N.  You are likely to have to move your OS survey 
closer to your main survey by using either the Objects Move button to drag 
it or the Objects Transform Offset Command to move it by coordinates. 
 
See page 207 for further information on DXF. 
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OBJ files 
Imports Wavefront (a 3D modelling package) Object files. 
 
Line and offset 
You can import line and offset files written in a text editor such as notepad.  
See page 208 for further details. 
 
From Version 5 on, you are advised that the best method of adding line and 
offset information is by direct entry to the main screen.  See adding points 
on page 99 for further details. 
 
XYZ Standard files 
Unlike DXF, XYZ files do retain point and line code information.  This has a 
distinct advantage in that, provided you have changed the RelMo codes to 
match those you normally use, all the lines that you survey will be 
replicated in RelMo.   
 
See the section on page 209 onwards for basic details of how to export 
XYZ files from commonly used software. 
 
Note - Some software exports Eastings, Northings, Height and some, Northings, Eastings, 
Height.  Once you discover which your own software does, you can set the appropriate 
order in RelMo from the Import dialog by clicking on Filter. 
 
PTS Points Cloud 
Data generated by laser scanner devices. 
 
XYZ Mesh files 
These files form a mesh over which an ortho-photo can be laid.  
Companies such as GetMapping will supply mesh data and the 
corresponding Ortho-photo.  You can animate onto the surface of a mesh. 
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RelMo Download Utility 

The RelMo download utility is for users who wish to download from 
electronic distance measuring (EDM) equipment. 
 
Users of Topcon, Geotronics and Sokkia and Leicia electronic distance 
measuring equipment can download directly into RelMo using the RelMo 
download utility. 
 
From RelMo select File, Download.  The download utility program is 
launched.  On the first occasion you use this software you will need to set 
up the program to recognise your EDM.   
 
 
Setting up for your equipment 
Select Options from the Actions menu. 
 
From this dialog box various parameters 
controlling the operation of the program, and the 
default data formats may be set.  By default 
RelMo Download is set up for a Geodimeter 
total station.  This must be changed to match 
your equipment you use. 
 
The various options available are: 
 
Auto Convert after download 
This option forces RelMo to attempt to convert the downloaded file 
immediately after it has been downloaded.  You will be prompted for this 
conversion, so you have the opportunity to cancel the conversion before it 
takes place. 
 
Auto-import into RelMo after conversion 
Use this option to force RelMo Download to automatically launch or re-
open RelMo and import the converted file. 
 
With both the above features selected, you will not have the opportunity to 
inspect or edit the raw data as the whole process of downloading, 
converting and importing will be fully automated. 
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EDM Source Type 
Select your equipment from the available list. 
 
Target Type 
RelMo measured format is the only option. 
 
Code Delimiter 
This is the symbol you use when you wish to double code a point (e.g. 
PLP5,WL for a point that is a lamppost and the start of a wall to the left).  
By default it is set to a , (comma).  However if your EDM does not have a 
comma or, the comma is an awkward series of key strokes, you can 
change the delimiter to one on the list.  See page 29 for further details on 
double coding of points. 
 
Attribute Delimiter 
If your survey equipment allows additional text to be inserted into a point 
code, you may also use attributes to specify extra information concerning a 
particular point or line code.  
 
If your EDM does not have a colon, you can change the symbol from the 
list. 
 
See page 39 for further details. 
 
Coordinate order: 
Choose either; 
Eastings then northings.  (Standard format for the Northern hemisphere) 
Northings then eastings.  (Southern hemisphere format) 
 
Download folder 
Set the default location where you would like the downloaded files to be 
saved.  This is only a guide location.  You can choose a more suitable 
location during the download process. 
 
Backup location 
Set the location where you would like a backup copy of the downloaded file 
and any converted file to be saved.  By default this is set to A:\  You can 
however change it to a more suitable location by clicking on the ‘…’ button. 
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Communications Options 
From the Actions menu select Comms Options 
 

From this dialog box you may set the 
communications protocol used by your 
EDM. 
 
Set up the port number to match the 
port to which the total station is 

connected.  RelMo Download supports port numbers COM1 to COM8 
inclusive. 
 
Select ‘Set defaults’ to set the remainder of the settings recommended by 
the manufacturer of your electronic distance measuring equipment.  If you 
have altered these settings on your instrument, you must match the 
settings in RelMo download to match the altered settings. 
 
You also need to ensure that your instrument is set up to measure in 
vertical angle slope distance mode (VASD).  This is the only surveying 
method that can be interpreted by RelMo.  Consult your handbook if you 
are unsure. 
 
Further options for Sokkia users 

Sokkia users can used the Actions, 
Control Codes option to set up a number 
of codes used by Sokkia instruments to 
start and end lines etc.  The Control 
Codes Option is shown to the left with 
the various control code options.  You 
can change the codes to match your 

own.  (Two alternatives are available). 
 
If RelMo Download is able to communicate with the equipment directly, i.e. 
allow you to select jobs from the instrument from within RelMo Download 
the Let RelMo control unit option will appear.  Check the box.  (If your 
equipment is not able to communicate directly with RelMo, this option will 
not appear). 
 
Most communications problems are found to be due to incorrect settings.  
Please check your machine(s) for compatibility. 
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Using RelMo Download 
From RelMo select File, Download.  
RelMo will be minimised on the 
task bar and the RelMo Download 
utility will be launched. 
 
Connect your EDM equipment to 
the computer.  Click 
on the Download 
button.        
 
 
Users where RelMo cannot directly control the unit. 
When the Download button is clicked the 
filename download dialog will appear.  Select a 
name for your file and the folder in which it will 
be stored.  Click Open, the Ready to download 
dialog will appear. 
 
Follow the instructions in the dialog in the order 
given.  Ensure you are ready to send the data on 
the EDM before you click the Begin button as 
RelMo only allows you 15 seconds before the 
COM port times out.  Once you start sending 
data from the EDM, you will see the data appear 
on the screen as it downloads.  The filename extension for a raw data file is 
.rlt 
 
Users where RelMo can control the unit 
When you click the download button a dialog will 
appear listing the Jobs stored in the head.  
Select the job you want to download and click 
OK. The filename download dialog will appear.  
Select a name for your file and the folder in 
which it will be stored.  Click Open and your job 
will be downloaded.  Once you start sending data on the EDM, you will see 
the data appear on the screen as it downloads.  The filename extension for 
a raw data file is .rlt 
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Converting the data   
Once you have downloaded the raw data, you can edit and save it or, 
convert it and do your editing in the converted data.  We suggest you edit 
converted (load file) data and the format of this is given in the following 
section. 
 
Click on the convert data button.  Your data will be 
converted and a summary will appear, listing the 
number of errors found.  Error lines will be marked as 
a 0, in the converted data, flagged with a message 
that the line cannot be interpreted and will be ignored 
during the import routine. 
 
If the backup data files box is checked, your data will 
be backed up to the location you set up in the 
Actions, Options dialog.  If this is to a disk drive, you 
will be prompted to load a disk. 
 
Both the raw data file (.rlt) and the converted file (.001) are backed up. 
 
When you click OK, the RelMo load file will appear on screen.  You can edit 
and save this file by referring to the next section.   
 
Loading into RelMo 
Once you have edited the data click on the Import button.  
Your file will be imported into RelMo and the RelMo 
Download utility will close. 
 
 
RelMo load file format 
On the following page you will find an example of a RelMo load file.  Load 
files are given the file name extension .001.  For those who wish to edit the 
file before it is loaded, the following explanation of the lines may prove 
helpful. 
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The first field of each line describes what information is contained in that 
line.  The table below lists the various field codes, their format and any 
notes. 
0 Description:  Comment line  

Format:  0, text 
Note:  A 0 comment line is ignored by RelMo in the import 

process.  This can be a comment entered by the user 
into their electronic distance measuring equipment.  
Equally it can be a line that RelMo has been unable to 
interpret.  Where RelMo is unable to interpret a line, it 
will add its own comment such as ‘unrecognised field’. 

1 Description:  Surveying parameters.   
Format:  1, DMS, VASD 
Note:  RelMo only accepts DMS (degrees, minutes and 

seconds) and VASD (vertical angle slope distance).  
You will need to ensure that your survey equipment is 
set up to measure in this way. 

2 Description:  Location of station 
Format:  2, Easting, Northing, Level, Scale factor (optional), 

Station description (optional) 
Note:  This line need not be defined and if not, RelMo will 

place the first station at the default location stored in 
RelMo (typically 1000N, 1000E, 100H)).  See page 44 
for details of how to change this location. 

3 Description:  Station setup 
Format:  3, Station label, Back sight station, Horizontal angle to 

back sight station, Instrument height in metres 
Note:  Stations labels may be numbers or letters. 

4 Description:  Back sight station or check/control observation   
Format:  4, Observation number, Horizontal angle, Vertical angle, 

Slope distance in metres, Label of station observed 
Note:  Although not required for a single station survey, back 

sight stations are mandatory for 
5 Description:  Detail observation   

Format:  5, Observation number, horizontal angle, vertical angle, 
slope distance, Detail pole height, point or line code. 

Note:   
6 Description:  Text attached to point   

Format:  6, text 
Note:  The text will be imported attached to the previous point 

9 End of file. 
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An example file is produced below. 
 
0, RelMo / LSS load file generated using RelMo Download v3.0 
0, File name: D:\RelMo Training\Geodometer\011S01C.006 
1, DMS, VASD 
0, 11 
3, A, B, 0.0000, 1.840 
0, CAESER 
4, 1, 000, 00, 00, 90.10.20, 35.11, 0.070, B 
5, 2, 349.56.17, 90.05.45, 25.25, 1.700, B1 
5, 3, 352.37.38, 90.06.43, 19.37, 1.700, B1 
5, 4, 356.32.12, 90.09.21, 14.46, 1.700, B1 
5, 5, 359.40.27, 90.04.48, 12.34, 1.700, B1 
5, 6, 31.16.19, 89.08.00, 11.20, 1.700, B1 
5, 7, 42.30.32, 88.17.30, 14.35, 1.700, B1 
6, WATERSTONES 
5, 8, 92.31.20, 88.09.54, 12.52, 1.700, B2 
5, 9, 130.36.03, 90.59.26, 4.68, 1.700, B2 
5, 10, 135.40.07, 91.03.29, 4.77, 1.700, B2 
5, 11, 153.34.58, 90.00.18, 13.49, 1.700, B2 
5, 12, 153.29.58, 89.44.33, 29.64, 1.700, KC 
5, 13, 159.54.38, 90.14.56, 17.65, 1.700, KC 
5, 14, 161.10.39, 90.16.41, 16.44, 1.700, KC 
5, 15, 161.45.33, 90.19.28, 15.21, 1.700, KC 
5, 16, 162.38.28, 90.26.50, 13.80, 1.700, KC 
5, 17, 167.25.27, 91.16.54, 8.74, 1.700, KC 
5, 18, 179.20.32, 93.24.04, 4.52, 1.700, KC 
5, 19, 186.30.09, 94.28.39, 3.67, 1.700, KC 
5, 20, 193.05.13, 95.14.04, 3.30, 1.700, DK1 
5, 21, 205.50.50, 96.26.48, 2.82, 1.700, DK1 
5, 22, 221.40.10, 97.04.05, 2.64, 1.700, DK1 
5, 23, 246.54.41, 96.57.22, 2.83, 1.700, DK1 
5, 24, 256.54.29, 96.02.46, 3.10, 1.700, KC2 
5, 25, 270.10.16, 94.49.10, 3.92, 1.700, KC2 
5, 26, 282.07.41, 93.32.05, 5.79, 1.700, KC2 
5, 27, 286.03.44, 93.02.28, 7.65, 1.700, KC2 
4, 28, 000, 00, 00, 90.10.20, 35.11, 0.070, B 
9 
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Creating from scratch 

RelMo will allow you to create a plan or to build a model for use as a code 
or template from scratch.  This section is intended to give you an idea for 
the first steps and should be used in conjunction with the rest of the 
manual. 
 
 
Manually recorded line & offset measurements 

o Open a new survey. 
o From the Control Bar Objects tab, right mouse on Root and Create 

New Object. 
o Name the Object and set it Active. 
o From the points menu, select Add Points. 
o Add two simple points, adjusting their easting and northing so that 

they are the correct distance apart for your datum line. 
o From the Design menu, select Add Points.  Choose Line and Offset 

and click on locate points.  Locate your baseline by selecting the two 
points added earlier. 

o Now add your points, joining them with lines where required, by 
giving the distance along and, to left and right of the datum. 

o Autocalc the triangles. 
o Add any templates, animation etc.  
 

 
Manually recorded triangulation measurements 

o Open a new survey. 
o From the Control Bar Objects tab, right mouse on Root and Create 

New Object. 
o Name the Object and set it Active. 
o From the points menu, select Add Points. 
o Add two simple points, adjusting their easting and northing so that 

they are the correct distance apart for your two fixed points. 
o From the Design menu, select Add Points.  Choose Two Distances 

and click on locate points.  Locate your baseline by selecting the two 
points added earlier. 

o Now add your points, joining them with lines where required, by 
giving the distance along and, to left and right of the datum. 

o Autocalc the triangles. 
o Add any templates, animation etc.  
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Manually recorded parallel offset measurements 
o Open a new survey. 
o From the Control Bar Objects tab, right mouse on Root and Create 

New Object. 
o Name the Object and set it Active. 
o From the Design menu, select Add Points. 
o Add the points to form your first line using the appropriate Add 

Points method with the appropriate line style. 
o Select the line and right mouse click to create parallel lines. 
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Triangulating the model 

Preparing for triangulation 
Having imported, downloaded or drawn the model and corrected and line 
styles, i.e. converted lines that where accidentally surveyed with a curved 
line style to a straight one and visa versa (see page 115, Line Properties) 
and, corrected any points that were coded with an incorrect height (see 
page 101, Point Properties) the next step is to triangulate the model.   
 
Users who have imported their model from CAD should ensure that all the 
ground model points are within the same object (see merging objects on 
page 56). 
 
The next step is to triangulate the main model.  Use the flowchart on page 
69 to decide the way in which you want to triangulate the model. 
 
 
Triangulating the main model 
Triangulating the model 
To triangulate the model, ensure that the Object you wish to triangulate is 
active.  Right mouse click and select AutoCalc Triangles from the Objects 
menu or select AutoCalc Triangles from the Main Objects menu.   
 
The Set Triangle Properties dialog box will appear.  
Select the texture first and then change the Solid 
Colour if necessary.  The texture applies to the 3D 
and locked ortho view.  The Solid colour applies to 
2D view.  To change the texture click on the … 
button.   
 
The Surface Properties box will be displayed.  First 
select the image you require from the list and then 
change the solid colour if necessary.  (Note the 
order that this is done). 
 
Set the Repetition, the number of times that the 
texture repeats itself per metre.  This is important in 
3D view as it affects the ‘coarseness’ of the image.   
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By way of example, the grass image to the right shows a 
triangle filled grass repeated at 0.5 metres (top), and at 2.0 
metres (bottom).  Normally, a repetition of 1 and 1 will suffice.  
Set size applies to ortho photographs.  See page 189 for 
further details. 
 
Users wishing to create a simple 2D line model 
As suggested in the flow chart on page 69, users who simply want to 
produce a 2D line plan should triangulate the model with textures set to 
none and a solid colour that matches the background colour of your screen. 
 
Users wishing to create a 2D coloured plan or 3D model 
Users who wish to create a 3D model or a 2D model with coloured in 
surfaces should triangulate the model with the majority colour/texture. 
 
Having created the triangles, and before escaping from the triangle routine, 
it is suggested that the triangles are inspected to see if there are any 
problems such as triangles breaking over two surfaces.  If there are, you 
can adjust the triangle creation routine (see page 45) or manually delete 
and then add new triangles that follow the line features. 
 
 
Manual triangle creation 
Triangles can be added manually rather than allowing the software to 
control the triangulation routine.  This is useful when designing new 
template objects or complex lines and points or, where one or two triangles 
in the model break across two surfaces  In the latter it may be easier to 
delete the offending triangles and manually create your own triangles by 
linking the points in a different order.   
 
There are two warnings when manually creating triangles.  If you leave a 
hole (an un-triangulated section) in the ground model, any animation that 
passes over the hole will produce unpredictable results.  This is because 
the distance across the non existent triangle is not known.  If you create a 
triangle on top of another triangle and produce animation across the top of 
it, again, strange things can happen.  This is because the object will not 
know which triangle or level to use. 
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Partial triangle creation 
You can partially triangulate the model by selecting a 
number of points (see selecting points on page 102).   
 
Once selected, right mouse click and select Triangulate.  
The Select triangle properties Dialogue will appear.  
Select a texture and solid colour and click OK.  Triangles 
will be created between the selected points. 
 
To delete a triangle 
Make the object that contains the triangles the Active Object, right mouse 
click and from the Triangles menu select Delete Triangles.  Alternatively 
click on the delete triangles button.  The cursor will 
change and the triangle outlines will be shown.  Click 
anywhere on the Triangle you wish to delete. 
 
To create a triangle manually 
Right mouse click and from the Triangles menu select Add Triangles.  
Alternatively click on the Add triangles button.  Right mouse click again and 
Edit the current fill to set the 3D texture and 2D solid 
colour.  Alternatively, if a triangle of the right colour 
already exists in your survey, use the dropper tool to 
click on that triangle and pick up its Properties.  Once set, use the mouse to 
select the three points you wish to form the triangle.   
 
Note – These points should be selected in an anti-clockwise direction.  Triangles have two 
faces and by creating them in an anti-clockwise direction, you will ensure the top face is 
uppermost.  This has the following implications; 
 

o In 2D, when in a triangle routine, the triangles will invert their solid colour (this 
tells you that you are viewing the back face.  You will not be able to click on the 
triangle (with the exception of the flip command below) unless you hold down the 
shit key.   

o In 3D view where you have chosen to display one side only (to enhance the 
speed on lower end computers) any inverted triangles will not be displayed.  

o In 3D view inverted triangles will not display bright and will appear to be in 
shadow. 
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Flipping triangles 
If you do find you have inverted triangles (an example is shown 
to the right), right mouse click and select Triangle Properties 
from the Colour menu.  Click on the triangle and use the Flip 
button in the Triangle Fill Properties dialog box to automatically 
turn the triangle over.  Alternatively click on the flip triangles 
button and then click on the triangle you wish to flip. 
 
 
Triangle Properties 
You can inspect and change a triangle’s Properties.  (To change several 
triangles, use the Fill Triangle routine.  To change many triangles use Find 
and Replace).  Set the object Active which contains the triangle whose 
Properties you wish to inspect and either right mouse click and, from the 
Triangles menu select Properties or, click on the 
Triangle properties button. 
 
The cursor will change and all the triangle 
outlines will be displayed in the Active Object.  
Click on the triangle whose Properties you wish 
to inspect.  The Triangle Properties dialog will be 
displayed.   
 
You can change either the solid colour or the 
texture by clicking on the … button.  You should change the texture before 
you change the solid (2D) colour.  This is because if you change the texture 
it will automatically change the solid colour to the default colour that it is 
associated with. 
 
 
Colouring in the remaining triangles 
Having triangulated the model with one colour and texture, users who wish 
to create a coloured in plan or who are creating a 3D model will need to re-
colour a number of triangles.  In this section we look at how to colour the 
remainder of the model.  Users who are creating a simple 2D line plan as a 
line drawing without fill can skip this section. 
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Adding colour and textures by triangles  
Set the object you wish to colour as the Active Object. 
 
Right mouse click and from the Triangle menu 
select Fill Triangles.  You can now choose to fill 
the triangles One by One or by Entire Object.  
Select One by One.  Alternatively, click on the 
Change Style button.  
 
 
The triangle outlines will appear on the model and your cursor 
will be loaded with the current fill colour (the one that you 
used to fill the entire model).  To change this colour, right 
mouse click on the main screen.  The menu to the right will 
appear.  Click on Edit Current Fill.   
 
The Set Triangle Properties box will appear.  Select the 
texture and solid colour as described on the previous pages. 
 
Once you have selected the texture and solid colour, click 
OK.  You can now colour the triangles by placing the cursor over the 
triangle and clicking the left mouse button.  To colour multiple triangles 
place the cursor over the first triangle to be coloured, click and hold down 
the left mouse button and drag the mouse over all the triangles you want to 
be coloured.  When you release the mouse button, the triangles that the 
mouse passed over will change both colour and texture. 
 
To change back to a colour/texture you have already used, right mouse 
click and select the colour/texture from the top of the list (the last 3 textures 
are stored).  If the texture has dropped off the list, click on the dropper tool 

and select the triangle you want to change to by left mouse clicking on 
that triangle on the model.   
 
Finding and Replacing Triangle Colours and Textures 
You can find triangles with same properties and replace them with different 
Properties.  Find and replace effects all the triangles of the selected object.   
 
Right mouse click and from the Triangle menu select Find 
and Replace or click on the Find and Replace button. 
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The Find and Replace dialog box 
appears.  From the Find Properties 
you can specify particular 
properties or click on the Select 
button.  If you click on Select, the 
dialog will disappear allowing you 
to select a triangle.  Click on the 
triangle you wish to find.  The 
dialog will reappear.   

 
On the Replace With side of the dialog change the Properties to the new 
settings or, if you already have a triangle with those Properties click on 
Select and left mouse click on the triangle.  Click change and all the 
triangles you selected on the Find side of the dialog will change to those 
you selected on the Replace With side. 
 
Rotating Triangles (3D command) 
As mentioned previously, triangles have two sides and, 
when you render them with an image the way that the image 
reflects light and joins up with the edges of an adjacent 
triangle will depend on the way that you created the 
triangles.  The image to the right demonstrates this where 
the join in the bricks between the two triangles does not 
align.   
 
Provided you remember to create the triangles anticlockwise, this problem 
should not arise.  However if it does, you can rotate the triangle to match 
the edges.  This command is only available in 3D.   
 
In 3D, make the Object that contains the triangles the 
Active Object and enlarge the points.  From the main 
Triangles menu select rotate points.  Click on one of the 
points of the triangle you wish to rotate, you can continue to 
click until it is all the way back to the original orientation. 
 
The image to the right has been corrected and the 
brickwork now appears seamless even though it is created 
from two triangles. 
 
You may need to combine this routine with the Flip 
Triangles routine on page 86.  
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Triangle display options 
Normally whenever you enter a triangle routine the outline 
of the triangles will always be displayed.  Escaping from 
the triangle routine will cause the triangle outlines to 
disappear.  You can force the triangle outlines to show 
permanently by selecting Show Triangle Outline from the 
Display menu.   
 
You can also turn off the triangles by deselecting Show 
Triangles from the Display menu.  In 2D this will leave you 
with a line drawing.  In 3D, the ground model will disappear! 
 
 
The Textures Library 
The textures that you add are loaded from the Textures Library. 
 
On the Resources Control Bar, expand the textures tree 
and right mouse click on a texture.  You can now add, 
amend or delete a texture.  
 
 

To add a new texture, click on Add, the Add 
New Texture dialog box appears.  If you are 
adding a new texture that you have obtained 
from the web or, you have taken a digital 
photograph of a new texture, you will need to 
manually transfer it to the folder where your 
keep your textures.  By default RelMo installs 
textures to C:\program files\AiTS\textures.  You can save your textures in 
either .bmp, .jpg or .gif format.  If you want to add a transparent colour, one 
that RelMo allows you to see through, the texture must be saved as a 
bitmap (see below for transparency). 
 
To create a texture that is going to repeat over many triangles such as 
grass, make sure the texture is square and the edges are all similar.  
Programs such as Paint Shop Pro are a big help as they help you to create 
this sort of repetitive bitmap or ‘tile’. 
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Having placed your image in the textures folder Click on 
the button marked >> next to File Name.  Select the 
texture (a preview appears in the preview window) and 
click Open. 
 
You will be returned to the Add New Texture dialog and 
the selected image will be shown in the preview window.  
By default, the name for the new texture will be the same as the name you 
gave to the Image.  You can now alter this name.  Select an Alternative 
Colour that will be displayed if you turn off Show Textures in 3D view.  If 
you need a transparent colour, (see below for transparency), check the 
enable transparency button and select the colour that is to be transparent.  
Finally select the default shininess, specularity and repetition for your 
texture.  Click OK and exit the Library remembering to save the changes. 
 
 
Transparency 
You can add a transparent colour to any image that you are going to 
convert into a Texture.  When you specify a colour as a transparent colour, 
it is not displayed in 3D view and anything behind the colour can be seen.  
This can be useful for such things as windows, trees etc. 
 
You will need an external image editor to ‘paint’ a transparent colour onto 
your image.  For example if you take a digital photograph of a house, and 
rather than displaying the windows and glass, which you will not be able to 
see through, you paint the glass a colour that is not used elsewhere in the 
image, you can specify this as the transparent colour and look through the 
windows.  An example of a tree bitmap is shown to the right 
 

The resulting 3D image is shown to the left. 
 
Note - To use transparency the image must be saved as a bitmap.  
 
Tip – use a colour that is close (but not too close) to 
either the image or the background against which it is 
to be displayed.  This is because of the way that 
graphics cards handle images and the way they are 
displayed.  If a colour such as orange had been used, 

a slight orange tinge might be seen around the edge of the tree. 
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Where to make new textures 
If you make a new texture in the current job, it will only be available in that 
job.  To make the new texture available to all new jobs, you should make 
the new texture in the Codes survey that resides in C:\program files\ 
AiTS\bin.  Vista users will be prompted for an alternative loacation 
 
If you don’t make the texture in Codes, you can open the Codes survey and 
from the Resources Control Bar, drag the new texture from your current 
survey to textures in the Codes survey.  Save and close Codes. 
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Points 

An Introduction to Points  
Whether you are trying to achieve a 2D line drawing, 2D coloured survey or 
3D model, you are likely to have to add or change some points.  You can 
also design schemes from scratch by manually adding points and linking 
them with lines.  
 
Where data has been imported or downloaded, the points can be edited or 
added by making the Object which contain or, is to contain, the points the 
Active Object.  (Double click the Object or drag a box round it with the 
mouse). 
 
Displaying points 
You can choose whether or not to display points.  From the Display menu 
select Show Points.  Note that only points in the Active Object will be 
displayed. 
 
Enlarging points 
Points can be shown in a large size to make it easier to work on them.  You 
can make them smaller or larger by Selecting Enlarge Points from the 
Points menu. 
 
In 2D the size of the points is set.  In 3D you can define the size of the 
points by selecting Set 3D Point Size from the points menu.  You can enter 
a figure in the range given. 
 
Identifying points 
There are three methods of identifying points.  The first is by colour, the 
second by hovering over the point to obtain feedback, finally you can chose 
to display point numbers on screen.   
 
By colour 
To switch this option on, go to Screen Options from the 
View, Options menu and check ‘Highlight point 
creation types’. 
 
Highlight point creation type will colour code all the points as follows; 
Red User created point, created during editing 
Black Original survey point created during the import routine 
Grey Created from a special code e.g. –RIN 
Blue Created during triangulation or auto-insert points.   
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By Hovering 
To switch this option on, go to Screen Options from the 
View, Options menu and check ‘Show Tool Tips’. 
 
Show Tooltips allows the user to hover over a point to 
show a tooltip which lists, point number (where the point is 
an original survey point), point code and the height.  The 
screenshot to the right shows an original imported point.  
This feature only works in 2D. 
 
By Displaying Point Numbers 
From the Points menu, select Show Point Info.  Ensure 
that on the Display menu Display Point Info is checked.  
The point numbers in the Active Object will be 
displayed.   
 
Two types of point numbers can be displayed, either the original survey 
point number or, the RelMo point number.  These may be different. 
 
The original survey point number is the point number as recorded by your 
electronic distance measuring equipment when you took a particular 
observation.  The RelMo point number is the point number assigned by 
RelMo. 
 
Whereas the original survey point number will not change, the RelMo point 
number constantly changes where you have added or deleted points or, 
auto points have been created on triangulation.  The change occurs after 
each Save.  Prior to saving, 0 will be displayed.   
 
When displaying the original point number, points that have been added in 
RelMo will not display a point number. 
 
You can choose which to display and, alter 
the font, size and colour from Points, Point 
Info Display.  The Point Info Display Dialog 
will be displayed.  
 
Note that some imported file types such as DXF files do not have survey 
point numbers. 
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Snapping to a point 
Most Point commands will allow the user to snap to the 
nearest point in 2D view.  As you move the cursor 
around the screen the nearest point will be highlighted.  
Clicking the left mouse button will snap to that point. 
 
In 3D view, you must click on the point itself.  
 
 
 
Resolving Ambiguity 

If you select a point which is very close to another 
point, the Resolve Ambiguity dialog box will appear.  
Select the point you wish to edit from the list.  To 
avoid this happening, try zooming in further before 
selecting the point. 
 
Simple and Complex points 
There are two different types of point, Simple and Complex.   
 
Simple points are points that contain a basic symbol such as a triangle, 
circle or rectangle.  These simple points are about the same size as the 
point itself.   
 
Complex points are built by the user and can be such things as trees 
bollards, lamps etc.  These points, as well as having a 2D symbol often 
also have a 3D shape. 
 
Point codes 
Every point has a unique code.  When you give a point the relevant code, 
the 2D symbol and in the case of complex points, the 3D shape associated 
with that code will be drawn at the correct location.  It is good practice to 
start all point codes with the letter P.  This stops unknown point codes from 
being linked up with lines on import if the ‘auto-create line for unknown line’ 
features is turned on.    
 
Point codes know that the symbol is produced by a single point therefore 
users of electronic distance measuring equipment simply need to enter the 
point code and take the observations without the need for any additional 
start of symbol or end of symbol codes. 
  

The Point nearest the 
cursor is highlighted. 
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Point Code Library 
The style associated with a point or a line is defined in the special survey 
called Codes that resides in the C:\Program files\aits\bin folder.  Each time 
you start a new job RelMo takes a copy of the codes in the Codes survey 
and adds them to your job. 
 
You can add or amend points or change the code associated with a point.  
If you want these changes to be available to all new jobs, you need to 
make the changes in the Codes survey. 
 
To access the Code library you will need to display 
the Resources Control Bar (page 10). 
 
Complex codes are indicated by the blue diamond 
symbol and Simple codes by their symbol such as a 
dot or a triangle.  When you hover over a code a 
description is displayed.  When you click on a Complex code, a preview of 
its symbol appears in the Preview Control Bar if you have it open. 
 
If you are changing to RelMo from another surveying package, it is 
recommended that you change your RelMo codes to match the ones that 
you are used to using.  Some things will need to change for example you 
will have to comply with the RelMo protocols for starting and ending line 
codes. 
 
Creating and amending codes 
Whether creating new or amending existing codes, you have a number of 
options. 
 
Right mouse click on the code you wish to amend or any 
code if you wish to make a new one.  Choose Add to 
make a new code, edit to amend an existing code or 
Properties to change the code or description. 
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To create a new code, right mouse click on a 
code and click add.  The add New Point Style 
dialog box appears. 
 
Type in a Code (this can consist of letters or 
numbers).  Remember, by convention you 
should use a P to start a point code.  You 
should also ensure that you do not duplicate 
codes in both Points and Lines.  Add a 

description that will appear as a tool tip in the Control Bar window.  For a 
simple point, select a shape from the drop down list and change the colour.  
If you wish to design a complex shape, select complex from the drop down 
box and choose a colour for the point. 
 
In relation to Complex codes there are a series of further options.   
Show simple lines in 3D -  This Option allows you to create a simple line 

symbol for your point for use in 2D for printing 
plans.  However the simple lines will not be 
displayed in 3D.  A good example of this is a 
tree. 

 
In 2D the simple symbol is associated 
with the point.  In 3D the 2D symbol is 
not required because a 3D image of a 
tree is displayed.  You can force the 
lines to be shown in 3D by selecting 
lines from the Display menu. 

 
Show triangles in 2D -  This Option will usually 

depend on whether you 
produce coloured plans or, 
simple line drawings.   

 
 For those who produce coloured 

plans, you are likely to want to 
display the triangles which make up a coloured 
object.  If you prefer to produce line drawings, a 
simple 2D symbol is all that is required.  The 
lamp post to the right shows the 3D triangulated 
model but the 2D symbol is a simple line 
drawing in which no triangles are displayed. 
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Always Face Camera  This feature causes the point to rotate to face the 
screen.  This has the effect of producing a 3D 
effect for flat objects.  A tree is a good example of 
this. 

 
Offset in 3D views  This feature minimises interference between 

triangles which are very close to each other for 
example white lines on a road surface.  It causes 
the Windows

®
 operating system to minimise the 

interference that occurs when two objects in the 
distance are vying for the same pixel on the 
screen.  

 
Having checked the appropriate options click Edit.  The main 
window now becomes the Codes editor with a green point 
displayed at 0,0,0.  This point is the survey point.  Using all 
the normal RelMo tools, create the Complex Point.   
 
You can also copy Objects that you have created in a main RelMo survey 
into the editor.  
 
Important 
When finished you must click on the Control Bar Objects tab and merge 
any Objects with the Root Object which will have the name that you gave 
for the code.  Once finished, quit the codes editor using Quit 
symbol  
 
Click Save and your Code will be saved. 
 
Note - To make this Code available for all future surveys, you will need to create it in, or 
drag it into, the Codes.rlm survey that (by default) resides in C:\ Program files\AiTS\Bin. 
 
Adding Points  
There are two ways of adding a point.  To add a simple point and have the 
opportunity to change its coordinates, ensure that the Object that you wish 
to add the point to is Active and, from the Points menu, select Add Points 

or, click on the add points button  
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Click on the screen where you want to add the 
point.  The Add point dialog will appear.  You can 
select the point style from the drop down list of 
codes or, if you do not know the Code, click on 
the … button.  A full list of codes and their 
description will appear. 
 
Note that if the point is a Complex one you also have 
the opportunity to define its angle (from screen north).  
For example this is useful to ensure that a lamp post is 
facing the right way.  You can also correctly proportion 
the code by defining the size of its X, Y and Z 
coordinates.   
 
For users of EDM equipment, you can proportion the code at the scene 
using additional Attribute codes, (see page 39). 
 
The second, and more diverse method of adding points is from the Design 
menu.  To add a point to an Object using this method, ensure that the 
Object is Active and select Add Points from the Design menu.   
 
The Add Points dialog will appear.  You are presented with a number of 
different options for adding points.  You can define a style for the new 
points.  To change the point style, click on the three dots and select the 
point style from the list.  If you wish to create a line between the points 
create, check the create line box and select the line style by clicking on the 
three dots. 
 
You can now choose the method by which you 
wish to add the points.  Provided the model has 
been triangulated, points will land on the surface 
of the model unless the Force default height box 
is checked.  If you check this box, you can enter 
the height for the point in metres. 
 
Freestyle points 
Freestyle allows you to add points by placing the 
cursor over the place where you wish to add the point and clicking the left 
mouse button to create the point.  The new point will appear on the model 
in the style set in the Add points dialog box.   
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Adding by coordinates 
Adding by coordinates allows you to type in the easting and northing of the 
point again, the point will land on the surface of the triangulated model 
unless a default height is entered. 
 
Adding by line and offset 

Adding by line and offset allows you to 
locate the two points on the ground 
model at either end of the line.  To do 
this click on Locate points, the Add 
Points dialog will disappear.  Click on 
the points at each end of the line. If the 
show baseline box is checked, the 
baseline will be shown on the model as 
a dotted line.  The Add points dialog will 

reappear.  Enter the distance along the baseline and the distance off.  
Check either create to left or create to right where the green dot indicates 
the end of the baseline.  Click preview and the point will appear as a red 
dot on the model.  If the position looks correct click Add and the point will 
be added.  Again, the point will land on the surface of the triangulated 
model unless a default height is entered. 
 
Adding by two distances (triangulation) 
Adding by two distances or, using the triangulation method again allows 
you to locate the fixed points on the ground model.  To do this click on 
Locate points, the Add Points dialog will disappear.  Click on the fixed 
points on your survey. If the show baseline box is checked, a baseline will 
be drawn between the two fixed points as a dotted line.  The Add points 
dialog will reappear.  Enter the distance of the new point from fixed point 
one and the distance from fixed point two and choose create to left or right 
of the line.  Again, a preview of the point location will appear in red.  If the 
two distances are too short to provide an intersection, a warning message 
will appear in the Add points dialog.  If the provisional point is in the correct 
location, click Add and the point will be added.  Again, the point will land on 
the surface of the triangulated model unless a default height is entered. 
 
Adding by true bearing and distance 
Adding by true bearing and distance allows you to add a point by defining 
the direction and distance from another point.  To do this click on Locate 
points, the Add Points dialog will disappear.  Click on the point that you 
want as your reference point.  The Add points dialog will reappear.  Enter 
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the true bearing and distance the new point.  Again, a preview of the point 
will appear in red.  If the provisional point is in the correct location, click 
Add and the point will be added.  Again, the point will land on the surface of 
the triangulated model unless a default height is entered. 
 
Orthogonal to line 
Creates an additional point at 90º to the end of a line and then creates a 
new baseline from the end of the first line to the new point allowing you to 
add another new point at 90º to the new line.  In this way a series of new 
points can be created in a ‘step’ fashion. 
 
First use the Locate Points button to select the first baseline, the Add 
Points dialog will disappear allowing you to select the two points with the 
mouse.  The Add points dialog will reappear.  Enter the distance from the 
line and whether the point is to be created to the left or right of the baseline.  
Preview the point (shown in red) using the Prev button and if correct click 
the Add button. 
 
Angle from line 
Creates an additional point at a specified angle and distance from the end 
of a selected line. 
 
First use the Locate Points button to select the baseline, the Add Points 
dialog will disappear allowing you to select the two points with the mouse.  
The Add points dialog will reappear.  Enter the angle and distance from the 
end of the line and whether the point is to be created to the left or right of 
the baseline.  Preview the point (shown in red) using the Prev button and if 
correct click the Add button. 
 
 
Deleting points 
To delete a point in an Object, make the Object Active.  Right mouse click 
and select Delete Point from the Points menu or from the Draw menu 
select Points, Delete Point.  Alternatively click on the Delete Points 
button.  If the point is linked to another point by a line, a warning message 
appears, click yes if you still wish to delete the point and, its attached lines. 
 
Note – If you delete a point that has been triangulated into the model, the triangles attached 
to that point will also be deleted.  You will need to create new triangles using the Add 
Triangle routine on page 85. 
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Moving points  
To move a point, right mouse click and select Move from the Points menu 
or from the Draw menu select Points, Move Point.  Alternatively click on the 
Move point button. 
 
Click on the point, (the cursor will snap to the point), and with the left 
mouse button depressed drag the point to its new position. 
 
Note – If you move a point that has been triangulated into the model, the triangles attached 
to that point will also move. 
 
 
Rotating points 
With complex points it may be necessary to rotate the point to get it to face 
the right way.  For example a streetlamp.  Select Properties from the Points 

menu or click on the Points Properties button .   
 
The Points Properties box will appear. 
 
You can change the rotation of the point by 
setting a figure of between 0 and 360 in the 
Complex style Angle box.  0 is the top of the 
screen. 
 
 
Point Properties 
To interrogate or alter the Properties of a point, 
right mouse click and select Properties from the 
Points menu or from the Draw menu select Points, 
Properties.  Alternatively click on the Properties 

button  . 
 
 
Changing points 
You can quickly change the style of a point by 
selecting the style from another point within the 
survey.  You can also change the style of all the 
points within an Object.  From the Points menu 
select Change Points and choose from One by 
One or Entire Object. 



POINTS 

AiTS International  102 

If you select Entire Object, all the points will be changed to 
reflect the current default style.  If you select one by one, the 
cursor will change.  Now select the style you want to apply by 
clicking on the dropper tool and clicking on the point 
whose style you want or by right mouse clicking on a point 
in the Points Tree in the Resources ControlBar.  The 
cursor will then change back to the Change Points cursor 
and you can click on each point to which you wish to apply 
the new style. 
 
 
Selecting points 
You can select individual points or groups of points.  There are several 
methods of selecting points.  To select points, from the Points menu go to 
Select Points and chose from one of the four methods shown below.  
Selected points appear with a red outline. 
 
One by one  
One by One allows you to Click on the 
individual points you wish to select.   
 
Note – RelMo remembers the order in which you 
select the points.  This can be useful when using 
commands such as create parallel when deciding 
whether to create to the left or right of the original 
points. 
 
Block selection  
This command allows you to drag a box with the left mouse button 
depressed around a number of points to select them all.   
 
Select by line 
This command allows you to click on a line.  All the points on 
that line will be selected. 
 
Select by Style 
Selecting by Style displays the Style dialogue 
box.  Choose the point code for the style you wish 
to select (click on … if you need to see a 
description of the code) and click OK.  All points 
of that style within the Active Object will be selected.  
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Extruding points 
Once a Point or series of points have been selected using Select Points 
from the points menu, they can be extruded.  Extruding points allows you to 
grow a vertical panel to a specified height.  This panel can be coloured and 
or, rendered with an image.  For example, the digital image of an actual 
house can be added to a survey of a street. 
 
Extruding points will depend on the way in which you have surveyed.  
Users with reflectorless electronic distance measuring equipment are able 
to take observations of top corners of buildings etc. using the –OBJ 
command (see page 31) in such cases, the panels are added to the points 
in 3D mode (see page 145) as the points for the top of the panel already 
exist and it is therefore unnecessary to add further points to form a panel.  
Users who require a reflector or who have created a survey from scratch 
will need to add the additional points at a height measured or known to the 
user. 
 
For more information on extruding panels and adding images see the 
section on Panels on page 127. 
 
 
Offsetting points 
Having selected your points, this feature allows you to move the selected 
points by a specified distance north or east or to change their height.  For 
south and west, or to lower the point, use a negative value.  Any line 
attached to the points will also move. 
 
 
Creating parallel points 
Having selected your points, this feature 
allows you create a single point or a 
series of points parallel to the selected 
points.  This is a powerful feature as it 
allows you to create different point styles 
for the new points, join them with a line 
and, fill the space with triangles.  If you 
are creating a survey from scratch, this 
tool can prove to be a great time saver.  
(Also see create Parallel lines on page 
118). 
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Right mouse click and select Points, Select Points and choose from block 
selection or one by one.  Each point you select will be highlighted in red.  
Once you have selected the points, right mouse click and select Create 
Parallel.  The Create Parallel Points dialog will appear.   
 
Select the lateral (sideways) offset in metres and enter any vertical offset. 
 
Select Create to left or right of the existing points where left is to the left of 
the points in ascending observation number.   
 
Select close path if you are joining the points with a new line style and wish 
to join the first new point to the last new point.   
 
You can choose to change the point style by checking the Use new point 
style button and changing the style using the … button.  If you leave this 
box unchecked, the new points will be created in the same style as the 
originals. 
 
You can choose to create a line style between the new point by checking 
the Create line from new points button.  Check the use new line style box 
and select the line style by clicking on the … button. 
 
Finally you can force the software to triangulate the surface between the 
new and existing points.  To select the fill style, check the box and chose 
the texture and fill colour for the triangles.  Click OK and the new points will 
be created. 
 
 
Selecting a group of points to create a new Object (cloning) 
Having selected your points, you can create a new Object 
from the selected points.  Right mouse click and select 
Clone area. 
 
The Add New Object dialog box appears. 
 
Give the new Object a meaningful name.  You 
can now set the Properties of the Object 
including its height above the source Object.  
See Object Properties on page 64 for further 
details. 
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When you click OK you will be asked whether you want to keep or delete 
the original points.  Choose which is appropriate.   
 
Any points and lines attached to the points will now be copied to the new 
Object. 
 
 
Converting a Point to an Object 
You can convert any RelMo complex point to an Object.  
This is useful where you may wish to animate a complex 
point (such as a tree which falls over).  As only Objects 
can be animated, you will need to convert your point to an 
Object. 
 
On the Resources Control Bar, expand the points tree.  
Right Click on the point you wish to convert.  Click Copy 
As Object.  Your point will be converted to an Object 
within the current Active Object. 
 
 
 
 
 
Merging Points 
The merge points command will create one point where multiple points 
exist in the same place i.e. with the same x, y and z coordinate.   
 
The merge points command is Object based.   
 
Any lines attached to the multiple points will be preserved after the points 
have been merged. 
 
Select Merge Points from either the Objects or Points menu. 
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Lines 

An Introduction to Lines  
Whether you are trying to achieve a 2D line drawing, 2D coloured survey or 
3D model, you are likely to have to add or change some lines.  You can 
also design schemes from scratch by manually adding points and linking 
them with lines.  
 
The colour, style and thickness of these lines is contained in the Codes 
Library.   
 
Where you are importing point data you will normally link lines between 
points, however RelMo allows the user to create lines from scratch.  These 
lines are called freestyle lines. 
 
Displaying lines 
If lines are not shown, from the Display menu select Show Lines. 
 
Identifying lines 
You can identify a line by hovering over the line to obtain feedback.  To 
switch this option on, go to Screen Options from the 
View, Options menu and check both boxes in the 
Display options section of the dialog. 
 
Show tool tips allows the user to hover over a point to 
show a ToolTip which lists, line code and the number of 
points in the line.  This feature only works in 2D. 
 
Selecting a line 
To select a line, click on the Select line tool and move the cursor 
over the line which will highlight.  Clicking the left mouse button 
will select the line. 
 
You can adjust the sensitivity of the highlight tool by 
changing the value of Line tolerance in View, Options, 
Screen.  The value represents the distance in pixels from 

the line before it is highlighted. 
 
In 3D view, you must click on a point attached to the line.  
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Resolving Ambiguity 
If you select a line which is very close to another line, 
the Resolve Ambiguity dialog box will appear.  Select 
the line you wish to edit from the list.  To avoid this 
happening, try zooming in further before selecting the 
line. 
 
Simple and Complex lines 
There are two different types of line, Simple and Complex.   
 
Simple lines are lines that contain a basic line styles such as a solid, 
dashed or dotted line.  They can be curved or straight and their width and 
colour can be defined. 
 
Complex lines are built by the user from, points lines, triangles and panels 
to form a solid 3D shape.  They also have a 2D symbol.  See the following 
section for further details. 
 
Line codes 
Every line has a unique code.  When you give a line the relevant code, the 
2D symbol and in the case of complex lines, the 3D shape associated with 
that code will be drawn between points at the correct location.  It is good 
practice not to start line codes with the letter P.  This allows unknown line 
codes to be linked up on import if the ‘auto-create line for unknown line’ 
features is turned on in View, Options, Survey Import.  If a code does start 
with a P, it is assumed to be a point code and will not be linked by the auto-
create routine. 
 
There are several different types of line code including auto repeat, 2 point 
lines and three point lines.  Briefly,  
 

o An auto repeat line will continue to repeat its symbol until told to stop.  This code is 
used for features such as walls carriageways, white lines etc. 

 
o A two point line code will end after the second point.  The symbol will stretch 

between the two points.  This code is used for features such as road arrows. 
 

o A three point line code requires the base and height to be entered to cause the 
feature to stretch to, in effect, fit the box you have created with the three points.  It 
will automatically end after the third point has been entered.  This code is used for 
features such as road text. 

 
For more detail, see page 30.  
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Line codes know the symbol that they are associated with therefore users 
of electronic distance measuring equipment simply need to enter the line 
code and take their observations to produce a completed line drawing on 
import. 
 
Creating and amending codes 
The style associated with a point or a line is defined in the special survey 
called Codes that resides in the C:\Program files\aits\bin folder.  Each time 
you start a new job RelMo takes a copy of the codes in the Codes survey 
and adds them to your job. 
 

You can add or amend lines or change the code 
associated with a line.  If you want these changes to 
be available to all new jobs, you need to make the 
changes in the Codes survey. 
 
To access the Code library you will need to display 
the Resources Control Bar (page 10). 

 
Complex codes are indicated by a striped symbol (curved for curved line 
styles and straight for straight styles).  Simple codes are indicated by a 
solid symbol, again either curved or straight.  When you click on a complex 
code a preview of its symbol appears in the Preview Control Bar if you 
have it open. 
 
If you are changing to RelMo from another surveying package, it is 
recommended that you change your RelMo codes to match the ones that 
you are used to using.  Some things will need to change for example you 
will have to comply with the RelMo protocols for starting and ending line 
codes. 
 
Whether creating new or amending existing codes, you have a number of 
options. 
 
Right mouse click on the code you wish to amend or any 
code if you wish to make a new one.  Choose Add to 
make a new code, edit to amend an existing code or 
Properties to change the code or description. 
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To create a new code, right mouse click on a 
code and click Add.  The add New Line Style 
dialog box appears. 
 
Type in a Code (this can consist of letters or 
numbers).  Remember, by convention you should 
not use a P to start a line code.  You should also 
ensure that you do not duplicate codes in both 
Points and Lines.  Add a description that will 

appear as a tool tip in the Control Bar window.  Select the style, you can 
choose from a range of simple lines or a complex straight or curved line. 
 
In relation to simple lines, change the colour and pen width of the line to 
reflect the colour and thickness of the line that you want to appear on 
screen and print out on any plans.   
 
If you wish to design a complex shape, select complex straight or curved 
from the drop down box.  Changing the colour for a complex line will 
change the colour of any simple lines that are included in the object to that 
colour. 
 
Note – Complex straight or curved relates to whether the code is to be a curved or straight 
line style.  For example it is reasonable to assume that a hedge line would follow a curved 
line, however a brick wall would be in straight sections, thus the hedge would be complex 
curved and the wall complex straight. 
 
In relation to Complex codes there are a series of further options.  You can 
choose from Normal (auto-repeat), 2 point or 3 point line codes as 
described above and on page 30. 
 
Show simple lines in 3D - You can choose whether the 

simple lines that you use in 
your code should be shown in 
3D.  In the example to the 
right where a series of simple 
lines have been added to 
simulate a mesh, these are shown in 3D.   
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Show triangles in 2D - This option allows triangles to be shown in 2D.  
In the case of the fence above, they would not 
normally be shown as the fence has simple 
lines to depict its shape for printing.  However in 
the case of, say, a road marking code such as 
an arrow or give way symbol, they could be 
shown in 2D as they are created from triangles.  
The example to the right demonstrates this 
where the user prefers to plot coloured in 2D 
plans.  For users who prefer line 
drawings, the lines that surround the 
shape rather than the triangles would 
be shown. 

 
Offset in 3D views -  This minimises interference between triangles 

which are very close to each other.  This feature 
is useful where you create something that is 
more likely to lie on rather than stick out of a 
surface such as the road marking above.  In 
effect when this option is selected, Windows

®
 

lifts the symbol off the surface when it is in the 
background and places it back on the surface 
when in the foreground.  The effect is never 
seen by the user. 

 
Once you click edit, the main window becomes the Codes editor.  A guide 
line will appear as a dotted line as you start to create your Complex Code.  
In RelMo the start of any line is coded as green and the finish as red.  In 
addition the guide line depicts the survey line.  Thus in the diagram below, 
the point that starts the line style should be placed or surveyed centrally 
and the style will start with a solid and dashed line. 
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The start of the guide line is at 0, 0, 0.  The advantage of the guide line is 
that it allows you to design codes that are offset from the surveyed line 
such as hedge to the left and hedge to the right (both supplied with the 
program). 
 
Note the way in which the line is designed.  Only one instance of the style 
is built as the line will continue to repeat itself when used in the survey.  
This also applies to the barrier with fence on the previous page, only one 
upright has been built and the crossbars are added at the correct length as 
far as the next upright.  When used, the first upright will repeat itself as the 
second upright. 
 
In the road line style, the points are positioned at metre intervals as this is a 
curved line style.  With points positioned like this the curving will be 
smooth. 
 
It is important that, when you have finished creating your code, you must 
click on the Objects Control Bar and merge any Objects with the Root 
Object which will have the name that you gave for the code.  Click Save 
and your Code will be saved. 
 
Note - To make this Code available for all future surveys, you will need to create it or, drag it 
into the Codes.rlm survey that (by default) resides in C:\ Program files\AiTS\Bin. 
 
Remember 
If you have created your Code in a different survey you can simply open 
the Codes survey and from the Resources Tab on the Control Bar, drag 
your new code into Codes, save the Codes survey.   
 
 
Adding lines between points 
Ensure the Object containing the Points you wish to link is the Active 
Object.   
 
Right mouse click and select Draw Line from the Lines menu.    
Alternatively, click on the Draw Lines button.  The Add New Line 

dialog will appear. 
 
To bypass this dialog box, in the Resources Control Bar 
right click on the line style you wish to use and click 
Draw Lines.  
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The Add New Line dialog allows you to set the line 
properties prior to drawing it. 
 
Select the Code from the drop down list.  If you do 
not know the Code, click on the … button.  A full 
list of codes and their description will appear.  You 
can select the code from this list. 
 
Forcing lines to be straight or curved 
Although each code has a style such as straight or curved, you can force a 
straight line to be curved or, a curved line to be straight by changing the 
Curve style.  You can also force a line to be straight or curved, overriding 
it’s default properties.  If you use an EDM you can also do this at the survey 
site using special codes called Attributes, (see page 39). 
 
Overriding Complex styles 
If the line is a complex style you can again override some of the codes 
existing properties.   
 
Auto repeat - This will force the line to be a repetitive line code such as 

a kerb line.   
2 point code - This will cause the style to stretch to fit between two 

surveyed points.  This is useful when placing features 
such as road surface arrows onto the road surface 
although arrows etc. should be set up as 2 point line 
styles by default.   

3 point code -  This will cause the style to stretch along the base and to 
the depth specified by a third point. Again, these codes 
should be set up by default.   

AutoScale width - This prompts RelMo to expand or contract the width of 
the complex line dependent on its length. In this way 
scaling automatically ensures that the overall shape of 
the complex feature remains the same, however large (or 
small) it may be drawn.  The Height option, if set to a 
positive value greater than 0, forces RelMo to display the 
complex line features at whatever height you set. Thus 
only one code is then necessary for say, hedges or walls.  
You can then set the height in this box to create hedges 
or walls at a different height.  Similarly you can override 
the default code width of a complex line to draw features 
at a particular width. 
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Closing lines 
If you choose to close a line or, close a line and fill it with a colour, hatching 
or texture, when you escape from the last point in the string, RelMo will join 
to the first point of the line to the last point of that line and, where 
appropriate, fill it with colour and or textures. 
 
 
Adding Freestyle lines 
Lines are normally created by linking existing points however you can 
create freestyle lines in which case a point will be added wherever you click 
on the screen and, the line will be drawn between the points in the style 
selected. 
 
Either create a new Object from the Objects Control Bar or, set the Object 
in which you wish to draw the line Active.   
 
Right mouse click and select Draw Line from the Lines Menu.  
Alternatively, click on the Draw Lines button.  The Add New Line 

dialog will appear.   
 
To bypass this dialog box, in the Resources Control Bar 
right click on the line style you wish to use and click 
Draw Lines. 
 
Holding down the Control key click on the survey where you wish to start 
your line, a point will appear and you can now carry on creating the line by 
clicking on the screen.  If at any stage you want to link to an existing point, 
release the Control Key. 
 
If the grid is displayed and snap to grid is turned on, holding down the 
Control Key will cause the point to be created at the nearest grid 
intersection. 
 
 
Changing lines 
You can quickly change the style of a line by selecting the style from 
another line within the survey.  You can also change the style of all the 
lines within an Object.  From the Lines menu select Change Lines and 
choose from One by One or Entire Object. 
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If you select Entire Object, all the lines will be changed to reflect the current 
default style.  If you select one by one, the cursor will change.  
Now select the style you want to apply by clicking on the dropper 
tool and clicking on the line whose style you want.  The cursor 
will then change back to the Change Lines cursor and you can click on 
each line to which you wish to apply the new style.  The changes will be 
reflected straight away. 
 
 
Deleting and unlinking Lines 
Deleting a complete line 

You can delete a whole line.  Make the Object that contains the 
Line the Active Object.  Select the line using the select line 
button, right mouse click and click on Delete Line or, from the 
Lines menu, click on Delete Line.  The line will be deleted but the points will 
remain.  If you do not want to delete a whole line, you can either unlink 
segments of the line or delete a segment of the line (see below). 
 
Unlinking a line 
To delete only parts of a line, from the Lines menu select Unlink 
Points or, click on the unlink button. The cursor will change 

allowing you to click between points to unlink them.  
Continue along the line from point to point.  If you 
miss an interim point, you cannot unlink.  Escape will 
free you from the line, allowing you to remain in the 
unlink command; using the escape key again will 
free you from the Unlink command.  When you 
unlink, the points are not deleted. 
 
Deleting a segment 
A segment is part of a line between two points. 
 
If you want to delete a single segment rather than 
unlink a series of segments, Click on Delete 
Segment from Lines, Segments, from either the 
main Lines menu or by right mouse clicking.   
 
Click anywhere along the segment you wish to 
delete.  The points will not be deleted. 
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Moving lines 
Moving whole lines 
Lines can be moved.  When moved, their points will also move.  To move a 
line, first select the line and then right mouse click and select Move.  Use 
the cursor with the left mouse button down to move the line.  The points of 
the line retain their original height. 
 
 
Moving line segments 
You can move a single line segment.  Click on Move Segment from Lines, 
Segments, from either the main Lines menu or by right mouse clicking.  
With the mouse, drag the segment you wish to move to the new position.  
The points will retain their original height. 
 
 
Line properties 

The properties of a line can be 
inspected and amended from Line 
Properties. 
 
Right mouse click and from the Lines 
menu select Properties.  Alternatively 
click on the Line Properties 
button.  The Properties 
dialog appears.   
 
You can now make alterations to the 
Line.  See Adding Lines on page 111 
for the options.   
 

In addition, you can also add or delete points to a line 
 
Increasing the number of points in a line 

In an earlier section we said that sometimes triangles would break across 
two surfaces.  Version 5 onwards minimises these problems by searching 
for lines that cross triangles (see page 45).  However if you do find a 
situation where the triangle edges do not break along lines, this feature 
allows you to add points to a line and re-triangulate the model.  This feature 
is also useful when designing new Objects where additional points can be 
added to help build complex line styles. 
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The screenshot on the following page demonstrates the problem with 
triangles that break across two surfaces. 
 
One solution is to add more 
points to the line between the 
two surfaces and re-triangulate 
the model. 
 
From Line Properties check the 
Enable Insert and Remove check box.  Click on Insert Points and click the 
button marked … . 
 
The Insert Points dialog will appear.  You can choose from three options. 
 

The first is to insert points at a regular interval.  
This option requires you to specify the 
minimum interval for the points. 
 
 
The second is to divide the line into a number 
of segments in which case points will be added 
to create the number of segments you specify. 
 
 
The final method is to use the smart insertion 
routine whereby points will be added to the line 
where the curvature of the line exceeds the 
angle specified.  This has the effect of adding 
more points to tighter curves. 

 
The height of any new points will be interpolated automatically from the 
height of adjacent surveyed points.  
 
If you have added points to solve the problem of a triangle breaking across 
two surfaces, once added, re-triangulate the object from Objects Autocalc’ 
Triangles.  The new points will now be included in the 
model.  Compare the triangles in the screenshot to the 
right with those above.  The footpath and road are now 
triangulated correctly with no triangles breaking across 
two surfaces. 

FOOTPATH 

ROAD 

Triangles breaking across 
both surfaces 
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Decreasing the number of points in a line 
You can remove points from a line.  This feature is useful if you have 
imported too many points on a line such as can happens with some DXF 
files.  If you remove too many points from a curved line it will lose the 
original curves.  Use Edit Undo or Control+Z if this occurs. 
 
From Line Properties check the Enable Insert and Remove check box.  
Click on Remove Points and click the button marked ‘…’.  The Reduce 
Points dialog will appear. 
 

You can choose to reduce the number of points 
along a line by specifying the maximum point 
spacing.  Any points at a lesser interval will be 
removed.   
 

The SmartReduce option removes points only if the angle between 
adjacent points exceeds a certain amount that can be set in the associated 
edit box. Hence multiple points very close together (typical of DXF files) will 
be ignored. 
 
SmartReduce can be combined with the maximum point spacing to 
efficiently remove lines with large numbers of points. 
 
 
Extruding lines 
Once a line has been selected using Select Line from the Lines menu, they 
can be extruded.  Extruding lines allows you to grow a vertical panel to a 
specified height.  This panel can be coloured and or, rendered with an 
image.  For example, the digital image of a wall can be added to a survey. 
 
Extruding lines will depend on the way in which you have surveyed.  Users 
with reflectorless electronic distance measuring equipment are able to take 
observations of top corners of buildings etc. using the –OBJ command (see 
page 31).  In such cases the panels are added to the points in 3D mode 
(see page 145) as the points for the top of the panel already exist and it is 
therefore unnecessary to add further points to form a panel.  Users who 
require an EDM with a reflector to record points or who have created a 
survey from scratch will need to add the additional points at a height 
measured by or known to the user. 
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Right mouse click and select Lines, Select Lines.  Once you have selected 
the line right mouse click and select Extrude.   
 
The Panel Properties dialog will appear.  You can select a solid colour and 
a texture.  For more information on adding digital images see the section 
on Panels on page 127. 
 
 
Offsetting lines 
First Select the line and then right mouse click.  Select Offset, the offset 
line dialog will appear.  Enter the distance to be offset north, east, or height 
(negative for south, west or lower), and click OK. 
 
 
Creating Parallel lines 
This feature allows you create a new line 
parallel to an existing one.  This is a 
powerful feature as it allows you to 
create different point and line styles for 
the new line and, fill the space with 
triangles.  If you are creating a survey 
from scratch, this tool can prove to be a 
great time saver.  (Also see create 
Parallel points on page 103). 
 
Right mouse click and select Lines, 
Select Lines.  Select the line from which 
you want to create a parallel one, right mouse click and select Create 
Parallel.  
 
The Create Parallel Points dialog will appear. 
 
Select the lateral offset in metres and enter any vertical offset and click 
create to left or right of the existing points where left is to the left of the 
points in ascending observation number. 
 
If you check the Create point on parent surface button, the new points will 
land on the surface of the model (where the model is triangulated).  If the 
box is left unchecked the new points will have the same height as the point 
from which it was created. 
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Select close path if you are joining the points with a new line style and wish 
to join the first new point to the last new point. 
 
You can choose to change the point style by checking the Use new point 
style button.  Change the style using the … button.  If you leave this box 
unchecked, the new points will be created in the same style as the 
originals. 
 
You can choose to create a line style between the new point by checking 
the Create line from new points button.  Check the use new line style box 
and select the line style by clicking on the … button. 
 
Finally you can force the software to triangulate the surface between the 
new and existing points.  To select the fill style, check the box and chose 
the texture and fill colour for the triangles. 
 
 
Reversing the point order of a line 
Some Complex line styles are formed to the left or right of a surveyed line 
such as Hedge which has two codes, hedge left (HL) and hedge right (HR). 
 
If you survey the points in the wrong direction, the hedge line will be 
produced on the wrong side of the survey line. 
 
To correct this, you can reverse the order of the points.  This will have the 
effect of turning the line round.  To reverse the point order, right mouse 
click and from the Lines menu click Select Lines.  Select the line you wish 
to reverse and right mouse click.  Click on Reverse points and the line will 
be reversed. 
 
 
Breaking Lines 
Break lines allows you to make two (or more) lines from one line.  This is 
useful where you have surveyed a line with one code where in fact it should 
have been coded with more than one code.  For example, a line surveyed 
as a curved kerb where there were in fact two straight segments at either 
end.  By breaking the line at the Point where the style should change, you 
create two lines one of which can have its style changed.   
 
Using this method saves having to unlink numerous segments and then re-
linking the points with a new line style. 
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There is a second reason for breaking lines.  The way that 
RelMo creates Auto-repeat lines means that some line styles 
will ‘cut the corner’ rather than match exactly to the surveyed 
point.  The screenshot to the right demonstrates this where a 
metal barrier should map to the point indicated by the mouse 
arrow. 
 
To map the line to the point it must be broken.  Ensure 
that the Object that contains the line is the Active 
Object.  Right mouse click and select Lines, Break Line.  

Click on the Point that the line has 
missed and the Line will be broken at 
this point.  One line will now end at the 
point and the next start at the same 
point.  Occasionally this can lead to 
some chamfering on the joint. 
 
 

Merging lines 
Merging lines is the opposite of breaking lines in that two lines of the same 
style can be merged together where they share the same point.  This has 
the advantage in that once joined, you can change the style of the whole 
line rather than doing it twice.  You can also choose to merge all lines in the 
survey in which case all lines of the same style which share common points 
will be merged. 
 
Note - if you have broken a line for one of the reasons above and you then Merge the 
broken line, the line will be returned to its original state, missing the survey point. 
 
To Merge a line, from the Lines menu click on Merge Lines or, Merge all 
Lines. 
 
 
Converting a Line to an Object 
You can convert any RelMo complex line to an Object.  This is useful 
where you may wish to animate a complex line (such as a fence which falls 
over).  As only Objects can be animated, you will need to convert your line 
to an Object. 
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On the Resources Control Bar, expand the lines tree.  
Right Click on the line you wish to convert.  Click Copy As 
Object.  Your line will be converted to an Object within the 
current Active Object. 
 
 
Spinning lines 
See page 137 
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Taking measurements from the model 

Querying Distances  
You can measure distances, slopes and radii within the model.  The 
diagram below shows how RelMo reports the various distances between 
points. 
 
 
 
 
 
 
 
 
From the Query Window, select from the commands shown in 
the screenshot to the right.  The various commands are 
explained below. 
 
Points Distance 
Reports the Slope, Horizontal and Vertical distances between two points.  
The distances are reported at the bottom of the screen as shown below.  
The bearing from the first point to the second is also given.  Finally, the 
slope is given in degrees.  The slope is from the first to the second point 
with a negative value indicating a decline. 

 
 
String Distance 
Use the String Distance command to click on a number of points along a 
line.  The slope and horizontal distances together with the change in height 
between the first and last point will be displayed.  Note that clicking on the 
first and last point of the line does not report the distance along the whole 
line. 
 
Simple Distance 
Use the Simple Distance command where you want to find the distance 
between any two places on the model.  When you use this command, you 
are not restricted to clicking on a point.  Only the horizontal distance is 
reported. 

SURFACE 

Vertical Distance (VD) 

Horizontal 
Distance (HD) 

Slope 
Distance (SD) 
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Querying Radii 
2D Radius 
You can find the radius of any three points by using the Radius command.  
Click on any three points in sequence, the circle will be displayed on screen 
and the 2D radius together with the centre point in metres north and east 
will be displayed.  The length of the arc formed by the points you selected 
is also given. 
 
3D Radius 
You can find the radius of any three points by using the Radius command.  
Click on any three points in sequence, the circle will be displayed on screen 
and the 3D radius together with the centre point in metres north, metres 
east will be displayed as shown below. 
 
 
Querying Angles 
2D Angle 
You can measure an angle between any three 
points.  Make the Object that contains the points 
the Active Object.  From the Query menu select 
Angle 2D.  Click on the three points in the order 
shown to the right.  The angle (ignoring any 
height change between the points) will be given 

at the bottom of the screen.  
 
 
3D Angle 
Like the 2D angle command above you can measure an angle between 
any three points and include the change in height between the points as 
part of the calculation.  Make the Object that contains the points the Active 
Object.  From the Query menu select Angle 3D.  Click on the three points in 
the same way as you do for 2D angles.  The angle  will be given at the 
bottom of the screen.  Incidentally, the screen shot of the 3D angle here is 
the same angle measured above. 
 
 

1 

2 

3 
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Adding dimensions 
You can add both linear and angular dimension arrows to your 2D plan.  
The advantage of adding these arrows is that they automatically calculate 
and display the distance on the 2D plan.  By default the slope distance is 
displayed in metres, however you can change this to display the horizontal 
distance, choose different units and alter the precision. 
 
There are three types of Dimension, Add Dimension, Add Simple 
Dimension and Add Angular Dimension. 
 
Adding the Dimension 

From the Dimension menu select either Add Dimension 
or Add Simple Dimension.  Add Dimension allows you to 
add a dimension between points, Add Simple Dimension 
allows you to add a dimension between any two places 
on the model.  The dimension cursor will be displayed.  
Click on the two places between which you wish to measure. 
 
A Dimension arrow will appear with the slope distance.  
displayed.  The dimension is displayed directly between 
the two places that you clicked.  You can now alter the 
position of the dimension by offsetting it. 
 
Setting the Properties (Linear Dimension) 
Having added the dimension you can now set its Properties.  From the 
Dimensions menu select Properties.  With the mouse, select the Dimension 
you wish to alter the Properties of.  The Properties dialog for that dimension 
will appear. 
 
In relation to the arrow, you can 
change its colour and the type of arrow 
head and its size. 
 
You can choose 
whether to display the 
end extensions and 
specify their length 
and whether there should be a gap between the extensions and the points 
to which they refer. 
  

12.3 

END EXTENSION 
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By default, units are not shown, you can check the box and the units will be 
displayed after the distance.  You can also choose whether the slope or 
horizontal distance is displayed, (see page 122 for the difference between 
slope and horizontal distance). 
 
You can check the level of precision by entering the number of decimal 
points that will be displayed. 
 
In relation to the text you can choose the colour and font as well as the way 
in which it is displayed (rotation). 
 
Finally you can define the display units. 
 
Adding an Angular Dimension 
From the Dimension menu select Add Angular 
Dimension.  The dimension cursor will be displayed.   
 
 
 

 
Click on the angle in the order shown on the diagram 
to the right, you do not have to click on points and 
you can reverse the order from 3 to 2 to 1 to display 
the outside angle.  
 
The dimension lines will be displayed together with 
the angle. 
 
You can now alter the Properties of the dimension. 
 
Setting the Properties (Angular Dimension) 
Having added the dimension 
you can now set its Properties.  
From the Dimensions menu 
select Properties.  With the 
mouse, select the Dimension 
you wish to alter the Properties 
of.  The Properties dialog for 
that dimension will appear. 
 
  

1 

2 

3 
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You can change the colour of the dimension lines, the offset of the arc and 
the offset of the text position.  (Offsets are a percentage of the length of the 
dimension line). 
 
You can choose whether or not to display the arc and where the arc is 
greater than 180, reverse the measurement.   
 
The angle can be shown in degrees or radians and the precision specified 
to a number of decimal places. 
 
The colour and size of the text can be altered as well as the text position.  
Finally, the reverse measurement can be shown. 
 
Offsetting the Dimension 
From the Dimension menu click Offset Dimension.  The 
cursor will change.  Move the cursor over the dimension 
you wish to offset, it will turn white.  Drag the Dimension 
to the position you want it. 
 
The arrow and text will be moved and two offset lines 
will be produced as shown to the right. 
 
Moving the dimension line 
You can move the line and text by selecting Move from 
the Dimension menu and dragging the arrow with the 
mouse.  The line, any extensions and text will all move. 
 
Deleting the dimension line 
You can delete the line and text by selecting Delete from the Dimension 
menu then clicking on the dimension you wish to delete. 
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Panels 

Introduction 
Panels are used to raise colour or textures from the surface of the model.  
The general principle to be applied is, where a surface is horizontal or 
tends towards horizontal, triangles are used to colour or add textures where 
the surface is vertical or tends towards vertical use panels. 
 
Panels are grown by selecting points, stipulating a height and colour / 
texture for the panel.  The software generates new points above the 
selected points at the top of the panel and renders it with the image / colour 
selected. 
 
General uses include creating 3D walls, trees, 
buildings etc. as shown in the screenshot to 
the right. 
 
The points at the top of the Panel are automatically generated by the 
software in response to the height that you enter into the dialog box.  
Where users are able to use reflectorless EDM equipment to precisely 
produce points at the top of the Panel, use the 3D editor to render your 
Panels.  See page 129 for further details. 
 
The points at the top of a Panel may be moved to form sloping panels for 
the creation of pitched roofs etc.  This is best done in the 3D editor. 
 
 
Adding panels – 2D 
Make the object that is to contain the panel the Active Object.  Right mouse 
click and select Add Panels from the Panels menu.  Alternatively select 
Add Panels from the Panels menu or, click on the Add Panels button. 
 
Select the points where you want to grow 
the panel.  If you are closing an Object for 
example creating a solid wall, you will need 
to click on the start point of the Panel as the 
last point to create the fourth side as shown 
in the diagram to the right.  
 
If you want to create a panel between points in two different Objects, you 
will need to merge the Objects before you create the Panel. 

1 

2 

4 

3 

5 
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Once you have selected all the points, right mouse 
click and select Extrude.  The Set Panel Properties 
dialog will appear. 
 
Type in the height for your panel.  You can also 
choose to display as a bright panel in which case 
the shadowed side will appear as bright as the side that is facing the light 
source.  You can also choose to display only the front face.  This can be 
useful if you only want to display one side of a building for example.  If you 
check the box, the panel will appear invisible when looking from behind 
which may mean that you need to add a back to the panel in a solid colour.   
 
To change the Texture, click on … .  The Surface Properties dialog box will 
appear.  Select the appropriate texture for your panel also set the repetition 

to correctly size the image.  If you don’t 
require a Texture, select None from the 
list of textures and select a solid colour 
instead. 
 
If you are creating a panel where the 
texture should not be replicated, for 
example a digital photograph of the 
front of a building, check the box to 
Ignore Repetition.  Remember, you 

need to load any Textures you have created into the Codes Library first. 
 
Click Ok and, OK to Set Panel Details, and the Panels will be created.  You 
can view the panel in 3D. 
 
 
Editing panels 
Editing single panels 
You can change a panels properties at any stage, note that although you 
may have strung a panel along a series of points, any changes you make 
will only apply to the single panel you have selected. 
 
Select Panel Properties from the Panels menu or right mouse click and do 
the same.  Alternatively click on the panel properties button. 
 
The Panel Properties dialog will appear.  Change the Properties as 
required. 
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Editing multiple panels 
You can find and replace panels with different Properties.  Find and replace 
affects the Active Object.   
 

Right mouse click and from 
the Panels menu select Find 
and Replace.  The find and 
replace dialog box appears.  
From the Find Properties you 
can specify particular 
properties or click on the 
Select button.  If you click on 
Select, the dialog will 

disappear allowing you to select a panel (all of which will be highlighted).  
Click on the panel you wish to find.  The dialog will reappear.  On the 
Replace With side of the dialog change the Properties to the new settings 
or, if you already have a panel with those Properties click on Select and 
mouse click on the panel.  Click change and all the panels you selected on 
the Find side of the dialog will change to those you selected on the Replace 
With side.  Close the dialog. 
 
 
Adding panels – 3D 
Users of reflectorless EDM’s can take observations of the top corners of 
buildings etc. where users of manual EDM’s would not be able to place the 
reflector of their pole.  In this way, digital images of the scene can be taken 
and rendered between the points to produce a correctly dimensioned 
image.  A brief description of the method to reproduce the front of a 
building follows. 
 
At the scene, use the –OBJ command (page 31) to create a new Object 
and shoot the top two corner points of your building.  Using the –OBJ 
command will ensure that the points at the top of the building are not 
triangulated into the main model.   
 
Note - If you accidentally include the points in the main model, you can separate them out 
by selecting the points and creating a new Object before you create the triangles in the main 
model (page 104). 
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Once you have triangulated the main model you will 
need to merge the points at the top of the building 
into the main model.  Drag the Object containing the 
points into the main ground model.  Then right mouse 
click on the Object and click Merge.  The points will 

now be part of the main model but, 
not triangulated into it.  
 
In 3D view, click Add 

Panels, select the image in the normal 
way and then click on each of the four 
points of your building starting at the 
bottom left and working clockwise. 
 
You may need to rotate or flip a panel if it 
has been created the wrong way round. 
 
 
Rotating Panels (3D command) 
If you have not followed the clockwise rule when 
you created your panel, you may find the image is 
on its side. 
 
Where this occurs, you can rotate the points which 
in turn will rotate the image. 
 
This command is only available in 3D.  In 3D, 
make the Object that contains the panel the Active Object 
and enlarge the points.  From the main Panels menu select 
rotate points.  Click on the panel you wish to rotate, you 
can continue to click until it is all the way back to the 
original orientation.  
 
The image to the right has been corrected. 
 
You may need to combine this routine with the Flip 
Panels routine below. 
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Flipping panels 
If you find that the image is facing the wrong direction you can flip the 
image to face the other way.  From the Panels menu select Flip.  
Alternatively click on the Flip Panels button.  Click on the panel 
(not the points) to flip the panel.  You may need to combine this 
routine with rotate points above. 
 
Deleting Panels 
Individual panels can be deleted.  From the Panels menu select Delete 
Panel.  In 2D, click on the point to the left of the panel you wish to delete.  
In 3D, click on the panel itself. 
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Text 

Introduction 
If you are intend to Add Text for plotting, ignore this section and go to the 
printing section on page 173. 
 
Both 2D and 3D text is supported.  
Some line styles that replicate text such 
as road markings are actually created 
from a triangulated alphabet rather than 
actual text.  The alphabet survey is 
available from the resources pages of 
the RelMo website. 
 
Users of EDM equipment can also 
attach a note to a point.  On download 
these notes will appear as 2D text.  Deleting the text no longer deletes the 
point that it is attached to. 
 
You can choose whether to plot text created in the main 2 and 3D windows. 
 
As mentioned above text for plotting is not usually created in the main 2D 
window.  If you wish to add annotation for plotting see the Layout pages 
section on page 173. 
 
 
Adding 
Adding text 
To add text, first ensure that the intended plot scale is correct.  From the 
View menu click on Options and go into the Printing tab.  Set the scale at 
which you intend to plot. 
 
From the text menu select Add Text.  Click on 
the point where you wish to add the text.  The 
add text dialog will appear.  Type the text you 
wish to add, (return to start a new line).  Then 
set your Properties for both 2 and 3D and 
adjust any Borders and Leaders you wish to 
add. 
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2D Options 
You can choose whether or not to display the 
text in 2D view.  If you only wish to display the 
text in 3D view, select this option.  You can 
change the font by clicking the … button.  
Choose between left, centre or right 
justification.  You can change the colour of the 
the text by clicking on the … button. 
 
You can chose between top left, centre or right 
or bottom left, centre or right referencing.  This is in relation to the point 
which anchors the text.  You can also enter the orientation. 
 
3D Options 
You can choose whether or not to display the 
text in 3D.  The size can be altered as a 
percentage of full size.  It is suggested that 
you leave the text at 100% and then decide 
whether the size is correct by viewing the text 
in 3D view.  If it needs to be altered use the 
Properties option from the text menu.   
 
Like 2D text you can set the justification and 
change the font colour.  You can also reference the text in relation to the 
point. 
 
Borders and Leaders 
The border and leader options are different for 
2 and 3D.  In 2D you can choose whether or 
not a border is drawn.  You can set the 
margin, (the distance between the text and 
and the border) and change the colour of the 
margin.   
 
You can choose whether or not to have a 
leader.  A leader is a line drawn to a particular 
point.  If you choose to include a leader, the 
head will be shown centre top of the text attached to a null point.  Use the 
move points routine (page 101) to drag the leader to where you wish it to 
be positioned. 
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In 3D you can also choose whether or not to have a leader and whether or 
not it is to be positioned the same as the 2D leader.  If you deselect this 
option, the 2 and 3D leaders can be positioned differently.  Swap reference 
point will position the leader where the text was and the text where the 
head of the leader was.  To change the height of 3D text, query the Points 
Properties of the text, (page 101), and alter the height. 
 
 
Deleting text 
From the Text menu select Delete.  Click close to the text you wish to 
delete.  The text will be deleted however the null point which held it in 
position will remain.  To delete the null point use the delete points routine, 
(page 100). 
 
 
Moving and Rotating text 
From the text menu select Move Text.  To move the text, drag it with the 
left mouse button depressed.  To rotate it, hold the shift key down and use 
either the mouse or the arrow keys. 
 
 
Attaching text to a point (3D command) 
In 3D an extra command allows you to attach text to an existing point.  
Whilst in 3D make the Object which contains the point the Active Object.  
From the Text menu select Add Text to Point.  Select the point to which you 
wish to attach the text and the Add Text dialog will appear.  Now add your 
text in the normal way.  The text will appear 5 metres above the point.  To 
change the height use the Point Properties routine, (page 101), on the null 
point created with the text. 
 
If the point to which the text is attached is contained within an animated 
object, the text will move with the animation. 
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Design tools 

Introduction 
RelMo contains a number of design tools which help you to build structures 
to be saved as Template Objects for later use or, used to create complex 
line or point styles.  All the Complex codes in RelMo are built using the 
program.  For users of some other software who have been used to 
stitching together a limited number of symbols to create a new ‘block’, this 
concept will be new.  Basically there is no 2 or 3D shape (within reason) 
that cannot be built in RelMo and saved as either a template or complex 
code. 
 
As well as the normal method of adding points these 
additional tools will allow you to create some quite 
complex shapes.  They include creating ellipses, 
arcs and rectangles and, spinning lines to create a 
3D shape from a 2D profile. 
 
For example the complex code BBG shown to the 
right was created by manually adding 4 simple 
points and adjusting their northing, easting and 
height to form the upright.  These points were then 
manually triangulated using Add Triangles in 3D.  One longitudinal post 
was then added as a child Object by creating a rectangle, filled with grey, 
extruding it with grey to the length required by the regulations.  This created 
an upright oblong which was flipped on its side using the Objects, 
Transform tools and then moved to sit against the main upright.  The copy 
and paste commands were used to create a further two longitudinal posts 
which were also moved.  In 3D, a line was created at the base in front of 
the posts,  up the side, along the front of the top post and down the other 
side (this line is not shown in 3D).  The points along this line were 
increased using Points Properties ‘add points to line’ routine and then the 
mesh was created using a simple line between the inserted points which 
was then forced to show in 3D. 
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Design Options 
You can set up the various design options 
from the Design Options menu.  This allows 
you to set various default styles for Point 
Line and Fill.  Checking the Create as child 
object ensures that the rectangle or ellipse 
is created as a sub-object in its own right.  
Once the whole Object has been created, 
you can merge the child Objects to form 
one Object. 
 
In relation to Ellipses, you can choose to fill 
the ellipse using the fill style described 
above, create a centre point and force 
straight lines to be used in 2D.  The number of points per 360º can be set.  
The maximum is 36, smaller objects require less points. 
 
Rectangle options include creating a centre point and filling the rectangle 
with the fill colour/texture set at the top of the dialog. 
 
Once these options have been set use the appropriate tool from the design 
menu to create your shape. 
 
 
Ellipses 
Having set up your Design Options, use the Design Ellipse tool to design 
circles.  Hold down the shift key for a true circle.  Once you have formed 
your ellipse, you can select the line and extrude it to form various shapes. 
 
Circle 
Having set up your Design Options, use the Design Circle option to draw a 
circle.  There are a number of circle option including; 

From 3 points Click on three points to create the circle. 
Diameter Click on two points which form the diameter. 
Radius  Click on two points which form the radius. 
Centre and radius Allows you to click anywhere on the 

model to define the centre of the 
circle.  Once this has been defined, 
the dialog to the right appears.  
You can adjust the centre and add 
the size of the diameter or radius. 
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Arcs 
Having set up your Design Options, use the Design 
arcs tool to design arcs.  You need to click on three 
existing points to create an arc.  Note that these can 
be in different objects (use the tab key to move 
between objects). 
 
Once you have your ellipse, you can select the line 
and extrude it or spin it to form various shapes. 
 
 
Rectangles 
Use the Design rectangle tool to draw rectangles.  Drag the rectangle to the 
size you want using the left mouse button. 
 
Holding down the shift key will force your rectangle to be square. 
 
Once you have your rectangle, you can select the line and extrude it to 
form various shapes. 
 
 
Spinning lines or points 
Spinning lines or points is a powerful feature that allows you to create a 3D 
object from a line or series of points.  For example the 

line on the right can be spun through 360  to create a 
solid 3D pawn from a chess set. 
 

Lines need not be spun through 360  allowing the 
user to create complex concave and convex objects which can be merged 
together to form one complex shape such as a light column or ornamental 
bollard. 
 

First draw your x axis profile using a basic 
line style (see drawing freestyle lines on 
page 113) or, by creating a series of points. 
 
When the profile is complete, select the line 
or series of points using the Select Line or, 
Select Point tool. 
 
Right mouse click and select Spin.  The 
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Spin Properties dialog will appear.  You can now select the Line style and 
Fill style for your object.  Also select whether the new Object should 
become a child of your existing work (in which case it will be given the 
name Spin in the Objects Control Bar).  The start angle where 0 is ground 
level 90 is above the x axis 180 is ground level but mirroring the line and 
270 is directly below the x axis.  When you click OK, the new 3D object will 
be created. 
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Analysing the Model 

Because RelMo is a digital terrain model, the ground model of your survey 
can be analysed to create a number of plots.  These plots are produced as 
Child Objects of the main ground model and can be turned on or off.  They 
can also be added to the Layout Pages for subsequent plotting. 
 
 
Contour plots 

Contour plots analyse the ground model only, thus 
excluding any complex lines and points that have 
been created.  You must have triangulated the 
model before creating a contour plot.  When the 
plot is created, it is created as a child of the 
ground model.  You can show 
or hide it or, delete it by right 
mouse clicking on it in the 
Control Bar window. 

 
 To create a Contour plot select Create Contours from 
the Analysis menu.  The Contour Interval dialog will 
appear.  Enter the interval for your 
major and minor contours and, select 
their colour.  If you want the contours 
to be smoothed rather than a series 
of straight lines, uncheck the straight 
lines box.  Contours can be viewed in 
2 or 3D.  To plot a contour map see 
page 168 (printing).  2D Contours 

3D Contours 
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Visibility plots 
Visibility plots analyse either the ground model or 
the ground model and complex lines and points.  
You must have triangulated the model before 
creating a Visibility plot.  When the plot is created, 
it is created as a child of the ground model.  You 
can show or hide it or, delete it by right mouse 
clicking on it in the Objects Control Bar. 
 
To create a visibility plot select Visibility Plot from 
the Analysis menu.  The cursor will change.  
Select the place on the model from which you want 

to view the terrain.  The default height is set in View, Options, Advanced, 
Set Viewpoint.  However, you have an opportunity to alter the height during 
the plot creation.  As soon as you have clicked on place you wish to view 
from, the Create Visibility Plot dialog will appear. 
 
You can make any alterations to the View point position including the eye 
height. 
 
You can set the Plot controls to show the angle of the plot lines and the 
heading of the plot. 
 
You can choose whether or not to include complex lines and points.   
 
Note - If you include these features, RelMo treats them as solid blocks.  This works well for 
such features as a wall, however for trees and fences which clearly are not either blocks or, 
solid, will cause false representation of what can and cannot be seen. 
 

Click OK and the visibility 
plot will be created.  Areas 
that can be seen are 
plotted in red and areas 
that cannot be seen are 
plotted in blue. 
 
This can be viewed in 
either 2 or 3D.  To plot a 

contour map see page 168 (printing). 
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Slope graphs 
Slope graphs analyse the ground model.  Complex lines and points are 
ignored.  You must have triangulated the model before creating a Slope 
graph.  When the plot is created, it is created as a child of the ground 
model.  You can show or hide it or, delete it by right mouse clicking on it in 
the Objects Control Bar. 
 

To create a Contour plot, select Slope Graph from 
the Analysis menu.  The Slope analysis dialog will 
appear.  Enter the bands and colours with which 
they will be associated.  In the dialog to the left, 
Flat to 2º will be displayed in light green, 2 to 4º in 
dark green etc.  Click OK and the plot will be 

created.  Slope plots are best 
viewed in 2D.  To plot a slope graph 
see page 168 (printing). 
 
 
 
 
 

 
Slope direction 
You can choose to display slope arrows on the plan.  
One arrow is produced for each triangle.  The arrows 
also scale, thus the larger the arrow, the greater the 
slope.  Arrows point down the slope.  This feature can 
be useful, (depending on the accuracy of your 
surveying), for finding water runoff points etc.  From 
the Analysis menu select Show slope direction.  To 
turn off the slope arrows, from the Analysis menu deselect Show slope 
direction.  The model must be triangulated to use this feature.  Slope 
arrows can be included in any plans that you print (see page170). 
 
 
Cross sections 
Cross section plots analyse either the ground model or the ground model 
and complex lines and points.  You must have triangulated the model 
before creating a cross section plot.  When the plot is created, it is created 
as a child of the ground model.  You can show or hide it or, delete it by right 
mouse clicking on it in the Objects Control Bar. 
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To create a cross section, plot select Cross 
section from the Analysis menu.  The cursor will 
change.  Select the line on the model along which 
you want the cross section to be plotted.  The 
Create Cross Section dialog will appear. 
 
Note – cross sections do not have to be formed between 
points, they can be created anywhere on the survey. 
 
The start and end positions are listed.  You can set the sampling interval 
along the line. 
 
You can choose whether or not to include complex lines and points.   
 
Note - If you include these features, RelMo treats them as solid blocks.  This works well for 
such features as a wall, however for trees and fences which clearly are not either blocks or, 
solid, will cause false representation of what can and cannot be seen. 
 
You can create a line along the terrain edge, to enhance the rise and fall of 
the section and you can create a skirt around the model of height and 
colour specified by the user. 
 

Finally you can choose whether to show 
the terrain.  Click Ok and the plot will be 
created.  To View the plot, right mouse 
click on it in the Control Bar and click on 
View X-Section. 
 
To plot a cross section first, save the 
view.  See page 168 (printing) for further 

details. 
 
Profiles 
RelMo 2008 allows you to create a profile (a type of section) along a line.  
The line can be straight or curved.  The Profile tool creates a graph 
showing the levels along the line. 
 
Select the line from which you wish to create the profile using Lines, Select 
Lines (alternatively you can draw a line on the surface of your model and 
then select it). 
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Once selected, right mouse click and select Create 
Profile View.  A graph of the line will appear in a new 
tab as shown below. 
 
It should be noted that the height is the height of each 
point on the line as indicated by the vertical lines below 
(there were 8 points on the line).   
 
Some degree of planning will 
be necessary when surveying 
if profiles of camber, gradient 
or surface defects are going 
to be drawn.  Note that these 
can be surveyed as points 
and joined with a line later. 
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3D editing 

General 
Almost all editing that you do in 2D can be carried out in 3D.  This can 
prove very useful when creating complex codes.  You can swap between 2 
and 3D at any stage.  You can also create 3D views of a particular area 
and edit in those.  See the chapter on views (page 157) for further details. 
 
Sometimes you may find it easier edit in 3D.  Almost all of the 2D editing 
facilities are available in 3D as well.  Some things can only be done in 3D 
such as linking four points to form a panel, rotating panels and flipping 
triangles to name but a few. 
 
Two 3D views are available.  Orthographic (the standard 3D view) and 
locked Ortho mode.  Locked Ortho mode is a 2D view of the 3D scene.  In 
other words, you are locked directly above the survey.  However you see 
textures instead of solid colours.  Locked Ortho mode also has the 
advantage of infinite zoom.  To change the Mode, select the appropriate 
mode from the View menu. 
 
The way you move around the model in 3D view can be found on page 14.  
There are a number of Display tools to help you zoom in on the right area 
these are; 
 
Show target – places a target in the centre of the screen.  This allows you 

to accurately zoom in on the area you wish to edit.  
Show outline - places a box around the active Object.  Tab moves you 

between Objects. 
Show axes – displays the x, y and z axis 
 
You can access these tools from the Display menu. 
 
 
Editing in 3D 
Most commands in 3D are the same as in 2D however there are a few 
differences. 
 
3D points 
In 3D, you need to click on a point as there is no snap to point feature.  The 
size of 3D points can be altered.  To enlarge the points select Enlarge 
Points from the Points menu.  The points in the Active Object will be 
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displayed.  To change the size of the points, from the Points menu, select 
3D Point Size.  You can alter the point size between the range stipulated. 
 
Selecting Lines 
To select a line in 3D, select the point that it is attached to it rather than the 
line itself.  You can add, delete, unlink and move lines as you can in 2D. 
 
Clipping planes 
If you are doing close up work you may need to alter the clipping planes for 
example if the near part of the Object you are editing disappears.  Alter the 
clipping planes from View, Options, 3D View as described on page 50.  Do 
not enter a value 0. 
 
Panels in 3D 
Adding panels in 3D assumes that all four points are present.  You add the 
panel between the points.  See panels on page 127 for further information. 
 
Moving in 3D 
You can move Objects in 3D, however to keep them on the surface, you 
must angle the view so that the cursor is over the surface and hold down 
the Control key, see page 59 for further details. 
 
Animating in 3D 
You can animate in 3D.  When you move the Object to be animated ensure 
that you angle the view so that the cursor is over the surface and hold the 
Control key down, see page 176 for further details. 
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Lighting 

Introduction 
The inclusion of multiple lights and shadowing of objects rather than just 
the ground model adds another level of realism. 
 
There is a note of caution in that, if you intend to use multiple lights, you will 
ideally need a graphics card that handles shadow acceleration.  RelMo 
uses OpenGL as its 3D rendering engine.  OpenGL has been supplied by 
Microsoft since Windows 95

®
 and is a commonly used set of functions.  

Many graphics card manufacturers have chosen to extend the core function 
supported by OpenGL and many now support additional hardware 
accelerated capabilities.  These are made available through a series of 
extensions for which RelMo will search.  Some Graphics cards however do 
not support these extensions, and in those circumstances, RelMo provides 
a software based rendering solution whenever it can. 
 
Since RelMo 3D views use OpenGL, it follows that any limitations imposed 
by the particular implementation of OpenGL on your machine must be 
carried over into the same limitations within RelMo.  The RelMo website 
carries a list of some of the more common cards and whether they support 
the necessary acceleration. 
 
In RelMo you may have up to eight individual lights and a general ambient 
light.  The reason you are limited to eight lights is to provide compatibility 
with every OpenGL system, since all must support at least eight lights.  
 
There are several terms that we need to look at before we actually start to 
add and manipulate lights. 
 
Positional lights 
Positional lights have a particular location in space and can radiate light in 
all directions.  You can limit the angle of the light cone to produce a tightly 
focused beam of light.  Positional lights are positioned where you want 
them.  By default the cone of light produced is set initially at 180 degrees 
pointing vertically downwards. 
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Directional lights 
Directional lights can be thought of as providing light from a particular 
direction.  The light emitted by such a light is assumed to be parallel and 
any calculations make this assumption.  (Imagine the light rays emitted 
from the sun, because we are such a long way from the source, by the time 
they reach us the are in fact all but parallel i.e. they have the same 
direction hence a directional light source.  
 
Directional lights are located in the same way as positional lights within 
RelMo, but the angle the position of the light makes with the centre of the 
surveyed area defines the direction of the light. 
 
Directional lights radiate in all directions. 
 
Shadows 
The nature of the light defines how any shadows are produced.  Shadows 
within RelMo are created by initially rendering the scene from the light's 
point of view and then overlaying the depth component part of that image 
over the normally rendered image to produce shadows.  This can be a very 
expensive process computationally, unless special OpenGL hardware 
acceleration functions are available on the graphics card.  RelMo uses 
such acceleration if it is available, but resorts to a much slower software 
implementation if these special extensions are not available.  In addition 
the image generated for the shadow is limited in size otherwise too much 
memory would be utilised in producing the image.   
 
Due to the nature of shadow generation and rendering a significant 
slowdown of the overall rendering process can be expected, especially with 
multiple shadows.  Roughly 2n + 1 times the rendering time for a simple 
(non-shadowed) scene can be expected where n is the number of shadow 
casting lights.  A certain amount of experimentation is likely to be 
necessary to fully explore the use of shadows.  
 
Directional lights, because the source is effectively located an infinite 
distance away from the surveyed area, are set so that the shadow image 
generated covers the entire area of the survey.  With a large area, this is 
likely to generate a relatively low quality of shadow. 
 
Using positional lights and reducing the light cone angle allows positional 
lights to generate much higher quality shadows. 
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Projection masks 
Positional lights can also be set to use a projection mask which limits the 
field of view of the light.  You can use custom built projection masks as 
these are simply images which are automatically overlaid in front of the 
light and projected onto the scene.  A simple circular projection mask is 
built into RelMo and is used by default.  Projection masks also help reduce 
one of the main limitations of OpenGL lighting.  In OpenGL, the light falling 
onto a vertex of an object is used to calculate how much light falls onto the 
area of the shape that the vertex helps define.  This means that if you have 
long thin triangles as part of the ground model for example, then light falling 
onto one vertex, but not the other two, causes the illumination of up to half 
the triangle.  This is not always visually acceptable.  Two solutions are 
possible; 

Either reduce the size of the triangles involved by sub-dividing large 
triangles into smaller ones, or  
use a larger cone of light but then use a light mask to reduce the 
effective field of view. 

 
Quality 
Lighting within RelMo uses one of two mathematical lighting models.  You 
can choose to have the calculations performed assuming all the light rays 
emitted by a light are parallel (which is marginally quicker) or alternatively 
ask RelMo to perform the calculation by working out all the angles involved 
between the light, the objects illuminated by the light and the viewpoint.  
The second option produces more realistic results.   
 
Also you have the option to ask RelMo to perform two sided lighting 
calculations which again results in more realism, but at the expense of 
slightly longer rendering times.  Two sided lighting calculations use both 
sides of the triangle to work out how the light should be displayed.   
 
Both the above options are available in the ambient lighting tab of the 
lighting dialog. 
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Lights as Objects 
Lights are derived from Objects and share many of the 
same features.  For example they can be moved around 
just like real objects and appear within the Objects 
Control Bar.  They can also be animated and inserted 
into other animated objects so that they can move 
around the scene.  Selecting the Object Properties 
dialog however does not display the normal object dialog 
but a specialised lighting dialog designed for lighting 
control. 
 
RelMo always contains one default light which can be seen as part of the 
Root in the Objects Control Bar.  Note that it is possible to delete this light 
in which case, if the ambient light is also turned off, you will not be able to 
view the survey.  Deleting the light is therefore not recommended! 
 
 
Adjusting the Ambient light 
Whereas the main lighting properties allow shaded areas and highlights to 
be viewed, ambient properties enable objects that are in shade to be 
illuminated.  The example below demonstrates this. 

 
As the Ambient light already exists by default, in 3D view click on 
the lighting button.  The lighting dialog will be displayed.  Click on 
the General tab for Ambient light settings. 

Ambient light on 

No Ambient light – only 
the area illuminated by 
the second light can be 

seen 
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Ambient light 
Enable ambient lighting simple allows the 
ambient light to be shown. 
 
The ambient light colour can be changed to 
produce some interesting effects.  Try a black 
light with the Cloudsnight bitmap as the 
background sky (View, Options, Three D View, 
Display background). 
 
The Level slider bar will alter the intensity of the 
light with the slider to the right being the most 
intensive. 
 
 
Background light 
The background light can be altered in 
intensity and colour.  Note that you can 
only alter the background light if you are 
displaying a background image such as 
one of the sky bitmaps.  The two 
images to the right show different 
intensities of background light.  Note 
that the light on the model itself remains the same.  Moving the slider to the 
right increases the intensity of the light. 
 
Fog 
See page 154. 
 
Lighting model 
Two sided lighting calculations refine the way that shadows are cast.  This 
however is at the cost of speed (more correctly smoothness) as twice the 
number of calculations have to be carried out. 
 
Local Viewer lighting is another model that effects the way in which the light 
is calculated towards the user. 
 
Both models will refine the way shadows are cast and viewed.  Experiment 
with either or both of the models to see which suites your computer the 
best.  Using them will improve shadow quality at the expense of processing 
power. 
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Special effects 
Show Shadows allows Objects to cast shadows against the ground model 
and other Objects. 
 
Using a light mask enables the user to project a 
light which displays an image.  This can have 
interesting effects.  For example the image to the 
right uses a non directional light with a mask set.  
The effect produces yellow, white, black and red 
lighting effects.  The image is a bitmap of a lane 2 
closed sign which is stored in the RelMo images 
folder.  The mask is actually set in the Light 1, 2 
etc. properties, not the General page. 
 
You can create your own masks using other software such as Paint Shop 
Pro. 
 
Default 
Clicking the 'Default' button will cause the current values to be used for all 
new surveys.  Unless you select this option, new surveys will take their 
default lighting parameters from those stored in the default survey, 
(Codes.rlm). 
 
 
Adding lights 
A new Light can be created by selecting Create 
light from the View menu.  Up to eight lights may 
be added.  Like normal Objects, if you add a 
light to an Object which contains animation, the 
light will pick up the animation of the Object. 
 
It is sensible to create and set lighting Properties 
in the 3D View.  When you have added the light 
make it the Active Object and from the Display 

menu Select Show Outline.  
Provided the show source 
button is clicked you will be 
able to see the light and 
the direction in which it is 
pointing.  
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General 
You can change the name of the light to something meaningful.  You can 
also change the colour of the light. 
 
Enable light has the same effect as switching a light on and off.   
 
Choose between Directional and Positional lighting.  Check the box for a 
Directional Light and leave it unchecked for a Positional Light.  Directional 
and positional lighting are explained on page 146 and 147. 
 
Show source will show the light source in 3D view as in the image on the 
previous page. 
 
Enable mask is only available for positional lighting.  If you enable a mask 
you can allow RelMo to use the default mask or select a mask from a 
separate source.  See Special effects on the previous page for further 
explanation.  To view a mask, you must check the use light masks box on 
the General page. 
 
Enable shadows will allow this light to cast shadows.  Show shadows must 
also be checked on the General page. 
 
Advanced 
This dialog allows you to control exactly how some advanced lighting and 
shadowing parameters are used by RelMo. 
 
The Size option controls the size of the virtual light object so that you can 
physically select the light to move it around the scene as you would with a 
regular object.  Increase the size to make the light larger.  Note that the 
size has no effect on the amount of light displayed. 
 
Shadows are created in RelMo by forming an image of the scene from the 
lighting position.  This image is then processed internally to create the 
shadows seen by the viewer.  The creation of the shadow images involves 
RelMo in calculating the depth of field at which various features are 
located.  If the features are too close to one another, then RelMo cannot 
distinguish between them and fails to display shadows correctly.  This is 
particularly noticeable in software shadowing where depths of fields are 
limited to 256 levels for various technical reasons.   
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To alleviate this problem, you can set the shadow clip range using this 
dialog.  The depth of field levels are logarithmic, with the far planes much 
closer together than the near planes, altering the near clip plane in 
particular has a greater effect.  For example, if you don't require shadows 
to be generated until at a distance of 100m from the light source, then 
setting the near clipping plane to 100m will mean that the depth of field 
calculations start at 100m. 
 
The shadow offset control allows you to manually set an offset to the 
shadow image when it is applied to a scene so that any remaining visual 
artefacts can be 'pushed away' from the real scene and thereby hidden 
from view.  Some experimentation may be required for these values which 
will be largely dependent upon the position of the light source and also the 
orientation of the scene illuminated by that light. 
 
The attenuation factors control how the intensity of light falls off with 
distance. 
 
All these controls can be played with to reach the desired effect. 
 
Location 
This is the Eastings, Northings and Height of the light.  Note it is not related 
to your survey points.  0 east, 0 north will place the light at the centre of the 
survey at whatever height you specify. 
 
Like any other Object in RelMo you can use the Move command to 
physically move the light using the mouse in 3D view. 
 
Rotation 
These settings apply to positional lights.  By default the light will be pointing 
down.  Alter the pitch, yaw and roll angles to point the light in the right 
direction. 
 
Levels 
Level controls are used to shape and alter the intensity of the light. 
 
Ambient 
Controls the intensity of the light. 
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Defuse 
Softens or hardens the boundaries of the light when no mask is applied. 
 
Specular 
Alters the way the light reflects off the surface 
 
Spot angle 
Alters the width of the cone 
 
Exponent 
Alters the depth of the light. 
 
Position 
The position controls allow you to adjust the position of the light source 
relative to the centre of the survey.  You can display a small sphere in the 
3D scene which shows you exactly where your light source is positioned by 
checking the Show source box. 
 
Intensity 
The intensity parameters control the proportion of the directional and 
ambient lights. The Effect parameter controls how much light is available 
for reflectivity properties of the material. In other words the effect of the 
specularity and shininess properties set in the textures dialog for each 
material used. Adjusting these figures can give interesting effects! 
 
 
Fog 
Fog is set using the fog parameters within this dialog.  Generally the colour 
of fog is set to be the same as the background colour.  Distant objects then 
merge gradually into the background. 
 
Two fog modes are available, the exponential version uses the density 
parameter to determine the amount of fog. The linear version uses the start 
and end fog positions to determine zero and 100% fog respectively. 
 
A small amount of fog allows more realistic scenes to be displayed, since 
distant objects tend to be viewed with a slight amount of haze in real life.  
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Info Pages 

Introduction 
Info Pages are HTML boxes that can be attached to objects.  They can 
contain written information and pictures.  In the 3D environment, you can 
use the cursor to change when it moves over an Object which has an Info 
Page.  Clicking on the Object will then display the page. 
 
Note - Info Pages will only be available where Internet Explorer 5 or later is installed on your 
computer. 
 
Displaying a new Info Page 

Make the Object you wish to 
add the Info Page to the 
Active Object and, from the 
Objects menu click on Info 
Page.  The Info page will be 
displayed. 
 
 
 
 

Editing the box 
Right mouse click on the page and select Create New, a 
new blank Info Page will be displayed.  
 
 
 
Adding text 
Right mouse click and select Insert text.  A text box will 
be displayed in the page.  Double click in the box to edit 
it.  You can move the text box about, bring it to the front 
or back and lock its position by right mouse clicking and 
selecting the appropriate command. 
 
Adding pictures 
You can add a picture by right mouse clicking on 
the box and selecting Insert Image.  The Picture 
dialog box will be displayed.  Use the Browse 
button to find the picture on your computer.   
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Once in the page, pictures can be resized by grabbing the corner handles.  
You can also move the picture about, bring it to the front or back and lock 
its position by right mouse clicking and selecting the appropriate command. 
 
Saving the box 
When you have finished editing the box, right 
mouse click and select Quit Edit. 
 
Close the Window by clicking on the cross in the 
top right corner.  You will be prompted to save the 
changes. 
 
 
 
Setting the cursor active 
In 3D view, from the View menu select Track Object 
Info.  When the cursor passes over an Object that 
contains an Info Page, it will change as shown in the 
picture below, left mouse click to display the Info 
page. 
 

 
 
 
 
 
 
 

3D Viewer 
RelMo3, the 3D Viewer program that you supply to clients to view your 
files, supports Info pages.  You can choose whether to include Info Pages, 
when you use the Pack and Go Wizard (see page 190). 
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Views 

Views are an important part of RelMo.  Views are used to switch to different 
locations.  To capture 2D scale images for plotting and, because views are 
‘live’ or active, they are constantly updated as you make changes in the 
main 2 and 3D screens.  Because they are live, you can also switch to a 
View and edit in that view.  The changes will then be reflected in the main 
model. 
 
Views can also be renamed to give meaning to that view.  Views are also 
supported in the 3D viewer program.   
 
If your survey contains animation, you can watch the animation from any 
view you have created. 
 
Views represent the view from a static point.  To create moving views, see 
the section on Cameras on page 186. 
 
 
Creating 2D scale views 
Setting up the scale 
2D views are usually created for plotting purposes.  You can add as many 
views at different scales to a single plotted sheet.  For further information 
on plotting and printing see page 168. 
 
The first step is to set the scale of the view you wish to save. 
 

From the View menu select Options and click on 
the Printing tab.  Set the scale of the view you wish 
to save.  If you are saving your view for printing 
purposes and want RelMo to set the scale as large 
as it can for the printed sheet, check the Prompt to 
scale view to fit print window option.  This means 
that although you may save a 1:500 view, when 
you add the view to the plan Layout Page, you will 
be asked whether you want to rescale it to the 

largest size it can fit in the Print Window (see page 167 for further details).   
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Note – Scale to fit will result in some strange scales and you are advised to add a scale bar 
from the Templates Symbols library if using this option.  The other options in this Window 
are dealt with in the Printing chapter on page 168. 
 
Getting the view 
In 2D view, select the Views Control Bar.  Cameras, 
Views and Layout pages will be shown. 
 
Right mouse click on Views and click Add. 
 
An outline box will appear on the main 2D plan.  You can move the box by 
dragging it with the left mouse button.  You can resize it by dragging a 
corner in or out and you can rotate it by grabbing the handle at the top of 
the box. 
 
Change its position until you 
have the required view and 
click the Return Key.  The view 
will be saved and named Plan 
view with its scale. 
 
You can switch to this view by 
double clicking on it.  You can 
zoom in or out from this view or 
return to the full screen view by 
clicking on the Home button or the F6 key.  Note that even if you alter the 
view by zooming, if you double click the View in the Control Bar again, you 
will be returned to the view you originally captured. 
 
Once the view is saved, any updates or changes you make to the plan will 
be updated in the saved view. 
 
Deleting a view 

Right mouse click on the view on the Control Bar and click Delete. 
 
Options 
Once you have saved the view, you can change some of the properties.  
Right mouse click on the view in the Views Control Bar and click on 
Properties.  The View Properties dialog will appear. 

ROTATE 



VIEWS 

AiTS International  159 

The description tab allows you to alter the name of 
the view and gives information about the view 
including any excluded objects.   
 
To exclude an object so that it will not be displayed 

in the view click on the Edit 
excluded objects button.  This 
will bring up the Excluded 
Objects dialog.  Right mouse 
click on the Object you wish to 

exclude from the view and click Hide Object.  Hidden Objects appear with a 
red cross through them. 
 
Excluded objects will only be hidden from that view.  If you take an identical 
view and do not exclude the object, you will have two views, one with the 
object displayed and one with. 
 
Excluded Objects will not be printed. 
 
The plot data tab displays the scale, width, height, 
rotation, centre east and centre north of the plot 
area.  If you alter this data, the changes will be 
reflected both the Layout view and the printed 
output but, not the normal 2D view. 
 
 
 
 
 
The display tab allows you to make changes to 
what is displayed.  Two options are given, changes 
that will be reflected in the printed output and on 
screen and, Screen options only.  
 
An animation preview can be shown in 3D views, 
these can also be plotted out by checking the 
button.  You can choose to specify a time at which 
the animation ends.  This allows you to show the 
animation up to a particular point.  The number 
you enter is the global finish time from the 
animation Properties.  See page 182 for further details.    
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Remember 2D Views are predominantly for printing, however they are also 
useful for editing because they are ‘live’ and thus changes made in the 
view are also made on the main plan. 
 
 
Creating 3D views 
In the same way as you 
create 2D Views, you can 
also create 3D views.  
Again, 3D views are ‘live’ 
and can be edited.  Changes 
made in the view will be 
reflected in the main plan.  It 
is worth restating that Views 
are also supported in the 3D 
Viewer program. 
 
To save a 3D view, navigate to the position in 3D and on the Views Control 
Bar, right click on Views and click add.  The current 3D view will be added 
to Views and a new view will appear in the Views tree on the Control Bar 
with the name 3D view.  You can now change the name and certain other 
properties by right mouse clicking on the name.  The View Properties 
dialog will appear. 
 

You can change the name of the view in the 
Description tab which also gives the position of the 
view.   
 
You can also choose to 
exclude any Objects from the 
view by clicking on the Edit 
excluded objects button.  This 
will bring up the Excluded 
Objects dialog.  Right mouse 

click on the Object you wish to exclude from the view and click Hide Object.  
Hidden Objects appear with a red cross through them. 
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The size tab allows you to unlock the aspect ratio 
and stipulate an exact size.  This will be reflected if 
you use the view in any printed output. 
 
 
 
 
 
 
 
 
The display tab allows you to alter the print and 
screen options.  The top option relate to both 
screen and printed output in which case what you 
see on screen will be what you get in the printed 
output. 
 
You can show an animation preview in 3D views, 
these can also be plotted out by checking the 
button.  You can choose to specify a time at which 
the animation ends.  This allows you to show the 

animation up to a particular point.  The number you enter is the global finish 
time from the animation Properties.  See page 182 for further details.   
 
You can choose whether to show the shadows and use the projection 
masks (see the section on lighting, page 146, for further details).  If you 
check the 3D text button, 3D text will be displayed and plotted. 
 
You can also alter the screen only options, in which case only the screen 
will be affected.  The 3D only options affect only what is seen in the 3D 
view.  The printed output remains unaffected. 
 
 
Viewing from a defined point at a defined height 
To set up your 3D views, you may find it useful to use the set Viewpoint 
option.  This option allows you to define a point in 3D view with the mouse 
and then define a second point to define the direction in which you wish to 
look. 
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To use this command set the height of the eye from the View Options 
menu.  Select the Advanced Tab and set the height of the eye in the Set 
Viewpoint box.  Apply the changes. 
 
In 3D view, select 'Set Viewpoint' from the View menu.  The cursor will 
change to a cross.  Click on the point where you wish to view from and then 
the point that you want to look at, the screen will display the new View.  It is 
worth mentioning that you are not locked into that position and can move 
around from that point.  When you are happy with the view, save it in the 
way described above. 
 
Note – The Set Viewpoint command does not work if you have added a camera and have 
turned on the Track Camera command in 3D.  If this is the case, simply turn off Track 
Camera from the Display menu and then create the view. 
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Printing and plotting 

Introduction 
The Layout Pages give the user much of the power of CAD to create their 
plans having prepared them in a digital terrain modelling interface. 
 
You will need to set a number of options before you can usefully print plans 
on your printer.  However once done, you should not have to repeat any of 
the setup steps unless you change your printer or plotter. 
 
First and foremost you need to decide which printer(s) you want to use for 
printing plans.  It is recommended that the drivers for those printers are 
installed on your computer.  RelMo supports any printer which has 
standard Windows

®
 drivers. You can also create a PDF file of your plan by 

printing to a PDF printer such as Adobe Acrobat. 
 
The general principle is to set up a number of templates for different sizes 
of paper in your Codes survey.  Because you set them up in Codes, they 
will become available for each new job that you start.  You can then 
customise the location date etc for that particular job. 
 
A number of layout templates are included in the Codes survey supplied 
with the software and these can be altered to suit your own printer.  They 
are unlikely to print out perfectly without some amendment because each 
printer manufacturer seems to have different paper leads and margins. 
 
You can also create your own templates from scratch and, provided you do 
this in the Codes survey, they will be available for all new jobs. 
 
The next section looks at creating an A3 layout template from scratch. 
 
 
Creating your template layout page 
Open the Codes survey 

Open the Codes survey and go to the Views Control Bar.  Layout templates 
are created in the Codes survey so that they are available for all new jobs. 
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Add a new layout 
Right mouse click on Layout Pages and click Add.  A new 
page called page 1, 2 etc. will appear below the layout 
pages.  Right click on this page and select Properties to 
rename the page with a more descriptive name such as 
A3 HP Laser.  Click OK. 

 
Associate the page with a printer/plotter 
Right mouse click on the page again and click on print 
setup.  A standard printer dialog box will appear.   
 
 
This allows you to assign a printer to this particular page.  
Select the printer, page size and orientation where 
appropriate.  Click OK.  Your layout page on the main part 
of the screen will now resize to reflect the paper size you 
have chosen.  
 
Once you have associated the page with the printer you can build up a 
template to reflect your corporate image by adding standard boxes, text 
and company logos.  You can zoom in and out by using the wheelie 
mouse.  Alternatively you can use the magnifier button and the home 
button to zoom in and return to 100% respectively.  
 
Adding an outside border 
From the View menu select Options and click on the Printing tab.  
Check the border check box and select the colour and weight of the border.  
Make sure you click on the Default button to ensure the changes are saved 
for all future jobs.  The border will be displayed in the Layout Pages. 
 
Adjusting the margins for the Printers paper feed 
You can alter the margins to try and compensate for those printers that 
insist on producing a larger leading edge or do not align your plot centrally 
on a piece of paper.  Ensure that borders are turned on and print a sheet.  
If the margin’s need to be adjusted do so by going to View, Options and 
clicking on the Printing tab.  Adjust the margins and print another sheet.  
When you are happy, click on the Default button to ensure the changes are 
saved for all future jobs.  This is a matter of experimentation. 
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Add boxes to your layout 
You now need to add boxes, text and 
company logo to reflect your corperate 
image.  Any text can be ammended or added to on a per job basis. 
 
The best method is to add a series of standard boxes and then add 
separate text boxes on top. 
 
To add a box, click on the box tool on the toolbar.  Using the mouse, drag 
out a box on the layout page.  Use the wheelie mouse to zoom in and out 
as necessary. 
 
You can change the line and fill colour of your object by 
clicking on the line and fill buttons.  For no fill, uncheck 
the fill option by going to the objects Properties, (see below). 
 
Once you have set the colour and fill Properties, you can set this as the 
default style for future boxes etc by right mouse clicking on the object and 
clicking on Set Shape Defaults.  All future objects will now be created in 
this style. 
 
You can inspect and alter the Properties of your box by 
either right mouse clicking on the object and clicking on 
Properties or with the box selected, clicking on the 
Properties button. 
 

You can use the alignment tools to ensure that your 
boxes are correctly aligned.  Select the boxes by 
dragging a box round them with the left mouse 
button or by clicking on each box individually whilst 
holding down the shift key.  Right mouse click and 
select the Alignment options. 
 
Once you have set up your boxes, you can group them by, 
again selecting the boxes with the left mouse button whilst 
holding down the shift key. Right mouse click and, click on 
Group. 
 
Note -You can Copy and Paste boxes (and any other objects). 
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Finally, as these boxes are going to form your corporate image, you can 
lock them in position, select the boxes, right mouse click and click on Lock 
Position. 
 
Add text to your layout 
Once you have your boxes, you need to add your default 
text.  To add a text box click on the text box tool and drag 
out a box using the left mouse button.  You can leave boxes 
empty for the later addition of text.   
 
Set the font using the text 
toolbar.  You can alter the 
font and size, use bold, italic or underline, left right and justified.  You can 
also alter the line spacing.   
 
To change the margins, click on the Properties button.  
Check the Draw Outline check box.  Set the width of the line 
and the colour.   
 
From Properties, you can also set the font etc. by clicking on 
the Font tab. 
 
To edit text in a text box, double click on the box.  To change the size of a 
text box, single click on the text box and drag the handles with the left 
mouse button held down.   
 
You can change the font, border and fill colours of your 
text box by clicking on the Font, line and fill buttons.  
For no fill, uncheck the fill option by going to the objects Properties. 
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Adding a Company Logo 
You can add a company logo to your template.  Right mouse 
click on the main plan area and click Insert New Object.   
 
The Insert Object dialog will appear.  Choose create from file 
and browse to the image you want to insert.  Click OK and the 

image will be imported.  By default the aspect ratio is 
locked.  To unlock, right mouse click on the Object.  
We recommend that you do not use the ‘Link’ button.  
Once your logo is correctly positioned, right mouse 
click and Lock Position. 
 
 
Setting the print area 
When you are happy with the general 
layout, you need to add a Print 
Window.  This is the window that any 
plans, 3D views and photos will drop 
into.  Zoom out until you can see the 
whole sheet and select Set Print 
Window from the Display menu.  This 
causes a white rectangle to be 
displayed on screen.  This rectangle 
represents the area into which RelMo 
will insert the plans, images and 3D views.   
 
Drag the window to the required size using the mouse.  When you are 
happy, click the return or Enter key.  The Print Window will disappear.  
Usually you will want the print area to cover all of the parts of the page 
which are not already used for text.   
 
Setting the print scale factor 
On a small number of older computers you may 
find that text you have added on one line spills 
over onto two lines when you go to Print Preview 
or, you print the plan.  You can correct this by 
setting the Text scale factor.  This value is set on 
the Printing page of the Options dialog under ‘Text 
scale factor’.  To set this option, go to View, 
Options, Printing.   
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Try using Print Preview to preview your page.  Note the relative size of the 
text in Print Preview compared with the Layout page.  If any text has 
dropped over onto a second line in the Print Preview box, reduce the scale 
factor.  Remember to click the Default button. 
 
Saving the template 
When you are happy with your changes, save the Codes.rlm survey and 
RelMo will automatically include your customised template pages in all 
future jobs.  Note that they will not be available in previously created jobs. 
 
Making a new template available to older jobs 

If you want to make the template available to older jobs, Create a new 
layout page in the old job and associate it with the printer.  In Codes, open 
the Layout Page you want to copy and, from Edit, Select All.  From Edit, 
click on Copy and then swap to your old job.  Open the layout page and 
Edit, Paste.  The text and any bitmaps etc will be copied into the old job. 
 
 
Creating plans 
Before you create your plans you need to create your Views.  See page 
157 for details on creating views. 
 
All your text, arrows etc. will be added in the Layout pages.  This is 
because the page is already scaled to your printer and thus fonts, arrows 
and any boxes you add do not have to be scaled further. 
 
Inserting your views into the layout page 
Open the Views Control Bar.  Drag the views that you wish 
to plot onto the appropriate Layout page. 
 
Double click the page and your views will now appear in the 
centre of the Print Window that you set up when creating 
the template.   
 
Moving and resizing your views 
Left mouse click on your plan in the Layout page.  You can now drag the 
plan around the page.  You can also move the plan outside the Print 
Window.   

DRAG 
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You can also resize the plan by grabbing any of the black handles that 
appear around the edge.  Because the plan is to scale, when you resize it 
you it will not shrink or grow, what will happen is you will see more or less 
of the job at the same scale. 
 
Altering the plan 

Adding a border 
Click on the plan you want to alter and right mouse 
click.  The Properties page will be displayed. 
 
The General tab allows you to add a border and fill 
colour.  The weight of the border (in pixels) and 
colour can be altered.  A fill colour can be added if 
required. 
 
 
 
The Description tab allows you to alter the 
description of the object.  It also gives information 
on the coordinates of the plot, whether the view has 
been rotated, the plot scale, its size and whether 
any Objects have been excluded. 
 
Excluding Objects from the printed output. 
You can choose to exclude specified Objects within 
your plan from the printed output.  For example if 
you want to produce a plan showing an area before 

the Object was there and then another with the Object there, there is no 
need to produce two Digital Terrain Models one with the Object and one 
without.  You can produce one plan with the Object in place, take your 
scale views, drag them into the Layout pages and then produce two views, 
one where you force the Object to be hidden and, one with it shown. 
 
To hide or exclude an Object from the printed output, 
double click the view that contains the Object, the 
Properties dialog will be shown.  Click on the Edit 
excluded objects button.  A list of all Objects included in 
the view will be shown.  Right mouse click on the 
Object(s) you wish to exclude. 
 
Excluded Objects will appear crossed out in the list. 
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Altering the scale and rotation of a plot 
The plot data allows you to change the scale, width, 
height, rotation and the centre.  This information 
relates to the original plot box, thus altering this 
information will alter the area of the view that you 
see in the plan. 
 
 
 
 

 
Altering the printed output 
The display tab allows you to alter the print and 
screen options.  The top options relate to both 
screen and printed output in which case what you 
see on screen will be what you get in the printed 
output.   
 
To produce a line drawing plan from a coloured in 

model, Show the lines but do not show the triangles.  To produce a full 
colour plan, check the Show triangles box. 
 
Show text relates to any text added in the main 2D window rather than text 
added in the Layout page. 
 
Show slope arrows relates to the slope direction arrows which can be 
turned on from the analysis menu (see page 141).  For the slope arrows to 
be displayed, the Object containing the triangulated surface must be the 
Active Object at the time of printing. 
 
Show animation preview will show the preview of any animation on the 
screen and plan.  You can specify the number of redraws from View, 
Options  and clicking on the animation tab.   
 
Specify animation time allows you to show an animated Object at a 
particular time in the animation sequence.  Check the box and enter a time. 
 
You can also alter the screen only options, in which case only the screen 
and not the printed output will be affected.   
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Inserting views that stretch to fit the page 
If you want RelMo to set the scale as large as it 
can for the printed sheet, check the Prompt to 
scale view to fit print window option.  This means 
that although you may save a 1:500 view, when 
you add the view to the plan page, it will ask 
whether you want to resize the plan to fit to the 
largest size it can for the page.  This may result in 
some strange scales and you are advised to add a 
scale bar from the Templates library. 

 
You need to set this option before you drag your View into the Layout page. 
 
Creating 3D views  
On the Views Control Bar drag the 3D view that you wish to 
plot onto the appropriate Layout page. 
 
Double click the appropriate Layout Page and your view will 
now appear in the centre of the Print Window that you set up 
when creating the template.   
 
Moving and resizing your 3D view 

Highlight the plan by left mouse clicking on it in the layout page.  You can 
now drag the 3D view around the page.  You can also move the view 
outside the Print Window.   
 
You can also resize the view by grabbing any of the black handles that 
appear around the edge.  Unlike plan views which do not alter their scale 
when you resize them, 3D views behave like normal pictures and 
consequently shrink or grow.  
 
By default the aspect ratio of a 3D view is locked.  You can unlock it by 
right mouse clicking on the view and selecting Properties, and clicking on 
the size tab.  
 
Altering the printed output of your 3D view 
Either click on the view you wish to alter and right mouse click on 
Properties or, double click on the view.  The Properties page will be 
displayed. 
 

DRAG 
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The General tab allows you to add a border and fill 
colour.  The weight of the border (in pixels) and the 
colour can be altered. 
 
 
 
 
 
 
 
The Size tab gives information on the image 
statistics and allows you to lock and unlock the 
aspect ratio. 
 
 
 
 
 
 
 
The Description tab allows you to change the name 
of the image and gives details of the view.  You can 
choose to exclude any of the Objects within the View 
from the printed output.  See page 169 for further 
details. 
 
 
 
 

The display tab allows you to alter the print and 
screen options.  The top option relate to both screen 
and printed output in which case what you see on 
screen will be what you get in the printed output.   
 
Show points, lines and triangles is self explanatory.  
 
Show slope arrows relates to the slope direction 
arrows which can be turned on from the analysis 
menu (see page 141).  For the slope arrows to be 

displayed, the Object containing the triangulated surface must be the Active 
Object at the time of printing. 
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Show animation preview will show the preview of any animation on the 
screen and plan.  You can specify the number of redraws from View, 
Options and clicking on the Animation tab.   
 
Specify animation time allows you to show an animated Object at a 
particular time in the animation sequence.  Check the box and enter a time. 
 
You can also alter the screen only options, in which case only the screen 
and not the printed output will be affected.   
 
You can choose whether to show the shadows and use the projection 
masks (see the section on lighting, page 146, for further details).  If you 
check the 3D text button, 3D text will be displayed and plotted. 
 
You can also alter the screen only options, in which case only the screen 
will be affected.  The 3D only options affect only what is seen in the 3D 
view.  The printed output remains unaffected. 
 
 
Add text to your plan 
You now need to annotate the plan.  Before you do this, we suggest that 
you lock all your plans, 3D views, photos etc. in place by right mouse 
clicking on each one and selecting Lock Position. 
 
Adding text 
To add a text box click on the text box tool and drag out a 
box.  Text boxes will remain the size that you specify rather 
than shrinking to fit the text when you click out of them. 
 
Set the style of the text from 

the text toolbar.  You can alter the font, size, style, colour 
and spacing of the text.  You can also add a line and fill 
colour to the text box.  (To clear the fill or line colour, right mouse click on 
the text box and select Properties.  Un-check the line and fill boxes). 
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Add the text.  You can add multiple text lines by clicking the Return (enter) 
button to start a new line.  You can rotate text by grabbing the handle at the 
top (only true type fonts can be rotated).  You can also edit existing text by 
double clicking on the text box.   
 
To change the margin, (the distance between the edge of the 
box and the text), click on the Properties button.   
 
Adding arrows 
You can add arrows to your plan by using the arrow tool.  Note that 
Dimension Arrows which automatically generate the distance are added in 
the main 2D window (see page 122). 
 
Adding an arrow 
Select the arrow tool and then click on the plan and drag 
out the arrow with the left mouse button.  (The base of the 
arrow is the first point created).  
 
Changing the Properties of an arrow 
To change the colour of an arrow use the line colour button.   

 
To change the weight or type of arrow, double click 
on the arrow.  The Line Properties dialog will be 
displayed.  You can choose the size of any arrow 
head and alter the style of the start and end. 
 
The styles include; 
 

Filled 
Outline 
Dimension 
Line 
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Adding a scale bar and or north symbol 
A number of scale bars and a simple North symbol are supplied as either 
templates or complex points.  You can also create your own template scale 
bars and north symbols, see templates (page 67) for more information. 
 
An example of a 30 metre scale 
bar is shown to the right. 
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Animation 

Introduction 
An Object or group of Objects can be animated.  Animation can be created 
in 2D or 3D.  In 3D you need to position yourself so that the surface along 
which you are animating is behind the Object you wish to animate. 
 
To animate an Object first ensure that that it is the Active Object.  Ensure 
that the Object is rotated and facing the right direction.   
 
If the terrain is sloping, we suggest you Auto-Level 
the Object by selecting Auto-Level from the 
Objects Transform menu.  The Object will 
automatically try and level itself across the 
surface.   
 
Note - On some extremely uneven surfaces it may not be 
possible to level the object perfectly. 
 
Once level click on the Animate button.  You now need to 
move the Object to the next point along the path you want the 
Object to follow by dragging the Object with the left mouse 
button held down.  Once you drop the Object in its next position the 
animation control box will be displayed. 
 
In 3D, if you want the Object to stay on the ground, follow the same 
procedure as above but in addition, hold the Control key down.  Provided 
the surface is behind the mouse the vehicle will stay in contact with the 
ground. 
 
 
Animation control box 
Once you have moved the Object in animation mode, the Animation 
Control Box will appear.  The features of the box are described below. 
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Time 
Global start time - The time at which the Object 

will start to move from the 
previous position 

Global finish time - The time at which the Object 
will arrive at the new current 
position. 

 
The diagram below illustrates global start and 
global finish. 

 
 
 
 
 
 
 

Start and finish behaviour 
Show before sequence start – If this box is checked, the Object will be 

shown in its start position before any 
animation starts. 

Show after sequence ends – If this box is checked the Object will be 
shown in its finish position after any 
animation ends. 

Add after and add before - This allows you to either animate from the 
start to the end or, from the end to the 
start. 

 
Speed and acceleration 
The rate at which the Object moves must now be added.  You must choose 
two quantities from those listed.  Distance is calculated by the software.  
When you have selected your two quantities check the boxes and the 
program will calculate the others. 
 
Note – RelMo uses SI units (metres per second, metres etc.) 
 
To convert miles per hour to metres per second, multiply by 0.447 
To convert kilometres per hour to miles metres per second, divide by 3.6 
 

Start  Position 1 

Global start  Global finish 
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Initial speed - The initial speed in metres per second. 
Final speed - The final speed in metres per second. 
Acceleration - The acceleration in metres per second

2
. 

Time - The time in seconds. 
Distance The distance is calculated by the software. 
 
Yaw, Roll and Pitch 

The pitch, (x), roll, (y) and yaw, (z) axes 
for an object are defined using the right 
handed orthogonal rule.  By default all 
objects are created with the y-axis 
pointing vertically up the screen.  The x-
axis is then to the right and the z-axis is 
at right angles to the other axes and 
points out of the screen.  A positive roll 
value will therefore rotate the object to the 
left, and a positive pitch angle will rotate 
the front of an object downwards.  For 
consistency within the program a positive 
yaw rotation will rotate the object 
clockwise.  
 
Remember that all Objects are created 
with their heading, 0 up the screen.  If 
your Object behaves unusually, rotate it 

so that the ‘front’ is pointing up the screen and from the Object menu, 
select Zero Heading. 
 
Height 
There are a number of Options for height. 
 
Follow terrain will cause the object to follow the terrain. 
Follow terrain plus a height change will cause the Object to change height 
at the start of the sequence and then move. 
Change height without follow terrain will cause the Object to change height 
smoothly whilst moving, achieving the new height by the end of the move. 
 

YAW 

PITCH 

ROLL 

+ 

+ 

+ 
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Auto-level 
Auto level will allow an object to react to any curves or bumps in the terrain 
by attempting to pitch and roll the object to align with the triangulated 
surface below.  On very bumpy terrain, this feature may not be entirely 
effective. 
 
Once the information has been entered, click OK and your Object will move 
to the new position.  Now move the object to the next position and repeat 
the process. 
 
Once you have completed the animation you can refine it using the move 
position command. 
 
Note – When Auto Level is selected the Pitch and Roll boxes are greyed out.  This is 
because pitch and Roll are controlled by the Auto Level function and manual entries cannot 
be made. 
 
 
Pausing animation 
You can pause the animation so that the Object you are animating remains 
stationary for a specified time period. 
 
Using the Animation dialog, bring your Object to rest 
(final speed 0) at the point where you wish to pause the 
animation.  From the Animation menu select Pause 
Animation.  The Insert Pause dialog will be displayed.  
Fill in the time of the pause in seconds. 
 
RelMo will create an additional animation control as 
shown on the right.  Note that the speed, acceleration 
and height boxes are greyed out, however you can still 
alter Yaw, Roll and Pitch. 
 
 
Freezing animation 
You can choose to freeze an animation at a particular 
point in time.  When you do this, the animated objects will 
move directly to that point.  Note that the animation does 
not play up to that point, it simply moves everying to that 
point.  Escape or play to return to normal. 
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To freeze an animation, select Freeze Animation from 
the main Animation menu.  The Freeze Animation 
dialog will appear.  Enter the time at which you wish to 
freeze the animation so that when it plays it stops after a defined number of 
seconds. 
 
 
Amending animation 
Move Position 
You can amend and refine you animation sequence for 
any position.  Whilst in animation mode, right mouse click 
and use the Go To command to go to the animation 
position you wish to amend.  Once at the position right 
mouse click again and select Move Position. 
 
You can now refine the position of your Object using the 
mouse or arrow keys.  (Hold down shift to rotate).   
 

Note - To increase or decrease the amount an object moves for 
each mouse click, change the Granularity (Nudge and Angular) by 
selecting the Screen tab from View, Options. 
 
When you make changes, time, acceleration rates etc. 

will automatically update. 
 
Note - Having made amendments, and if you wish to add further animation, go to the final 
position if not already there and right mouse click and select Add Position.  Pick up the 
object and continue as normal. 
 
Amending speeds 
Again whilst in animation mode go to the position 
you want to amend by right mouse clicking and 
using Go to, then call up the Properties of that 
position by right mouse clicking and selecting 
Properties.  Make any alterations and click on 
calculate.  This will recalculate each position. 
 
If you don’t know the position, go to a position 
(not the first) and call up Properties.  Now use 
the forward >> or reverse << keys to move to the 
correct position. 
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Note - Having made amendments, and if you wish to add further animation, go to the final 
position, right mouse click and click Add Position. 
 
Inserting a position 
You can Insert a position in an animation that you have 
created.  This is usually done to refine your animation after 
you have first created and viewed it.  Whilst in animation 
mode go to the position adjacent to the one where you want 
to add a position.  Right mouse click and select Insert 
Position. 
 
You will be asked whether you wish to add 
the new position before or after the current 
position.  Select the appropriate one and 
click OK.  The Object will be repositioned 
midway between the current position and the 
position before or after depending which you selected.  The speeds will 
reflect the speeds from the position before and after the new position.  You 
can now refine the position by using the Move Position command. 
 
Deleting a position 
You can delete an individual animation control point.  To 
delete a control point go to the position you wish to delete.  
Right mouse click and select Delete Position.  The 
animation position will be deleted. 
 
 
Creating an animation along a line 
New for RelMo 2008 is the ability to make an object follow a line.  The 
limiting factor is that the speed along the line must be constant.  The 
feature is particularly useful for motorcycles as RelMo can automatically 
create the roll in bends. 
 
The first step is to create a line on the model which the Object is to follow.  
This can be done using the line tools such as Create Parallel to create a 
line parallel to the kerb. 
 
Next, drag in the Object, for example a motorcycle, from the Vehicle 
Templates.  Ensure that this Object is dropped into the Object containing 
the line and not the Root Object. 
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Make the Object containing the line, (not the Object to be 
animated), the Active Object and, on the Objects Control 
Bar, right mouse click on the Object to be animated and 
click on set Animation path.     
 
 
 
 
 
The cursor will change and you will be 
able to select the line that the Object 
will follow as shown in the screen shot 
below and to the right. 
 
To select the line, left mouse click on 
it.  The animation dialog box will 
appear. 
 
You can delete any existing animation contained 
within the Object by checking the box.  You can 
set a start time.  This is the global start time in 
relation to any other Objects in the model.  The 
speed can be set in metres per second.  You can 
select whether the object should auto pitch and 
roll, following the undulations of the parent surface 
or, in the case of motorcycles to auto-roll in bends.  
Finally you can select whether the object is to 
follow the terrain. 
 
You can string together a number of separate lines and add to the 
sequence by repeating the above procedure ensuring that Delete existing 
animation is unchecked.  Probably the best way to do this is to create one 
line and then use the Break Lines command to create separate segments 
each of which can have a different animation. 
 
 
Playing an animation 
Animations can be played in 2 and 3D.  Double 
clicking the stop button resets the animation. 
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Preview Animation 
You can preview the animation in 2D and 3D.  In either 2 
or 3D, from the Animation menu select Preview Motion.  
The animated Objects will be redrawn along their path at 
the interval set in the in the Animation Options (see page 
48).   
 
To increase or decrease the number of redraws, from the View menu select 
Options and click on the Animation tab.  Alter the 
calculations per second value where a larger 
number will result in less redraws. 
 

 
 
 
Adding a second animation to interact with the first 
If you have two animated Objects that need to meet at a particular point, 
the following may prove useful. 
 
Animate your first Object.  This should be the Object with the longest 
animation time.  Ensure that one of the animation positions is at the point 
where the two objects are to meet.  Refine the animation and then using 
Animation Properties, go to the position where the two objects are to meet 
and note the global finish time for that position.  Leave the Object in that 
position and escape out of animation. 
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Now make the second object Active and animate the second objects entire 
sequence ensuring that one of the positions is where the Objects will meet.  
When finished, go to the position where the vehicles meet using the 
Animation Properties dialog and change the global finish time to that of first 
object which you noted earlier.  Click calculate and use the << and >> 
buttons to review each position, the timings for which should have changed 
automatically.  Click OK and play the animation. 
 
If you make further changes to either object, you will need to repeat the 
process as the global time will also have altered. 
 
Importing animation 
You can import animation from other programs 
which output their animation in the RelMo format.  
Such programs include Madymo and some 
Incident Data Recorders. 
 
To import an animation, place the Object to be 
animated on the model at the start position.  In the 
Objects Control Bar right mouse click on the 
Object you wish to import the animation to and 
click on Import animation.  The Import Animation 
dialog will appear.  Navigate to the animation file 
output by the third party program and click OK.  
The animation is automatically imported.  To view 
the animation sequence click Play. 
 
 
Troubleshooting animation 
Animating over missing triangles may cause objects to speed up or veer off 
course because the distance cannot be calculated – Create a triangle 
where one is missing. 
 
Animating over multiple triangles where manual triangulation has been 
undertaken and two triangles overlap may cause objects to speed up or 
veer off course because the distance cannot be calculated – Delete the 
triangles and manually create new ones that don’t overlap. 
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Having moved to a new animation position, the speed from the previous 
position has been forgotten – Right mouse click and use Previous position 
to move back two or three positions, then use Next position to move 
forward again.  When you can move forward no more, click Add position to 
add a new position.  Move the object as normal and the speed from the 
previous position should be remembered. 
 
If you have problems whilst animating, the easiest Option is to delete the 
animation using Delete Controls from the Animation menu. 
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Cameras  

Introduction 
Having animated, it is also possible to fly round the survey as the animation 
is played. 
 
Rather than allowing the client free and unfettered access, you can control 
the path by adding a Camera.  Cameras are added from the Views Control 
Bar.  Right mouse click on cameras and click Add.  A new camera will drop 
into the centre of the Active Object. 
 
If you add a camera into an existing object that already has animation, the 
camera will acquire the same animation properties as that object and will 
therefore move with it. 
 
 
Adding the camera to an Object that already has animation. 
Make the Object containing the animation Active.  Right mouse click on 
cameras in the View Control Bar and click Add.  A red arrow will appear in 
the centre of the Active Object.  Make the camera Active and use the 
Object Move command to position the arrow looking the correct way.  
Change its height using the Object Properties command. 
 
To view the Animation from the camera position, go to 3D and select Track 
Camera, from the Display menu.  Play the animation.  If multiple cameras 
are being used click on the camera from which you want to view the 
animation in the Views Control Bar or use F9 and F10 to switch between 
cameras. 
 
 
Adding a camera and creating an independent path. 
Make the survey the Active Object.  Right mouse click on cameras in the 
View Control Bar and click Add.  A red arrow will appear in the centre of the 
Active Object.  Make the camera Active and use the Object Move 
command to position the arrow looking the correct way.  Change its height 
using the Object Properties command. 
 
Animate the camera as you would any other object.   
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To view the Animation from the camera position, go to 3D and select Track 
Camera, from the Display menu.  Play the animation.  If multiple cameras 
are being used click on the camera from which you want to view the 
animation in the Views Control Bar or use F9 and F10 to switch between 
cameras. 
 
 
Renaming cameras 
It may be useful to rename cameras to something more meaningful to your 
job.  Right mouse click on cameras in the Views Control Bar and click 
Properties.  You can set the properties of the camera including changing its 
name. 
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Creating Videos  

Introduction 
RelMo 2008 allows you to create video files which can be played in a 
media player or, using 3

rd
 party software turned into DVD files. 

 
Your computer will need codec software to compress the video files.  
Windows is supplied with such software and further codec software is 
available on the web.  Two particularly good formats are MPG4 and XVID. 
 
Set up the defaults from the View, Options, Animation dialog (see page 48 
for further details). 
 
Once you have added your animation and any cameras, you can create 
your videos.  You are not restricted to creating videos from camera 
positions.  You can equally create videos of ‘fly bys’ across the model.  
 
 
Creating a video 
Go to the camera position from which you wish 
to create a video.  From the Animation menu 
click on Create Video. 
 
The Create Video dialog box will appear.  
Navigate to the place you wish to save your 
video, (video files have the file name extension 
.avi), give it a name and click Save.  
 
The screen will resize to reflect the format set up in 
Options, Animation. 
 
To create the video, click on the Play 
button.  Once you have finished 
recording, click on the stop button. 
 
To exit animation mode, from the 
Animation menu Click on Create 
Video.  The 3D screen will resize to 
normal. 
 
The video file can be viewed in Windows Media Player or similar software. 
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Ortho photos 

Ortho photos are large photos of terrain taken from the air.  These have 
been rectified so that when laid over the corresponding national mapping 
agencies 3D point data, the photo corresponds to the land. 
 
In the UK, the Ordnance Survey can supply X, Y and Z coordinate data for 
any part of the country and, most of the country is now available as ortho 
photographs. 
 
Ortho photos are usually supplied by the square km and in a number of 
resolutions.  The higher the resolution of the photo, the higher the price. 
 
Once loaded, the surface of the photo can be broken up and points added 
to allow the user to add 3D objects and designs. 
 
To load an ortho photo, you need to know the Northing and Easting of the 
bottom left and top right of your Survey data.  If you have too much data, 
you can set a filter in the import dialog box to only import points for a 
specified area North and East. 
 
Now make a new texture in the 
normal way with your ortho photo 
as normal and click on the set 
size button.  The dialog to the 
right will appear. 
 
Enter the northing and easting of 
the bottom left and top right 
corner. 
 
The software will work out the 
remaining boxes and allocate bits 
of the image to the appropriate 
triangles. 
 
Now all that remains to be done is 
to triangulate the model. 
 
Set the survey Active.  Select AutoCalc triangles from either the Object or 
triangle menu.  Select the image that you called your ortho photo and 
check the ortho photo rendering box.  Click OK. 
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Distributing animation files 

 
Pack and Go 
Prior to using the Pack and Go wizard, reduce the file size as described on 
page 202.   
 
From the File menu in 2D, select Pack and Go.   
 
Use the next button to step through the various stages 
 
 
Follow the steps in the Pack and Go Wizard.  You have 
a choice of what files to Pack. You can include 
RelMo3, the Viewer program and help files.  Each time 
you update RelMo, you should also update the Viewer 
program and, redistribute the new copy to your clients.  
The sky bitmap and Info Pages can also be included.   
 
Browse to the folder you wish to save your work in or, click 
the Create Folder button and type in the name of your new 
folder.  Click OK and then Next. 
 
 
A list of all the files will be displayed.  You can add 
further files by using the Add button.  Also included is a 
DLL file, IJL15.DLL.  Not all computers have this file 
which is used by RelMo and the Viewer so it is 
supplied in the Pack and Go job as standard. 
 
Click the next button and click finish.  The files will be copied to your folder.  
Your job filename extension will have been changed from a RelMo file 
(.rlm) to a Viewer file .rlv. 
 
Burn the folder to a CD and distribute with the usual caveats about the 
specification of the computer the end user will require. 
 
Your client simply needs to copy the folder to their hard drive and double 
click on RelMo3.exe and then Open the file you have sent them. 
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See page 192 for instructions on how to use RelMo3.  These pages may be 
photocopied and sent out to end users.  A copy is also available in Adobe 
format from www.relmo.co.uk. 
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RelMo3 Instructions to end Users 

 
Introduction 
The RelMo 3D viewer allows anyone to view 3D animations created by 
RelMo.  You cannot view 2D plans and you cannot carry out any editing of 
the model other than changing the lighting conditions. 
 
The viewer and associated job 
files are supplied to you on a 
CD created by the RelMo user.  
Copy these files to a folder that 
you create on your hard drive, 
do not run them from the CD.   
 
Note - The minimum spec for a 
computer to run the animation 
smoothly is a Pentium 2.5Gh processor with 512Mb of Ram a 128Mb graphics card with a 
CD drive and wheelie mouse.  Animations will run on slower processors with smaller 
graphics cards, however they may appear jerky.  If the RelMo user has used multiple lights 
and shadows, you will also need a graphics card which supports hardware shadowing.  Visit 
www.relmo.co.uk for a list of graphics cards. 
 
The RelMo 3D viewer program is freeware, in other words, you can 
distribute and use it free of any fee. 
 
The environment 
To open a file, from the file menu click open and open the file you wish to 
view.  The file will be loaded into RelMo3. 
 
The Creator can control what you view by adding 
any number of cameras.  You can see these 
cameras, by clicking on the Views tab of the Control 
Bar to the left of the screen.  When you play an 
animation, you are guided along the path of the 
camera.  You can swap between cameras by 
double clicking on the camera you want.   
 

CONTROL BAR 

VIEWS TAB 

CAMERAS 
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Below the Camera icon is the Views Icon.  If the creator 
of the survey has produced specific static views, they 
will appear here.  Static views may represent the view 
seen from a specific position and height.  Double click 
on the view to see it displayed on the main screen.  You 
can move around from this position.  To return to a 
Camera view, double click the Camera. 

 
If the Control Bars are not shown on screen you can 
display them.  From the View menu, click on Control 
Bars and then the appropriate Bar. 
 
By default the Control Bars will be displayed on the 
left of the screen.  The small Autohide pushpin in the 
top right corner can be toggled to permanently display 
the Control Bar or to hide it at the edge of the screen. 
When the pushpin is down the Control Bar is locked.  When 
it is on its side, the Control Bar will hide itself. 
 
To display the Control Bar in Autohide mode, guide the 
mouse over the appropriate tab on the left of the screen. 
 
 
To play an animation 
If the creator has added animation, click the play button on the 
main toolbar.  To pause an animation, click stop.  To proceed in increments 
click the increment button to step through the animation.  To reset the 
animation double-click the stop button.   
 
Before you play an animation you can choose to view it from any of the 
camera views by double-clicking on the appropriate camera and then 
clicking play.  You can ‘look around’ whilst watching an animation by using 
the mouse and left mouse button and dragging it across the screen. 
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Free movement 
Getting to a static position 
Your movement is not restricted to the path taken by a 
camera.  To move around the scene without restriction first 
from the display menu, uncheck the Track Camera button. 
You will be repositioned 100 metres above the survey.  Use 
the wheel of the wheelie mouse to zoom in and out.  
(Holding down the Control key will increase the rate at 
which you zoom in). 
 

To change your position use Shift and left mouse or  to 
drag the survey about the screen. 
 

Left mouse only or  rotates the survey about your eye. 
 

Control and left mouse or  moves you about the centre of the survey. 
 
Free Flight 
You can fly around the scene in free flight.  Use the following keys, 
F2 Fly or stop Flying 
F4 Set Fly speed increments 
Control + A  Speed up in increments 
Control + Z  Slow down in increments (you can use this command to 
stop) 
ESC Escape from Fly mode 
 
You can control your heading and pitch using either the arrow keys or the 
mouse with the left mouse button depressed. 
 

If you get lost, stop flying (ESC) and click on the home button . 
 
Whilst flying, at the bottom of the screen you are given feedback.  This 
includes, pitch (where a negative figure is down), heading, speed in metres 
per second and the number of 
frames per second. 
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Display options 
You can choose whether or not to display the 
textures, lines, points, and triangles.  Normally, 
you would not choose to turn off the textures or 
triangles, however, lines are not normally 
displayed in 3D, turning them on will often reveal 
original survey data that may be of use, similarly 
with points. 
 
Show wireframe, simply shows a wireframe view 
of the model and show triangle outline simply 
shows the outline of the triangles that make up the 
surface of the model.  Show sky, shows a clouds 
background where this has been supplied by the 
file creator. 
 
Show axes displays an X, Y and Z pointer that may help you with your 
navigation and show target shows a target to assist you with zooming in on 
a particular point. 
 
 
Info Pages 
Introduction 
Info Pages are HTML boxes that can be attached 
to objects by the creator.  They can contain 
written information and pictures. The Creator can 
choose whether or not to include any Info pages 
they have created with the files they have 
supplied to you.  The Creator should tell you if 
Info box data is included with the file.   
 
Setting the cursor active 
From the view menu select Track Object Info.  
When the cursor passes over an Object that 
contains an Info Page, it will change as shown in 

the picture to the left.  Left 
mouse click to display the Info 
page. 
 
An example Info page. 
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Printing images 
You can print any 3D views.  The various options can be 
found on the File menu.   
 
You can either print the whole Window or, a rectangle 
which you drag out with your left mouse button.  Print 
preview options are available for both of these options. 
 
You can also Save an image to your computer. 
 
 
Altering the lighting 
Introduction 
If your survey contains multiple lights, you will ideally need a graphics card 
that handles shadow acceleration.  RelMo uses OpenGL as its 3D 
rendering engine.  OpenGL has been supplied by Microsoft

®
 since 

Windows 95
®
 and is a commonly used set of functions.  Many graphics 

card manufacturers have chosen to extend the core function supported by 
OpenGL and many now support additional hardware accelerated 
capabilities.  These are made available through a series of extensions for 
which RelMo will search.  Some Graphics cards however do not support 
these extensions, and in those circumstances, RelMo provides a software 
based rendering solution whenever it can. 
 
The RelMo website carries a list of some of the more common cards and 
whether they support the necessary acceleration. 
 
It will help to have an understanding of some lighting terms before we begin 
to manipulate lights. 
 
Positional lights 
Positional lights have a particular location in space and can radiate light in 
all directions.  The angle of the light cone can produce a tightly focused 
beam of light.  Positional lights can be positioned by the creator of the 
survey. 
 
Directional lights 
Directional lights can be thought of as providing light from a particular 
direction.  The light emitted by such a light is assumed to be parallel and 
any calculations make this assumption.  (Imagine the light rays emitted 
from the sun.  Because we are such a long way from the source, by the 
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time they reach us the are in fact all but parallel i.e. they have the same 
direction hence a directional light source).  
 
Shadows 
The nature of the light defines how any shadows are produced.  They can 
be a very expensive process computationally, unless special OpenGL 
hardware acceleration functions are available on the graphics card.  Where 
not present RelMo resorts to a much slower software implementation.   
 
Projection masks 
Positional lights can use a projection mask which limits the field of view of 
the light.   
 
Lights as Objects 
RelMo always contains one default light which can be 
seen as part of the Root in the Objects Control Bar.  
Note that it is possible to delete this light in which case, if 
the ambient light is also turned off, you will not be able to 
view the survey.  Deleting the light is therefore not 
recommended! 
 
 
Adjusting the Ambient light 
Whereas the main lighting properties allow shaded areas 
and highlights to be viewed, ambient properties enable objects that are in 
shade to be illuminated.  The example below demonstrates this. 
 
As the Ambient light already exists by default, in 3D view click on 
the lighting button.  The 
lighting dialog will be 
displayed.  Click on the 
General tab for Ambient 
light settings. No Ambient light – only the 

area illuminated by the 

second light can be seen 
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Ambient light 
Enable ambient lighting simple allows the ambient 
light to be shown. 
 
The Level slider bar will alter the intensity of the light 
with the slider to the right being the most intensive. 
 
Background light 
The background light can be altered in intensity and 
colour.  Note that you can only alter the background 
light if you are displaying a background image such as 
one of the sky bitmaps.  The two images to the right 
show different intensities of background light.  
Note that the light on the model itself remains 
the same.  Moving the slider to the right 
increases the intensity of the light. 
 
Lighting model 
Two sided lighting calculations refine the way that shadows are cast.  This 
however is at the cost of processing power.  Local Viewer lighting is 
another model that effects the way in which the light is calculated towards 
the user.  Using these models will improve shadow quality at the expense 
of processing power. 
 
Special effects 
Show Shadows allows Objects to cast shadows against the ground model 
and other Objects. 
 
Using a light mask enables the user to project a light which 
displays an image as shown to the right. 
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Directional and positional lights 
Where a creator has included lights, their intensity 
and direction can be altered in the Viewer program. 
 
General 
You can change the name of the light to something 
meaningful.  You can also change the colour of the 
light. 
 
Enable light has the same effect as switching a light 
on and off.   
 
Choose between Directional and Positional lighting.  
Check the box for a Directional Light and leave it unchecked for a 
Positional Light.  Directional and positional lighting are explained 
previously. 
 
Show source will show the light source as a large point. 
 
Enable mask is only available for positional lighting.  If you enable a mask 
you can allow RelMo to use the default mask or select a mask from a 
separate source.  See Special Effects on the previous page for further 
explanation.  To view a mask, you must check the use light masks box on 
the General page. 
 
Enable shadows will allow this light to cast shadows.  Show shadows must 
also be checked on the General page. 
 
Advanced 
This dialog allows you to control exactly how some advanced lighting and 
shadowing parameters are used by RelMo. 
 
The Size option controls the size of the virtual light.  Increase the size to 
make the light larger.  Size has no effect on the amount of light displayed. 
 
Clipping can be altered for example, if you don't require shadows to be 
generated until at a distance of 100m from the light source, then setting the 
near clipping plane to 100m will mean that the depth of field calculations 
start at 100m. 
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The shadow offset control allows you to manually set an offset to the 
shadow image when it is applied to a scene so that any remaining visual 
artefacts can be 'pushed away' from the real scene and thereby hidden 
from view.  Some experimentation may be required for these values which 
will be largely dependent upon the position of the light source and also the 
orientation of the scene illuminated by that light. 
 
The attenuation factors control how light the intensity of light falls off with 
distance. 
 
All these controls can be played with to reach the desired effect. 
 
Location gives the Eastings, Northings and Height of the light.  Note 0 east, 
0 north will place the light at the centre of the survey at whatever height you 
specify. 
 
Rotation applies to positional lights, the pitch, yaw and roll angles can be 
altered to point the light in the right direction. 
 
Levels controls are used to shape and alter the intensity of the light. 
 
Ambient controls the intensity of the light.  Defuse softens or hardens the 
boundaries of the light when no mask is applied.  Specular alters the way 
the light reflects off the surface.  Spot angle alters the width of the cone.  
Exponent alters the depth of the light. 
 
Position allows you to adjust the position of the light source relative to the 
centre of the survey.  You can display a small sphere in the 3D scene 
which shows you exactly where your light source is positioned by checking 
the Show source box. 
 
Intensity controls the proportion of the directional and ambient lights. The 
Effect parameter controls how much light is available for reflectivity 
properties of the material. In other words the effect of the specularity and 
shininess properties set by the creator in the textures dialog for each 
material used. Adjusting these figures can give interesting effects! 
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Fog 
Fog is set using the fog parameters within this dialog.  Generally the colour 
of fog is set to be the same as the background colour.  Distant objects then 
merge gradually into the background. 
 
Two fog modes are available, the exponential version uses the density 
parameter to determine the amount of fog. The linear version uses the start 
and end fog positions to determine zero and 100% fog respectively. 
 
A small amount of fog allows more realistic scenes to be displayed, since 
distant objects tend to be viewed with a slight amount of haze in real life.  
 
 
Further help 
You can find attritional help and information at www.relmo.co.uk.  No 
telephone or email support is available for users of the Viewer program. 
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Saving, Backup and File sizes 

Saving 
It is recommended that you save your file on a regular basis. 
 
Backup 
RelMo automatically generates a back-up of your last ‘good’ save.  This file 
has the same name as your working file with _bak appended to the end.  
The file is saved as a hidden file in the same folder as the survey you are 
working on.  It is a standard rlv file and can be opened, save and renamed 
at any stage. 
 
You will need to ensure that Windows Explorer is set to show all file types 
to view a hidden file.  From the Tools Menu select Folder Options and on 
the View Tab select Show hidden files and folders. 
 
Reducing file size 
On completion of your job and prior to using the pack and go wizard it is 
recommended that you take the following action to deduce the size of the 
file. 
 
Remove any unused codes and textures   
From the resources ControlBar, right mouse click on Codes and select 
Remove Unused.  Save your work. 
 
Remove any unused Layout pages   
From the Views ControlBar, right mouse click on any unused Layout pages 
and click Delete.  Save your work. 
 
Delete the backup file 
Delete the backup file from the working directory. 
 
Creating a PDF file 
You can create a PDF file of you plan for archive purposes.  To do this you 
need to have a PDF printer installed such as Adobe Acrobat. 
 
From the Layout Page, click on Print, and from 
the Print Dialogue select your PDF printer.  Click 
OK.  You will be asked for a file name, give your 
plan a name and click OK.  Your plan will be 
saved to a PDF file. 
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Data Protection and Integrity 

 
Protecting your survey 
You can choose to protect your survey to stop other parties from making 
alterations by entering a password which prevents any changes from being 
saved.  If you Save As, the password will be transferred to the newly 
named file. 
 
To password protect your survey, from the File 
menu select Protect Survey.  The Protect Survey 
dialog will be displayed.   
 

Enter and confirm your 
password.  When you click 
OK, your survey will be 
protected. 

 
When you try to Save, the Unprotect Survey dialog is 
displayed.  To save the changes enter your password 
and click OK.  To unprotect the survey and save the 
changes enter your password, check the Set as 
unprotected check box and click OK.  You work will be 

saved and the file will become unprotected.  If you 
click OK without entering a password, the save will be 
prohibited.  You can still close the survey, but you 
must click no to Save Changes. 
 
 
Log File 
RelMo produces a log file which can be viewed and printed.  To view the 
log files go to the main View menu and select Log File.  An example is 
produced on the following page. 
 
Note that log files are created on the fly and, although you can delete or 
add lines and save the file, the next time it is created, any deletions or 
additions will be lost. 
 
The log file is an integrated part of RelMo, not a separate file.  If you send a 
document to another user, the log file can be viewed by them.  RelMo3 
does not support the viewing of log files. 
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Each time the survey is opened or saved, the Log file stores the date and 
time and the user that is logged onto the computer. 
 
Other data that is stored includes, 

o Import data such as station setups, 0 setting the horizontal 
angle, backsight station creation.   

 
o Where the user uses check observations, the differences are 

listed.  Such check observation differences are, in the surveying 
world, an indication as to the integrity of the survey. 

 
o The difference is based on the following equation 

 

o 
2 2 2Northings  + Eastings  + Heightdifference

 
 

o Where the value for the Northing, Easting and Height is the 
difference between the current backsite observation and, the 
initial set-up. 

 

o Triangulation data is stored including the number of points 
inserted during triangle optimisation. 

 
o All alterations to points including deletion, insertion, movement 

and alteration of codes are recorded.  Alteration to line codes 
are not recorded. 

 
An example file is produced on the following page. 
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RelMo Log File: C:\Program Files\AiTS\Logs\Book survey.rlv.log  
Created on: Wednesday, 27 October 2004 at 08:25 for user: RicW ( 0300200 ) 
 
 
Data: 
1001 211103 12:15 Version 5.20 survey file created (User: RicW) 
2010 211103 12:15 Importing C:\Program Files\AiTS\Surveys\Samples\Rw1.001 into object Rw1 (User: RicW) 
2000 211103 12:15 Station A created at: 1000.000 E, 1000.000 N, 100.000 H 
2001 211103 12:15 Moved to station A at: 1000.000 E, 1000.000 N, 100.000 H. Backsight to B: 0.000 deg. 
2000 211103 12:15 Station B created at: 1000.000 E, 1024.062 N, 99.707 H 
2005 211103 12:15 Check Obs to station: B: 0.010 difference (0.009 E, 0.003 N, 0.002 H) 
2011 211103 12:15 Completed. 149 points 15 lines 0 errors 
3000 211103 12:15 Triangulation begun in object: Rw1. 
3002 211103 12:15 Triangle optimisation: 0 points inserted for crossing lines. 
3002 211103 12:15 Triangle optimisation: 12 points inserted during 4 iterations. 
3002 211103 12:15 Triangle optimisation: 2 external triangles removed. 
3001 211103 12:15 Triangulation completed in object: Rw1. 718 triangles created in 0.761 s. 0 duplicate points 
ignored. 0 errors. 
1003 211103 12:24 Survey file saved as D:\RelMo Training\Resources\Book survey.rlm (User: RicW) 
1003 211103 12:30 Survey file saved as D:\RelMo Training\Resources\Book survey.rlm (User: RicW) 
1003 211103 12:34 Survey file saved as D:\RelMo Training\Resources\Book survey.rlm (User: RicW) 
1003 211103 13:27 Survey file saved as D:\RelMo Training\Resources\Book survey.rlm (User: RicW) 
1003 211103 13:29 Survey file saved as D:\RelMo Training\Resources\Book survey.rlm (User: RicW) 
1002 271103 09:23 Survey file opened. (User: RicW) 
1003 271103 10:37 Survey file saved as D:\RelMo Training\Resources\Book survey.rlm (User: RicW) 
1002 271103 14:44 Survey file opened. (User: RicW) 
1003 271103 14:47 Survey file saved as D:\RelMo Training\Resources\Book survey.rlm (User: RicW) 
1002 031203 10:10 Survey file opened. (User: RicW) 
1003 031203 12:12 Survey file saved as D:\RelMo Training\Resources\Book survey.rlm (User: RicW) 
1002 031203 12:52 Survey file opened. (User: RicW) 
2050 031203 12:55 Rw1: Point code WR2 at (968.539, 924.336, 101.369) moved to (968.740, 924.244, 101.603) 
(User: RicW) 
1003 031203 13:06 Survey file saved as D:\RelMo Training\Resources\Book survey.rlm (User: RicW) 
1002 091203 13:31 Survey file opened. (User: RicW) 
1003 091203 13:47 Survey file saved as D:\RelMo Training\Resources\Book survey.rlm (User: RicW) 
1002 101203 13:16 Survey file opened. (User: RicW) 
1003 101203 13:22 Survey file saved as D:\RelMo Training\Resources\Book survey.rlm (User: RicW) 
1002 200404 11:11 Survey file opened. (User: RicW) 
1003 200404 11:11 Survey file saved as D:\RelMo Resources\Book survey.rlv (User: RicW) 
1002 051004 08:43 Survey file opened. (User: RicW) 
2052 051004 09:23 Root: User created point deleted. Code SBAR50 at (1037.475, 1014.669, 100.000) (User: RicW) 
1003 051004 09:23 Survey file saved as D:\RelMo Resources\Book survey.rlv (User: RicW) 
2050 271004 08:24 Rw1: Point code RAPO at (985.185, 992.690, 100.413) moved to (983.802, 990.193, 100.413) 
(User: RicW) 
2052 271004 08:24 Rw1: Original survey point deleted. Number 0 with code RAPO at (990.437, 990.379, 100.416) 
(User: RicW) 

1003 271004 08:25 Survey file saved as D:\RelMo Resources\Book survey.rlv (User: RicW) 
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Import data formats 

 

XYZ File Format 
RelMo supports both the import and export of an extended XYZ file format.  
This is an ASCII based file format and most of the features supported by 
RelMo files can be created using this format.  In turn this permits third party 
developers to create files suitable for use within RelMo.  At present a 
number of manufacturers have developed or are developing output formats 
suitable for direct import into RelMo.  
 
A full description of the RelMo extended XYZ format is available to 
Developers on request from support@mathtech.co.uk. 
 
To import a RelMo XYZ file, from the File menu select Import.  The Import 
dialog will be displayed.  Select XYZ Standard and click on Open.  The 
status bar at the bottom of the screen will report the progress of the import. 
 
Standard XYZ files 
Most software can output an XYZ file.  The format of XYZ files is as follows: 
 
Any blank line or line beginning with the character # is ignored.  Points are 
defined using a five or more field comma delimited line, i.e.  PointNo, 
xCoord, yCoord, zCoord, code, [code2, code3 etc] 
 
Each point must be on a separate line. The code is used by RelMo to 
determine either the point type, or link type. Using a number as the 
postscript (e.g. KC1, KC2 etc) instructs Relative Motion to generate a link 
using the link code (e.g. KC). You may also use multiple codes to create 
multiple links attached to the point. 
 
EXAMPLE FILE.... 
# this is a comment line and is ignored 
1, 0, 3.45, 100, KC1 
2, 1.2, -4.44,100, KC1 
3, -2.33, -4.44,100, KC1 
4, 0, 1,100, KC1 
5, 1, 1, 100, KC1 
6, 2, 1.5, 100, KC1 
7, 3, 1, 100, KC1 
 

To import an XYZ file, from the File menu select Import.  The Import dialog 
will be displayed.  Select XYZ Standard and click on Open.  The status bar 
at the bottom of the screen will report the progress of the import. 



IMPORT DATA FORMATS 

AiTS International  207 

Raw XYZ files 
The format for Raw XYZ files is very simple and imports only the points, 
without any point or line code information. It is designed for importing 'point 
clouds' as generated by laser scanning technology. 
 
Any blank line or line beginning with the character # is ignored.  Points are 
defined using a three field comma delimited line, i.e.  xCoord, yCoord, 
zCoord 
 
To import a Raw XYZ file, from the File menu select Import.  The Import 
dialog will be displayed.  Select XYZ Raw and click on Open.  The status 
bar at the bottom of the screen will report the progress of the import. 
 
Mesh XYZ files 
These files are used in conjunction with ortho-photos.  With mesh files no 
triangulation of the model is required.  Mesh files containing XY and Z 
coordinates can be supplied with the appropriate ortho-photo from 
Getmapping to name one of the many suppliers. 
 
DXF 
DXF files up to AutoCAD version 12 are supported.  This includes LINES, 
POINTS, POLYLINES, 3DFACE, CIRCLE, ARC & TEXT entities only.  
 
To import a DXF file, from the File menu select Import.  The Import dialog 
will be displayed.  Select DXF and click on Open.  The status bar at the 
bottom of the screen will report the progress of the import. 
 
When importing DXF files, RelMo will maintain the layer structure of the 
original file, by generating a new Object for each CAD layer. 
 
DXF deals with curved lines by adding multiple points and joining them with 
straight lines.  Because the number of points added is large, the lines still 
appear curved.  In addition, the large number of additional points created 
by DXF files causes a huge number of unnecessary triangles to be 
generated.  In saying this RelMo can filter large numbers of these points 
out by using the filter tools in the Survey import box in Options, (see page 
43). 
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LSS 
LSS load files are supported.  You will need to replicate your LSS codes 
library in RelMo.  Surface codes are not supported nor are textures or 
colours. 
 
To import an LSS file, from the File menu select Import.  The Import dialog 
will be displayed.  Select RelMo/LSS and click on Open.  The status bar at 
the bottom of the screen will report the progress of the import. 
 
Line and offset files 
You can import line and offset files written in a text editor such as notepad.  
The following format should be used. 
 
Any blank line or line beginning with the character # is ignored. 
Points are defined using a four or more field comma delimited line, i.e.: 
Baseline, offset, height, code [,code2, code3 etc] 
 
Each point must be on a separate line. The code is used by RelMo to 
determine either the point type, or link type.  Using a number as the 
postscript (e.g. KC1, KC2 etc) instructs RelMo to generate a link using the 
link code. 
 
If height information is not available, RelMo will assign the default height to 
the point. It is important however to include the delimiting comma. 
 
EXAMPLE FILE.... 
# this is a comment line and is ignored 
0,0,100,CRS 
0, 3.45,, KC1 
1.2, -4.44,, KC1 
-2.33, -4.44,, KC1 
0, 1,, KC1 
1, 1,, KC1 
2, 1.5,, KC1 
3, 1,, KC1 
4, 1,, KC1  

 
To import a Line and Offset file, from the File menu select Import.  The 
Import dialog will be displayed.  Select Line and Offset and click on Open.  
The status bar at the bottom of the screen will report the progress of the 
import. 
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TERRAMODEL users – Exporting XYZ files 
 
Introduction 
With the new Complex 3D Codes, you can save a lot of time if you can 
import into RelMo and retain your point code information.  This will ensure 
that fences, lampposts, walls, white lines etc actually come out as 3D 
objects without further work. 
 
With DXF data, point and line codes are lost.  The answer is to export from 
your own software as a XYZ file. 
 
By default points in XYZ files are expected to be in the order - Easting, 
Northing, Height. With some 3rd party software this may not always be 
true. To change the point order to Northing, Easting, Height set the 
appropriate option in the Filter dialog accessed from the Import dialog 
 
 
First Step 
Change your RelMo codes to match your own codes.  Open the Survey 
‘Codes’ in c:\program files\AiTS\bin.  From the Resources Control Bar,  
open the Lines Tree,  Change the Properties of the Codes to match your 
own.  Do the same in Points and save the changes. 
 
In Terramodel 
An export script is needed to create a suitable xyz file. Terramodel will call it a .pts file. 
 
File>Export>Export Script Manager. 

1. Select New, give it a name and select 'Export to disk', the format is ASCII points 
2. Complete the 'export to file' box with a destination of your choice 
3. In the 'output format' box type P,E,N,Z,D  with commas and no spaces 
4. Tick 'show this page at runtime' 
5. Select next and ignore the point settings dialogue box, remove the tick from 'show this 

page at runtime' 
6. Select Finish. 

 
When importing into RelMo choose xyz format and then use the 'all files' 
option to see the .pts file 
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CARS/SDR Map users – Exporting XYZ files 
Introduction 
With the new Complex 3D Codes, you can save a lot of time if you can 
import into RelMo and retain your point code information.  This will ensure 
that fences, lampposts, walls, white lines etc actually come out as 3D 
objects without further work. 
 
With DXF data, point and line codes are lost.  The answer is to export from 
your own software as a XYZ file. 
 
By default points in XYZ files are expected to be in the order - Easting, 
Northing, Height. With some 3rd party software this may not always be 
true. To change the point order to Northing, Easting, Height set the 
appropriate option in the Filter dialog accessed from the Import dialog 
 
First Step 
Change your RelMo codes to match your own codes.  Open the Survey 
‘Codes’ in c:\program files\AiTS\bin.  From the Resources Control Bar,  
open the Lines Tree,  Change the Properties of the Codes to match your 
own.  Do the same in Points and save the changes. 
 
In Cars  

1. Tools/Database editing/Point COORDS. 
2. Select ALL at the bottom of the screen. 
3. Select OK. 
4. In the next window that opens select FORMAT REPORT. 
5. Select the NEW button. 
6. Type the name into the highlighted REPORT NAME field.  
7. Change Index 1 to Point.  
8. Index 2 to Eastings 
9. Index 3 to Northings. 
10. Index 4 to Height. 
11. Index 5 to Code. 
12. It doesn't matter too much about the field widths but it is suggested that you use 10 

and 4, they do need to be set.  
13. The Tail needs to be set to a comma (,) and don't bother with the last one, i.e. the 

Code, that can remain ""  
14. Once completed select CANCEL. 
15. Make sure the previously created report is visible in the Report Name field.  
16. Select OK.  
17. Put a tick in the TEXT file field. Type the path and the file name with the XYZ 

extension. 
18. Press the Enter key twice. This will have then created the file in the location you 

selected in the file name field. 
19. (Once you've created the format you can use it again and don't need to repeat the 

procedure) 
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In RelMo  
New Job/Import.  
Select XYZ and navigate to the file. You may need to select "All Files" to 
find it if you haven't changed it to XYZ.  
 
The data should import and draw the lines as long as your codes are 
correct. If you need to edit them you can do that in WordPad or suchlike 
and then import them. 
 
 
Geotronics/Landscape users – Exporting XYZ files 
Introduction 
With the new Complex 3D Codes, you can save a lot of time if you can 
import into RelMo and retain your point code information.  This will ensure 
that fences, lampposts, walls, white lines etc actually come out as 3d 
objects without further work. 
 
With DXF data, point and line codes are lost.  The answer is to export from 
your own software as a XYZ file. 
 
By default points in XYZ files are expected to be in the order - Easting, 
Northing, Height. With some 3rd party software this may not always be 
true. To change the point order to Northing, Easting, Height set the 
appropriate option in the Filter dialog accessed from the Import dialog 
 
 
First Step 
Change your RelMo codes to match your own codes.  Open the Survey 
‘Codes’ in c:\program files\AiTS\bin.  From the Resources Control Bar,  
open the Lines Tree,  Change the Properties of the Codes to match your 
own.  Do the same in Points and save the changes. 
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In Landscape 
Open the job you wish to export in Landscape 
 
Go to the Print Menu 

1. Select COORDS as the style 
2. Select DEFAULT as the printer 

print 0 lines per page 
leave 1 lines after header 
leave 0 lines between Bodies 
leave 1 lines before Footer 

3. Setup is Header 
4. The print job to file  -  enter the path including the name for the file, 
5. use .txt for the extension 
6. The job will be saved, exit landscape 
7. Open saved txt file using Excel, RelMo needs columns 1 to 5 inclusive, delete the rest 
8. save as .csv file (means Comma delimited) 
9. exit Excel 
10. change file extension from .txt to .xyz (or use all file types when you import in RelMo) 

 
In RelMo  
New Job/Import.  
Select XYZ and navigate to the file. You may need to select "All Files" to 
find it if you haven't changed it to XYZ.  
 
The data should import and draw the lines as long as your codes are 
correct. If you need to edit them you can do that in WordPad or suchlike 
and then import them. 
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Export data formats 

XYZ files 
RelMo supports both the import and export of an extended XYZ file format.  
This is an ASCII based file format and most of the features supported by 
RelMo files can be created using this format.  In turn this permits third party 
developers to create files suitable for use within RelMo.  At present a 
number of manufacturers have developed or are developing output formats 
suitable for direct import into RelMo.  
 
It also allows RelMo users to export files and send them to other RelMo 
users in a very efficient file format. 
 
A full description of the RelMo extended XYZ format for Developers is 
available on request from support@mathtech.co.uk 
 
To export a n XYZ file, from the File menu click on As XYZ.  You will be 
prompted for a file name and location for the Save. 
 
An example of a section from a RelMo extended XYZ file is produced 
below. 
 
# RelMo XYZ Format File. 
# Generated using RelMo v6.00 
 
[Codes] 
SBAR30=P:30 metre scale bar,5,512,0 
PNT=P:Default point,0,0,0 
PBOL=P:Pedestrian bollard - Black,5,64,0 
SL5=P:Streetlamp 5 high,5,16744576,0 
PT2010=P:Tree - 20 high 10 spread,5,0,8 
NULL=P:Null point,0,16777215,0 
PT0705=P:Tree young 7 high 5 spread,5,0,8 
PT1620=P:Tree - 16 high 20 spread,5,0,8 
PTLB0803=P:Tree leafless HQ 8 high 3 spread,5,0,8 
PTLB1507=P:Tree leafless birch 15 high 7 spread,5,0,8 
STN=P:Station,2,4194432,0 
=P:,5,0,0 
LINE=S 
KC=S:Kerb curved,3,1,8421440,0,0 
KS=S:Kerb straight,2,1,8421440,0,0 
LINE=S 
LINE=S 
DEF=S:Default line,0,1,0,0,0 
WR=S:Wall to right of surveyed point In brick 2 high,6,1,4210816,0,0 
Asphalt Black=A:Asphalt Black.bmp,3355443,0,0,0,0,1.000,1.000,0.000,0.000 
grass=A:grass.bmp,4227072,0,0,0,0,1.000,1.000,0.000,0.000 
Concrete 1=A:Concrete 1.bmp,12632256,0,0,0,0,1.000,1.000,0.000,0.000 
Asphalt Red=A:Asphalt Red.bmp,128,0,0,0,0,1.000,1.000,0.000,0.000 
SIGN 'SCHOOL'.BMP=A 
CLOUD3.BMP=A 
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[Config] 
Scale=500 
Colour=16777215 
Image=cloud3.bmp 
AngView=60.0 
ClipNear=1.0 
ClipFar=2500.0 
Ambient=50 
AmbCol=16777215 
Flags=1315933 
 
[CodeObject] 
Name=WR 
Type=10 
Flags=2 
 
[Points] 
1,0.000,0.000,0.000,DEF 
2,1.500,0.000,0.000,DEF 
3,3.000,0.000,0.000,DEF.:RGB4210816 
4,3.000,-0.250,0.000,DEF 
 
[Triangles] 
2,12,7,8,16512,1.000000,1.000000,brick.bmp 
2,8,11,12,16512,1.000000,1.000000,brick.bmp 
2,11,8,9,16512,1.000000,1.000000,brick.bmp 
2,9,10,11,16512,1.000000,1.000000,brick.bmp 
 
[Panels] 
2,6,7,5,8,16512,0,brick.bmp 
2,5,8,4,9,16512,0,brick.bmp 
[EndObj] 
 
 

DXF files 
You can export as a DXF file.  This dialog allow you 
to control some of the aspects of the DXF file 
created during the export process.  RelMo only 
supports a limited subset of the features recognised 
by AutoCAD

®
.  At present these features are all 

contained within the DXF version 10 definition, so 
later versions are not explicitly supported.  You 
should find however that later versions of 
AutoCAD

®
 should recognise earlier versions and 

display them correctly. 
 
To export a DXF file, from the File menu first click on 
DXF Options and set those entities that you wish to 
export (usual all of them).  Then from the File menu 
click on As DXF.  You will be prompted for a file name 
and location for the Save. 
 
An example of a DXF file is produced over. 
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0 
SECTION 
  2 
HEADER 
999 
RelMo DXF file output 
999 
Generated using RelMo v6.00 
  9 
$ACADVER 
  1 
AC1006 
  9 
$EXTMIN 
 10 
932.536 
 20 
922.026 
 30 
97.391 
  9 
$EXTMAX 
 10 
1048.973 
 20 
1032.403 
 30 
109.932 
  9 
$AUNITS 
 70 
1 
  9 
$ANGDIR 
 70 
1 
  9 
$LUNITS 
 70 
2 
  9 
$LUPREC 
 70 
3 
  0 
ENDSEC 
  0 
SECTION 
  2 
TABLES 
  0 
TABLE 
  2 
LTYPE 
 70 
1 
  0 
LTYPE 
  2 
CONTINUOUS 
  3 
Solid line 
 70 
0 
 72 
65 
 73 
0 
 40 

0.0 
  0 
LTYPE 
  2 
DASH 
  3 
Dash 
 70 
0 
 72 
65 
 73 
2 
 40 
1.0 
 49 
0.5 
 49 
-0.5 
  0 
LTYPE 
  2 
DOTDOT 
  3 
Dot 
 70 
0 
 72 
65 
 73 
2 
 40 
0.4 
 49 
0.2 
 49 
-0.2 
  0 
LTYPE 
  2 
DOTDASH 
  3 
DotDash 
 70 
0 
 72 
65 
 73 
4 
 40 
1.3 
 49 
0.8 
 49 
-0.2 
 49 
0.1 
 49 
-0.2 
  0 
LTYPE 
  2 
DASHDASH 
  3 
DashDash 
 70 
0 
 72 
65 

 73 
4 
 40 
1.6 
 49 
0.8 
 49 
-0.2 
 49 
0.4 
 49 
-0.2 
  0 
ENDTAB 
SEQEND
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Changes to RelMo 2008 SP1 

o Underline and strikeout text are now supported throughout RelMo, not just in the 
Layout Pages.  An additional toolbar icon for strikeout text has been added to the 
Layout Page format toolbar. 
 

o Survey text ‘remembers’ the last user font, style, colour etc so that additional items 
of survey text are consistent without superfluous user interaction. 

 
o Point numbers can be displayed in 2D views.  RelMo index numbers or original 

survey point numbers are supported.  Bear in mind RelMo index numbers are only 
created when the file is saved and may well change between sessions due to 
addition and deletion of points.  (They are initially created with the index number of 
0)  Also if an object wasn’t created from an XYZ or 001 file import, then it will not 
have original survey point numbers and nothing will be displayed – this is not a bug.  
Display of point numbers is controlled by two new commands in the points menu – 
Show Point Numbers and Point Number Display.  Show point numbers is also an 
option in the Display menu.  The Point Number Display command allows the user to 
change various settings.  NB: point numbers are not be displayed in plans, since 
this would require the program to save the current active object when displaying a 
view.  Without a file format change, this is not an option. 

 
o Control bar panels now work whether or not they are docked to the main window.  

Floating toolbars can now be used. 
 

o In 3D views (especially RelMo3) complex points were not always displayed.  This 
has been fixed. 

 
o When adding an animation control point, if the user selects ‘AutoLevel’ then the 

pitch and roll boxes are greyed out since these are obviously ignored if the program 
is going to calculate it’s own values. 

 
o Point and line symbols can be converted into proper RelMo objects – a copy is 

created and placed into the root object.   This can be accessed from the context 
menu in the Objects Control Panel. 

 
o Play in Reverse or Play Backwards command is now available in full screen mode. 

 
o The wrong command for Show Triangles was linked in RelMo3.  This has been 

fixed. 
 

o Plain coloured (no texture) triangles were not consistently displayed in 3D views 
unless a 3D symbol was also present in that object.  Usually a texture was visible on 
the plain text coloured triangles.  This has been fixed. 

 
o Tool bar icons for the Show 3D triangle and Show 3D Text commands have been 

added. 
 

o In RelMo3 files (*.rlv) Windows did not always display the correct RelMo3 document 
icon in Windows Explorer.  This has been fixed, BUT will require an administrator to 
run the program and then close it down, otherwise the relevant parts of the registry 
cannot be updated. 


